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Using This Guide

Congratulations on your purchase of an Avid® editing application. You can use your
application to create broadcast-quality output incorporating every possible production
element from full-speed, high-resolution footage, to multimedia artwork and animation, to
computer-generated effects and titling.

This guide contains the task-oriented instructions, conceptual information, and reference
material you need to use the conform and finishing features of your Avid Symphony™
Nitris® system. These features include project transfer, HD support, tracking and
stabilization parameters, and Symphony Nitris color correction.

This guide is intended for all users who need information for the conform and finishing
processes.

The documentation describes the features and hardware of all models. Therefore, your
system might not contain certain features and hardware that are covered in
the documentation.



Using This Guide

Symbols and Conventions
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Avid documentation uses the following symbols and conventions:

Symbol or Convention

Meaning or Action

AN
Jia

Italic font
Courier Bold font

Ctrl+key or mouse action

A note provides important related information, reminders,
recommendations, and strong suggestions.

A caution means that a specific action you take could cause harm to
your computer or cause you to lose data.

A warning describes an action that could cause you physical harm.
Follow the guidelines in this document or on the unit itself when
handling electrical equipment.

This symbol indicates menu commands (and subcommands) in the
order you select them. For example, File > Import means to open the
File menu and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a
list indicate that you perform one of the actions listed.

Italic font is used to emphasize certain words and to indicate variables.
Courier Bold font identifies text that you type.

Press and hold the first key while you press the last key or perform the
mouse action. For example, Ctrl+drag.




If You Need Help

If You Need Help

1. Retry the action, carefully following the instructions given for that task in this guide. It

is especially important to check each step of your workflow.

. Check for the latest information that might have become available after the

documentation was published:

- If'the latest information for your Avid product is provided as printed release notes,
they ship with your application and are also available online.

- If'the latest information for your Avid product is provided as a ReadMe file, it is
supplied in your Avid application folder as a PDF document (ReadMe.pdf) and is
also available online.

You should always check online for the most up-to-date release notes or ReadMe
because the online version is updated whenever new information becomes
available. To view these online versions, select ReadMe from the Help menu. or visit
the Knowledge Base at www.avid.com/readme.

. Check the documentation that came with your Avid application or your hardware for

maintenance or hardware-related issues.

. Visit the online Knowledge Base at www.avid.com/onlinesupport. Online services are

available 24 hours per day, 7 days per week. Search this online Knowledge Base to find
answers, to view error messages, to access troubleshooting tips, to download updates,
and to read or join online message-board discussions.

Related Information

The following documents provide more information about Symphony Nitris:

Avid Symphony Basics Guide

Avid Symphony Nitris Advanced Guide

Avid Symphony Nitris Advanced Effects Guide
Using the Avid Nitris

These documents are available in PDF form on the Avid Symphony Nitris Online Library
CD-ROM. The Online Library includes a Master Glossary of all specialized terminology
used in the documentation for Avid products.

For the latest product information, see the Avid Knowledge Base: www.avid.com/support

All product information is included in the Help system, which you can access from the
Symphony Nitris application’s Help menu.
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Accessing the Online Library

The Avid Symphony Nitris Online Library CD-ROM contains multimedia presentations and
all the product documentation in PDF format. You can access the tutorial and the library
from the Online Library CD-ROM or from the Help menu.

You will need Adobe® Acrobat® Reader® to view the documentation online. You can
download the latest version from the Adobe web site. The effects guide requires the Apple®
QuickTime® application to view the QuickTime movies. You can download the latest version
of QuickTime from the Apple Web site.
To access the online library from the Online Library CD-ROM:

1. Insert the Online Library CD-ROM into the drive.

2. Double-click the Mainmenu file.

To access the online library from the Help:
1. Insert the Online Library CD-ROM into the drive.
2. In your Avid application, select Help > Online Library.

How to Order Documentation

To order additional copies of this documentation from within the United States, call Avid
Sales at 800-949-AVID (800-949-2843). If you are placing an order from outside the United
States, contact your local Avid representative.

Avid Educational Services
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For information on courses/schedules, training centers, certifications, courseware, and
books, please visit www.avid.com/training or call Avid Sales at 800-949-AVID
(800-949-2843).



Section 1
Conforming and Mastering

The following chapters contain information to help you conform and master
your project:

*  Conforming and Transferring Projects
*  Working with HD Media
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Chapter 1
Conforming and Transferring Projects

Avid offers a range of editing applications for editing film, video, and audio. Within the Avid
family of editing and finishing products, you can work at the system most appropriate for
your task. When you are ready for the next step in the process, you can easily move your
work to another system. For example, you might start your project on a Media Composer
Adrenaline™ offline system and then move it to a Symphony Nitris online system when you
are ready for finishing. You can also send audio media to a Digidesign® Pro Tools® system
and edit the finished audio into the final sequence.

®

The following sections contain information about transferring and conforming projects.
*  Compatibility Between Applications

*  Conforming Workflow

+ Conforming Sequences Created with HDV Media

*  Conforming Sequences with Color Correction

*  Transferring Project and Media Files

Compatibility Between Applications

Avid editing products are designed so you can easily move projects and media from one
system to another and preserve your edits and effects. In a typical offline-to-online
workflow, you create a program on one Avid editing system—choosing the footage, making
edits, adding effects—and then transfer your program to another Avid system for final
finishing. This re-creation of the offline project on an online system is called conforming,
and Avid’s solution is called Total Conform. Finishing might involve recapturing in a final
resolution, making color corrections, adjusting effects, and outputting the final master.
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Alternatively, you can use the same media for offline and online editing. You can access the
media in several ways, such as sharing media in an Avid Unity" workgroup environment, or
transferring removable drives from one system to another. The clips and sequences
automatically link to the media, and you can complete the final finishing.

Specific information for transferring projects to Avid DS is contained in the Avid DS
Conform Guide, which is available from the Avid DS Support Center or the Avid Customer
Support Knowledge Base. To access the Knowledge Base, go to
www.avid.com/onlinesupport.

If you are moving from one Avid editing product to another in the current release, or from a
product in a previous release to a product in the current release, you can move project files
and media without losing any of your work.

However, when you move projects from a product in the current release to a product in the
previous release, some effects that have been created with features that are new for a
particular release do not appear, or appear as unknown effects.

All capturing into Symphony Nitris is done through the Avid Nitris, which does not contain a
1394 connection. DV 25 and DV 50 sources can be captured through a baseband connection
to either the SDI or analog inputs on the Avid Nitris (Symphony Nitris does not support
capture of DVCPRO HD through a baseband connection). Alternatively, another Avid
product such as Avid Xpress® Pro or Media Composer Adrenaline HD can be used to
capture native DV 25, DV 50, or DVCPRO HD media over IEEE-1394. You can then share,
play, edit, and render the media within Symphony Nitris. You can also transcode to these
resolutions, available resolutions depend on the format of the source media.

Conforming Workflow
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The following sections provide information to help you transfer projects from one Avid
editing system to another and conform the sequence to create one or more finished masters.
These steps are based on an offline-to-online workflow that uses Symphony Nitris as the
online system.

*  Preparing for the Online Session

*  Step l: Transfer Files

*  Step 2: Open the Project

*  Step 3: Measure the Video Signal

*  Step 4: Recapture Media

*  Step 5: Import and Lay in the Final Audio Mix
*  Step 6: Batch Import Graphics
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Conforming Workflow

*  Step 7: Re-create Title Media

*  Step 8: Refine Effects and Perform Color Correction

*  Step 9: Render Effects as Needed

*  Step 10: Create the Final Masters

For specific information about HD workflows, see “Working with HD Media” on page 53.

For specific information about film-based workflows, see “Working in a Film Project” in the
Help.

If you are transferring projects and media but not performing an online edit, refer to
“Transferring Project and Media Files” on page 43.

Preparing for the Online Session

If possible, work with the offline editor to plan the online edit. Planning the online edit
makes the online session easier and more efficient.

Review the following information before you begin the online session.
Delivery Requirements for Final Masters

The requirements for your final masters determine factors such as the project type used
during the offline edit. Ideally, the offline edit is done with the online edit in mind.

The most important delivery requirements are the formats and frame rates. A broadcast
network might require a range of formats: NTSC, PAL, and HD, at 4:3 and 16:9. Avid’s
Universal Mastering provides you with the ability to output multiple versions from the same
source file—see “Step 10: Create the Final Masters” on page 39. Make sure that the offline
edit is done at the same frame rate, or a compatible frame rate, as the online edit.

If you are delivering an HD project, and the offline will be done in SD, consider how the SD
media will be downconverted. If the project requires complex effects, use an anamorphic
downconvert, rather than center-cut or letterbox, to reduce the adjustments required in the
final conform.
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Offline Formats for HD

If your project requires final mastering in HD, use the corresponding SD project for offline
editing, as listed in the following table.

Offline Formats for HD

HD Online SD Offline

720p/23.976 23.976p NTSC

720p/59.94 30i NTSC

1080p/23.976 23.976p NTSC or 24p NTSC?
1080p/24 24p NTSC or 24p PAL
1080p/25 25p PAL

1080p/29.97 30i NTSC

1080i/50 251 PAL

1080i/59.94 30i NTSC

a. 24p NTSC sequences require additional conversion. See “Converting a 24p NTSC
Sequence to 1080p/23.976” on page 67.

When you start the online session, you can create a new project in the final format, or use the
original project and change the project format (see “Changing the Project Format” on
page 62).

File Transfer
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Before you begin moving project files between Avid editing applications, consider the
following.

*  What files will you transfer? Determine if you need to transfer project information,
video media, audio media, or all three. See “Step 1: Transfer Files” on page 30.

*  How will you transfer the files? Determine the most appropriate method for
transferring your project files. See “Devices and Methods for Transferring Files” on
page 47.
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System Compatibility

Make sure that files transfer correctly between editing systems, and that both systems
include the necessary applications. Consider the following:

Frame rates: Make sure both editing systems support the same frame rates. For
example, some offline systems support 24p projects and some do not. You might require
a 24p project to deliver multiple output formats.

File naming: To make it easier to move files between products and across platforms,
use the following guidelines when naming files:

- Do not use the following characters in project, bin, or other file names:
NFP<>|

The Windows® system does not recognize these characters in file names and
substitutes other characters, possibly making the file name unrecognizable.

You can use these characters in bin names if you are sharing bins between Symphony Nitris,
Media Composer, Avid Xpress, or NewsCutter®™ products. You cannot use these characters in
bins you share with Avid DS or Pro Tools.

- Do not add spaces at the beginning or end of a file name. The Windows system
displays such files but might be unable to open them.

- Do not use a period at the end of a file name. The Windows system displays such
files but might be unable to open them.

- On Macintosh® systems, beginning with v7.2, you can enable a setting in the Avid
application that prevents you from using restricted characters in file names. This
setting automatically adds the correct file name extensions to files for your project.
The Use Windows Compatible File Names setting in the General Settings dialog
box is selected by default. With this setting selected, the file name extension .avp is
added to project files and .avb is added to bin files when they are saved. These file
name extensions are also attached to existing files.

Title fonts: If the project includes titles and you are moving between Macintosh and
Windows systems, make sure you have the same font with exactly the same name
(preferably from the same supplier) on both the Macintosh and Windows systems.
Check the font carefully because the same font can have slightly different names. For
example, Times New Roman on the Macintosh system is named Times New Roman
Regular on the Windows system.

If you open a title on the online system that does not have a matching font, a dialog box
opens that allows you to substitute the font in the title with a font that exists on your
system.

For best results, use OpenType® fonts, which reduce problems when transferring
projects from one platform to another.
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«  AVX" plug-ins: If your project contains AVX plug-in effects and you are moving
across platforms, make sure the same plug-ins are available on both the Macintosh and
Windows systems. If the same AVX plug-in effect is not available, you can mix down or
render the effect to a high-quality resolution and then transfer it using an OMFI or an
AAF file. However, you cannot change the parameters of the effect.

Preparing Graphics

The most critical step when preparing graphics for online is to make sure that the elements
you are going to import are created correctly. The following table summarizes various
requirements.

Graphics Requirements

Aspect Requirement Notes
Frame size Square pixels: These are the preferred sizes for NTSC and PAL. 720 x
(4:3) 648 x 486 (NTSC) 540 can also be used, in some situations, for both NTSC
640 x480 (NTSC DV) and PAL. These are stored by the application as
768 x 576 (PAL) non-square pixels. For more information, see “Preparing

Graphics Files for Import” in the Help.

Frame size Square pixels: Preferred sizes. SD media is stored by the application as
(16:9) 864 x 486 (NTSC non-square pixels.

anamorphic)

1024 x 576 (PAL

anamorphic)

1280 x 720 (HD)

1920 x 1080 (HD)

Alpha channel =~ White foreground This is the standard used by graphics, animation, and
(transparent), black compositing packages. The graphics need to have the
background (opaque) alpha channel inverted on import.

Color mode RGB Other formats, including CMYK, can cause import errors.
ITU-R 601 ITU-R 601 is used for SD and ITU-R 709 is used for HD.
ITU-R 709 In HD projects, the Avid application automatically

converts the media.

File format Various The Avid application accepts many file formats for input.
TIFF (.tif) and PICT (.pct) are commonly used formats.
See “Import Specifications for Supported Graphics File
Formats” in the Help.
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Graphics Requirements (Continued)

Aspect Requirement Notes

File field order Odd (Upper field first) For interlaced media, the Avid application uses the

Even (Lower field following order:

first) *  NTSC (601 and DV): lower field first
* PAL 601: upper field first
* PAL DV: lower field first
* HD Interlaced: upper field first

If the field order of the graphic is not correct, select the
field order of the graphic during import and the application
reverses the fields appropriately.

Field order does not apply to progressive media. See
“Field Ordering in Graphic Imports and Exports” in the
Help.

Preparing Effects

In general, effects from older systems are automatically conformed by newer systems.
However, be aware of the following issues:

If you’re working in an offline SD project with complex effects and you plan to conform
as HD, the media should be downconverted anamorphically. Media downconverted as
4:3 or letterbox causes problems when you conform effects such as picture-in-picture.

If you are conforming a sequence that includes effects created with Avid FX, mix down
or render the effects to a high-quality resolution on the offline system and then transfer
them using an OMFI or an AAF file. You cannot adjust an Avid FX effect on a
Symphony Nitris system.

Wipes that include borders that were created in Media Composer Adrenaline v2.2.x or
earlier, or Avid Xpress Pro v5.2.x or earlier do not conform precisely. In these versions,
borders for the wipes end on screen; in Symphony Nitris borders end off screen.

29



Chapter 1

Conforming and Transferring Projects

Preparing Titles

You have the option to save titles in multiple aspect ratios. If you’re working with
anamorphically downconverted media, save the title as 16:9. After opening the sequence in
an HD project, re-create title media (see “Step 7: Re-create Title Media” on page 35). This
method lets you correctly create titles that fit in the 4:3 center cut or that extend beyond the
center cut.

If you’re working with media downconverted to center cut or letterbox, save the title as 4:3.
In this case the titles will appear centered, within the 4:3 center cut.

If you are working in 23.976p, 24p, or 25p projects, you can output your project in both
NTSC and PAL video formats, and in both 4:3 and 16:9 aspect ratios. You need to save a
title at each aspect ratio you need for your output requirements, but video format conversion
is handled automatically by your system’s hardware. For more information, see “Saving
Multiple Format Titles” in the Help.

Preparing Audio

Step 1:
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Your project might involve audio that is exported from the offline system, sweetened in an
audio application such as Pro Tools, and imported into the online system (see “Step 5:
Import and Lay in the Final Audio Mix” on page 34).

If you are sharing files with Pro Tools, you can use the WAVE or AIFF-C format. Pro Tools
v6.9 or later also supports MXF files For more information, see “Transferring Audio Files”
on page 43.

DigiTranslator” v2.0 is required on the Pro Tools system for import and export of OMF and
AAF files.

If you are sharing files between Macintosh and Windows systems, avoid using Sound

Designer II, which is a Macintosh format. For more information, see “Transferring Sound
Designer I Audio Files from Macintosh Systems” on page 44.

Transfer Files

There are several different methods for transferring project files and media files, depending
on the requirements of your project.
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Transferring Project Information Only

Project information includes the information about the components of your project (such as
settings, bins, master clips, edited sequences, and so on), but does not include the media for
these components. This project information is sometimes called metadata. Transfer only
project information if you are planning to recapture media (for example, from an offline
resolution to an online resolution) or relink media in an Avid Unity workgroup.

Options for transferring project information include:

*  Transferring a project folder from one desktop to another. This option allows you to
transfer complete project information, but you need to use the desktop operating system
to copy and transfer files. See “Transferring Project Files and Media Files Using
Nonshared Storage” on page 45.

*  Creating an OMFI or an AAF file (composition only). This option allows you to export
from the Avid editing application, but is limited to a single sequence or master clip. See
“Exporting OMFI and AAF Files” in the Help.

»  Sharing project information within an Avid Unity workgroup. See “Transferring a
Project Using Shared Storage” on page 44.

* Creating an AFE file. This option allows you to transfer complete project information,
but is currently limited to transfers to an Avid DS system. See “Exporting Projects and
Bins Using AFE Files” in the Help.

Transferring Project Files and Media Files

Transfer project files and media files if you want to transfer media files to another Avid
editing system, for example, if the offline sequence uses a broadcast-quality resolution and
you want to add Symphony color correction. Options include:

» Transferring a project folder along with a removable media drive. This option allows
you to transfer complete project information, but you need to use the desktop operating
system to copy and transfer files. See “Transferring Project Files and Media Files Using
Nonshared Storage” on page 45.

*  Creating an OMFI or an AAF file that references a removable media drive. This option
allows you to work within the Avid editing application, but is limited to a single
sequence or master clip. You can link to media files that you have copied or
consolidated to a single drive. See “Exporting OMFI and AAF Files” in the Help.

*  Creating an OMFTI or an AAF file with embedded media. This option allows you to
create a single OMF or AAF file, which you can consolidate onto a single drive.

If you want to transfer audio media to a digital audio workstation, such as a Pro Tools,
system, see “Transferring Audio Files” on page 43.
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Step 2: Open the Project

Depending on the project requirements and your personal preference, you can open a project
in the following ways:

*  Start a new project.

Use the Select Project dialog box to create a new project with the format you want
to use for final mastering. Starting a new project lets you configure the project
settings and eliminate any errors or problems caused by the offline project’s
settings.

You can then use the File > Open Bin command to open the bins that you’ve
transferred from the original project and load the final sequence. If you are finishing
an HD project, and the offline project was done in SD, use the Modify command to
change the sequence format (see “Modifying the Format of a Sequence” on

page 64).

If you transferred an OMFI or an AAF file with embedded media, create a new
project and bin and import the OMFI or the AAF file. The sequence automatically
links to the media.

If the clips and sequences do not link automatically, select File > Refresh Media Directories.

*  Open a transferred or shared project.

If you transferred project files, the original project appears in your list of projects.
(Depending on the location into which you copied the files, you might need to use
the Browse button in the Select Project dialog box to locate the project.) Open the
project, and all project settings and bins are displayed.

If you transferred both project files and media, and your media is compatible, the
original project appears in your list of projects. Open the project, all project settings
and bins are displayed, and clips and sequences automatically link to the media.

If you are finishing an HD project, and the offline project was done in SD, change
the project format (see “Changing the Project Format” on page 62.

) and then change the sequence format (see “Modifying the Format of a Sequence”
on page 64).

For information about working with shared projects and media in an Avid Unity
environment, see “Transferring a Project Using Shared Storage” on page 44.
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Measure the Video Signal

When working with analog material, measure the actual video signal during both input and
output to make sure the signal does not exceed the broadcast specification.

For SDI or HD-SDI formats, you cannot adjust input or output levels by using the video
controls in your Avid system. For HD media, you can calibrate only HD component output,
which is usually used for monitors.

For more information, see the following topics in the Help:
*  Preparing for Video Input

e Calibrating for Video Output

*  Advanced Video Output Calibration.

Symphony Nitris requires that the deck and the Avid Nitris hardware be genlocked to
the same timing source when capturing or outputting. For more information, see
“Selecting the Sync Source for Capture” and “Selecting the Sync Source for Output” in
the Help.

Recapture Media

If you did not transfer media, or you need to recapture your media at a higher resolution, use
one of the following options:

* Recapture master clips: Offers complete flexibility to make revisions, but takes the
most time and disk space.

* Recapture a sequence: Provides a one-step process, but limits your options during
capturing. You can make revisions using only assigned handle lengths.

*  Decompose the sequence and recapture the new clips: Captures only enough media
to re-create the sequence. You can specify the length of handles, which you can use for
minor revisions. This method is more flexible than capturing from the sequence because
new clips are created, which you can sort and selectively capture. This method uses
minimal storage and can be one of the fastest methods for recapturing.

In most cases, do not decompose clips created from imported graphics, which is an
option in the Decompose dialog box. These decomposed clips might cause problems
when batch importing, particularly if the sequence uses only part of an

imported animation.
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»  Use the Show Reference Clips option: Lets you reveal the source clips of a sequence
in a single bin by selecting the “Show reference clips” option in the Bin Display dialog
box, and then recapturing the source clips. This method can be faster than recapturing a
sequence or decomposing if the lengths of the new audio and video clips created differ
from the original master clips. Because two passes are necessary to capture audio and
video from a single source if the lengths are not the same, it is sometimes faster to
capture a slightly longer master clip than to capture the new clips once for audio and
once for video. This method also gives you more opportunity for revisions. However,
this method uses more disk space and capturing can take longer. It can be a good
compromise between capturing all the original clips and capturing only the clips needed
to re-create the source.

For instructions on recapturing, see “Recapturing Your Material” in the Help.

When you recapture from SD source tapes, Avid recommends that you readjust the video
levels. You can transfer video input settings from another system, but the existing settings
have been calibrated to a different set of hardware and might not operate properly.

If you are capturing serial digital video (SDI), the Avid system ignores the video input
settings.

Import and Lay in the Final Audio Mix

In most cases, the final audio mix was done as part of the offline edit or was done by an
audio editor on a digital audio workstation, possibly using Avid Pro Tools. In either case,
import the OMFT or the AAF file. For more information, see “Transferring Audio Files” on
page 43 and “Importing Files” in the Help.

After importing the audio mix, calibrate the audio hardware and channels as described in the
following topics in the Help:

*  Changing the Audio Hardware Calibration Setting

e Calibrating Audio Input Channels

*  Calibrating Audio Output Channels

Then use the Audio tool to monitor the audio levels. See “Using the Audio Tool” in the
Help.

You can quickly check the peak values of the sequence. See “Using the Console Window to
Check Audio Levels” in the Help.
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Batch Import Graphics

If you are working with master clips or sequences that contain imported material, you can
use the Batch Import command to reimport the source files. For example, you might want to:

»  Upgrade the video resolution of the imported files to an online resolution.

*  Replace low-quality material with high-quality material finished with other
applications.

*  Create new media files when the media files are lost or accidentally deleted.
Reimporting requires your original source files. Do not delete the media files for
imported files unless you have access to the source files.

Here are two tips for making batch importing easier:

» Placing a “graphics” folder inside the project folder of your offline project makes the
batch import process easier because the path will be the same, or at least faster to find.

» Itis easy to edit revised graphics into your project by giving them the same names as the
original graphics, copying the revised graphics to the folder that contains the original
graphics, and batch importing the revised graphics. You can also edit new graphics into
your project by deleting the media for your original graphics, batch importing your
sequence, and pointing the old clips to the revised graphics files.

For instructions on batch importing, see “Reimporting Files” in the Help.

Re-create Title Media

After you transfer or import all files, you might need to re-create title media if you did not
render the titles, or if you want to change the resolution of the titles.

To re-create the title media:
1. Select all video tracks that contain titles.

2. Mark an IN point and an OUT point to create a segment that includes all your titles.
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3. Select Clip > Re-create Title Media.

- Ifyou have the same font on both systems, the equivalent font appears
automatically.

Because the mapping process changes the exact appearance of the font, check your
titles carefully. It might be easier to check your titles from the bin than from the
sequence.

- Ifatitle opens and the system does not recognize the font, you see a dialog box that
allows you to substitute the font in the title for one that is installed on the system.

This replacement creates a font mapping, which is saved as a Site setting. For
information on changing the font mapping, see “Redefining a Font Replacement”
on page 37.

If more than one font in the title needs replacement, the dialog box remains open
after you click OK, and a new message identifies the next font that needs
replacement.

4. Select a drive and resolution for the re-created title media, and click OK.

For more information, see “Re-creating Title Media” in the Help.

Note the following:

For best results, use OpenType fonts, which reduce problems when transferring projects
from one platform to another.

If you are moving across platforms and the transferred title text uses a single style (the
same font and type size), the title text aligns as closely as possible to its original
position. The size of the text bounding box adjusts to accommodate the differences
between the Macintosh and Windows versions of the font used. You might see a
changed leading value in the Title Tool leading field to adjust for multiline text.

Because the Macintosh and Windows systems handle fonts differently, you might see
variations in the appearance of titles between the two systems. If necessary, adjust the
size of the bounding box, leading values, or kerning information.

For example, bounding boxes that were set on a Macintosh system might appear in a
different size on a Windows system. Some clipping of the new text might occur and
words can be lost. If this clipping occurs, you need to open the title, select the text box,
and manually change the size of the text box or the size of the fonts to display all the
text.

For more information on differences between the Macintosh and Windows versions of a
font, contact the font supplier.
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«  Ifthe original system used any applications to manipulate font display (such as Adobe®
Type Manager®), the enhancements these applications provided on the original system
(such as character anti-aliasing or character spacing) will not transfer to a system not
using the application.

»  Titles created in an offline project with anamorphically downconverted media should be
saved as 16:9. See “Preparing Titles” on page 30.

Redefining a Font Replacement

You can redefine a font replacement at any time. However, your new font choice is applied
only to a title currently in the Title tool and future replacements. It does not affect the font
replacement information in titles you have worked with previously.

Font relationships are saved as a site settings file named AvidFontSub.avt. This file is located
in the Settings folder, which is located in the Avid Symphony Nitris folder on your internal
drive.

Once you have defined a font replacement, the Avid system uses that definition across all
projects and all users of the system. If you want to switch to a different replacement font for
a title, you must redefine the font replacement.

If you replace the font for a title and return that title to an Avid editing application on a
Macintosh system, the new font information will be associated with the title. You must
reapply the Macintosh font to restore the title to its original Macintosh style.
To redefine a font replacement:

1. Open a title in the Title tool.

2. Select Object > Font Replacement.

The Font Replacement dialog box opens.
3. Click the Unknown Fonts menu on the left, and select the original font.

4. Click the Available Fonts menu on the right, and select the replacement font you want to
use.

When you select a font from the Available Fonts menu, a preview of that font appears in
the text boxes.

5. Click OK.

The system updates the font in the open title and records the new replacement information
for future use.
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Refine Effects and Perform Color Correction

After reviewing the sequence, you might find you need to adjust effects, add effects, or
perform color correction.

Color Correction: You can use Symphony Nitris Color Correction tools for a variety of
tasks, including review and adjustment of the chroma and luma levels and color adjustments
to selected areas (secondary color correction). For more information, start with “Symphony
Nitris Color Correction: Basics” in the Help and then see the chapters in Section 2 of this
guide, starting on page 71. For information about conforming sequences that contain color
correction, see “Conforming Sequences with Color Correction” on page 40.

Motion Effects: You might need to choose a different rendering method for motion effects
after recapturing media in a final online resolution. If a traditional motion effect is used,
consider promoting it to a Timewarp effect. For more information, see “Playing and
Rendering Motion Effects” in the Help.

Chroma and luma keys: Chroma and luma keys conform in Symphony Nitris as they were
created in the offline system. However, you might find problems with the keys, especially
when working in an uncompressed resolution. For maximum options in adjusting keys,
promote 2D keys to 3D. The 3D Warp effect in Symphony Nitris includes parameters for the
SpectraMatte effect. For more information, see “Creating Key Effects” in the Help.

The following topics provide information about other finishing tools in Symphony Nitris:

*  “Motion Tracking and Stabilization” on page 73

»  “Using the Reformat Effects” in the Help

*  “Understanding the Intraframe Effects” in the Help

e “QGetting Started with the Paint and AniMatte Effects” in the Help

e “Scratch Removal” in the Help

For complete information about effects, see the Avid Effects Guide, which is included in the
Help and is also available as a PDF file in the Avid Online Library.

Render Effects as Needed

On a Symphony Nitris system, most effects play in real time. However, you might need to
render some complex effects or plug-in effects. For more information, see “Real-Time
Playback of Video Effects” and “Basics of Effects Rendering” in the Help.

The ExpertRender feature includes a special setting called Prepare for Digital Cut. For more
information, see “ExpertRender” in the Help.



Conforming Workflow

Step 10: Create the Final Masters

A

Avid’s Universal Mastering features offer you a range of output formats you can use for your
final master. The output formats that are available depend on the format of your source
footage.

» Ifyour source footage is 23.976p, 24p or 25p, you can use the Digital Cut tool to output
broadcast masters in NTSC and PAL formats, both from the same sequence. You can
use the Reformat effect or the Pan and Scan effect to create 4:3, 14:9, and 16:9 versions
of the sequence. In addition, the Digital Cut tool includes the option to automatically
output titles as 4:3 or 16:9 to match your sequence. You can also output versions for
special purposes, such as NTSC 24, for recording audio at the film rate.

For more information, see “Selecting Output and Timecode Formats for 23.976p, 24p,
and 25p Projects” in the Help.

» Ifyour source footage is HD, you can crossconvert to a compatible HD format, and
downconvert to an NSTC or PAL format. The following table summarizes the available

formats.
Crossconverted Downconverted
HD Sequence Format HD Format SD Format
720p/59.94 10801/59.94 30i NTSC
720p/23.976* 1080i/59.94 30i NTSC
1080p/23.976% 1080i/59.94 30i NTSC
720p/59.94
1080p/24° - —
1080p/25 720p/50 251 PAL
1080p/29.97 720p/59.94 30i NTSC
1080i/50 720p/50 251 PAL
10801/59.94 720p/59.94 30i NTSC

a. When crossconverting these formats, the Avid editing system adds 2:3 pulldown
frames to create a sequence with the correct frame rate.

b. To crossconvert to HD, output a tape master and then convert. To downconvert to
SD, change the project format and transcode the media. Then output a digital cut.

Crossconverted and downconverted options that change the edit rate are not supported

for digital cut. For more information, see “Crossconverting and Downconverting HD
Formats” in the Help.
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»  All formats let you use the Export tool to output in popular file formats, including
QuickTime and Windows Media. Avid codecs for QuickTime let you input and output
files quickly, and you can install the codecs on graphics workstations for the most
efficient input and output. For more information, see “Exporting Frames, Clips, or
Sequences: Advanced” in the Help

*  You can use FilmScribe™ to create cut lists and change lists, and EDL Manager to create
an EDL. For more information, see “Using FilmScribe” and “Using EDL Manager” in
the Help.

Conforming Sequences Created with HDV Media

Symphony Nitris does not support HDV media. To conform a sequence or part of a sequence
that was created with HDV media, you need to transcode the media to a DNxHD resolution
on a system that supports HDV and then transfer the media.

To conform sequences with HDV media:

1. On an Avid system that supports HDV, capture the HDV media in an HDV project (for
example, HDV 1080i/59.94).

2. Perform the offline edit.

3. In the Project window, click the Format tab and change the project format to a
compatible HD format (for example, 1080i/59.94).

4. Select the sequence and transcode the HDV media to a DNxHD resolution. DNxHD 145
is an appropriate choice for HDV media. For information on transcoding, see “Using the
Transcode Command” in the Help.

5. Depending on your storage configuration, do one of the following:

a. Transfer the bins and media to the Symphony Nitris system and open them in an HD
project that matches the project on the offline system.

b. In a workgroup environment, open the bins and link to the media.

6. Finish the sequence.

Conforming Sequences with Color Correction
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The following sections explain how sequences with color correction conform as they are
moved between Symphony Nitris and certain other Avid editing applications, and how you
can transfer color correction adjustment values from one type of color correction to another
in cases where color corrections do not conform as you want.
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Conforming with Symphony Meridien Systems

In Symphony Nitris, if you open a Symphony Meridien'" sequence containing relationship
color corrections, a message box appears informing you that you are attempting to open a

sequence with an older type of color correction. You can choose to continue working with
the existing sequence or to create a duplicate sequence with updated color corrections.

» Ifyou continue to open the original sequence, the older relationship color corrections do
not appear on the Timeline and cannot be played or adjusted.

» Ifyou choose to create an updated duplicate sequence, Symphony Nitris converts the
older relationship color corrections to color corrections that you can view, play, and
further adjust in Symphony Nitris. The unaltered original sequence is also retained.

In Symphony Nitris, if you open a Symphony Meridien sequence containing Color
Correction effects, those effects conform correctly in Symphony Nitris and are available for
further adjustment.

Color corrections created in Symphony Nitris have limited backward compatibility with
Symphony Meridien systems. In a Symphony Meridien system, if you open a Symphony
Nitris sequence, you see the following behavior with color corrections:

*  Color Correction effects appear and are available for further adjustment.

You must enter Color Correction mode and click one of the Segment Mode buttons to see the
parameter settings in the Color Correction tool.

» Relationship color corrections appear as Color Correction effects, not as relationship
color corrections, so the relationship aspect of the corrections is lost. However, you can
usually recreate the relationships using color correction templates, as described in
“Transferring Color Corrections with Color Correction Templates” on page 42.

*  When segments contain both a Source and a Program relationship color correction, only
one of those corrections (the one applied first in time) appears as a color correction
effect.

Conforming with Adrenaline or Avid Mojo Systems

In Symphony Nitris, if you open a sequence created on an Avid editing application that
works with Adrenaline or Avid Mojo " hardware, all existing Color Correction effects
conform. You can view and play the Color Correction effects in the Timeline, and you can
make further adjustments to the Color Correction effects in the Color Correction tool.

If you want to convert existing Color Correction effects to relationship color corrections, you
can do so using color correction templates, as described in “Transferring Color Corrections
with Color Correction Templates” on page 42.
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In an Avid editing application that works with Adrenaline or Avid Mojo hardware, if you
open a Symphony Nitris sequence, you see the following behavior with color corrections:

All color corrections (whether relationship or Color Correction effect) that use color
correction controls available in the Adrenaline or Avid Mojo editing application
conform as Color Correction effects.

Color correction adjustments that are unique to Symphony Nitris, for example
adjustments on the Channels, Levels, or Secondary tabs, do not conform to Adrenaline
or Avid Mojo editing applications. A color correction that uses these adjustments
appears in the Timeline (and if it also contains HSL or Curves adjustments they are
available), but you cannot view or further adjust the adjustments that are unique to
Symphony Nitris.

When segments contain both a Source and a Program relationship color correction, only
one of those corrections (the one applied first in time) appears as a color correction
effect.

Transferring Color Corrections with Color Correction Templates
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In many situations where a color correction does not conform between one Avid editing
application and another in the way that you want, all of the color correction adjustment
values that you need are still intact, so you can work around the problem by using color
correction templates to transfer the color correction adjustment values to a new type of
correction.

For example, if you want to convert a Color Correction effect in a sequence originally
created in Media Composer Adrenaline HD to a relationship color correction, you can do so
by following these steps:

1.

In Color Correction mode, move the position indicator to the Color Correction effect
whose adjustment values you want to transfer, and make sure that you are monitoring
the track in the Timeline that contains the effect.

. Drag the Color Correction template icon from the Color Correction tool to a bin.

The application saves a color correction template in the bin. If you want, you can
rename the template to clarify its origin.

. Click the Remove Effect button to remove the original Color Correction effect from the

segment.

. (Option) If you intend to use a relationship color correction that will apply to multiple

segments, taking the place of multiple individual Color Correction effects, you might
need to move to each of the other segments and remove the existing Color Correction
effects from each.

. In the Correction Type menu, select the relationship color correction you want to use.
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6. Do one of the following:

- To apply all of the adjustment values stored in the template, drag the Color
Correction template icon that you created in step 2 from the bin, and drop it on the
monitor containing the current segment.

- To apply only those adjustment values from the template that appear in one Color
Correction tool tab, drag the Color Correction template icon that you created in step
2 from the bin, and drop it on the appropriate tab in the Color Correction tool.

For example, drop the icon on the Curves tab to apply only Curve adjustments to the
new relationship.

Transferring Project and Media Files

The following sections describe the options and methods you can use to transfer project files
and media between Windows systems, between Macintosh systems, and between Windows
and Macintosh systems:

* Transferring Audio Files

» Transferring a Project Using Shared Storage

»  Transferring Project Files and Media Files Using Nonshared Storage
*  Devices and Methods for Transferring Files

» Nonshared Storage Issues for Cross-Platform Collaboration

* Transferring Media Files from Media Composer Version 7.2 or Avid Xpress Version 2.1

Transferring Audio Files

You might need to transfer audio separately from video. One workflow might involve
sending audio from an offline system to a Pro Tools system for sweetening, and then sending
the finished audio to a Symphony Nitris system for syncing with final video.

When you are moving your sequence to an audio-editing application, you need to export the
sequence as an OMFI or an AAF file (see “Exporting OMFI and AAF Files” in the Help). If
you are working with a Pro Tools system, you can streamline your workflow by using the
Send To feature (see “Send To Digidesign Pro Tools” in the Help). The Send To Digidesign
Pro Tools templates export an AAF file.

+ If'the audio-editing application to which you are moving your sequence supports the
audio format used to create your sequence, you can export the sequence as an OMFI or
an AAF composition without audio media and move the original media files to the
audio-editing workstation.
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» Ifthe audio editing application to which you are moving your sequence does not support
the audio format in your sequence, you must export the sequence as an OMFI or an
AAF composition with audio media and convert the audio media to the appropriate
format.

OMFTI files have a 2-GB file-size limit.

The following table lists Pro Tools support for embedded audio. Pro Tools does not support
embedded video.

Pro Tools Version Audio embedded in OMFI Audio embedded in AAF
AIFF-C  WAVE MXF AIFF-C WAVE MXF
Pro Tools v7 or later Yes Yes No Yes Yes Yes
Pro Tools v6.9 or later Yes Yes No Yes Yes No
Pro Tools v6.7 or earlier Yes Yes No No No No

For information on importing into and exporting from the audio-editing application, see the
documentation for the audio-editing application.

DigiTranslator v2.0 is required on the Pro Tools system for import and export of OMF and
AAF files.

Transferring Sound Designer Il Audio Files from Macintosh Systems

Sound Designer II audio media is a Macintosh format and is not supported on Windows.

To transfer Sound Designer II media to a Windows system, export an OMFI or AAF
composition that includes the media and convert the media to AIFF-C or WAVE. Use the
Export command or the Send To command.

Transferring a Project Using Shared Storage
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If you are using your Avid editing system in an Avid Unity workgroup environment, you can
use Avid Unity MediaManager and Avid Unity Transfer Manager to share media files,
projects, and bins between systems. For more information, see the Avid Unity
MediaManager Setup and User’s Guide and the Avid Unity TransferManager Setup and
User’s Guide.
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You can also share bins and projects in an Avid Unity environment that does not use

Avid Unity MediaManager or Avid Unity TransferManager. See “Sharing Bins and Projects
on Avid Unity MediaNetwork” in the Help and in the Avid Unity MediaNetwork
documentation.

Transferring Project Files and Media Files Using Nonshared Storage

To transfer project files (information about the components of your project, such as bins,
master clips, edited sequences, and so on) and user profiles between Avid systems, you must
transfer specific folders directly into the Avid Projects or Avid Users folder before starting
the application. You can also transfer the Site Settings file between systems.

For information about these files and folders, see “Managing the Avid Projects and Avid
Users Folders” in the Help.

If the media is compatible, you can transfer media files between systems by using a
removable media drive. For information about media compatibility, see “Compatibility
Between Applications” on page 23. For information on devices for transfer, see “Devices
and Methods for Transferring Files” on page 47.

Transferring a project folder does not transfer accompanying media files.

To transfer project files and associated media files to another Avid system:

1. (Option) Consolidate the media for the project onto an appropriate drive for transfer to
the other system.

- For more information on consolidating, see “Consolidating Media” in the Help.

- For more information on devices for transfer, see “Devices and Methods for
Transferring Files” on page 47.

Do not rename the folder named OMFI MediaFiles or Avid MediaFiles (for MXF files)
located on the media drive. The target system uses the folder name to locate the media
files.

2. Select the project folder, user folder, or Site Settings file you want to transfer (the folder
uses the project name or user name you provide). You do not need to copy the Statistics
folder, which is located in the project folder. This folder can be large and is not needed
by the transferred project.
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The default locations for project folders are listed in the following tables.

Media Composer Adrenaline Default Folder and File Locations (Windows)

Folder or File Location

Project folder drive:\Program Files\Avid\Media Composer Adrenaline\Avid Projects
User folder drive:\Program Files\Avid\Media Composer Adrenaline\Avid Users
Site Settings file drive:\Program Files\Avid\Media Composer Adrenaline\Settings

Media Composer Adrenaline Default Folder and File Locations (Macintosh)

Folder or File Location

Project folder (Mac OS X) Macintosh HD/Users/Shared/Adrenaline/Avid Projects

User folder (Mac OS X) Macintosh HD/Users/Shared//Adrenaline/Avid Users

Site Settings file (Mac OS X) Macintosh HD/Applications/Media Composer
Adrenaline/Settings

Symphony Nitris Default Folder and File Locations

Folder or File Location

Project folder drive:\Program Files\Avid\Avid Symphony Nitris\Avid Projects
User folder drive:\Program Files\Avid\Avid Symphony Nitris\Avid Users
Site Settings file drive:\Program Files\Avid\Avid Symphony Nitris\Settings

The exact location depends on your Avid application, its version, and how it was installed on
your system.

3. Copy the folders or files you want to maintain at the new location onto a storage device
or a location on a server.

Alternatively, create a folder at the top level of the media drive and copy the folders or
files to that folder.

4. If you are transferring a removable drive, quit the Avid application and shut down your
system.

5. Remove the drives containing the media files, and take them and the storage device to
the new location.
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6. With the system at the new location turned off, insert or connect the drives and start the
system.

7. Copy the folders or files to the appropriate folder.

The folder locations might be slightly different, depending on the product and how it
was installed. Ignore any Resource folders or files that appear.

8. Start the Avid application.
The new project appears in the Project window. New user settings appear in the Users

list. Site settings are active for all projects at the new location.

& Do not open a project directly from the transfer device. You must copy the folder to the
system drive first.

9. Select a user, open the project, and resume work.

The Avid system reconstructs the MediaFiles database the first time you start the application
to incorporate the new media into the system’s internal directory.

Do not rename the project folder. The project settings do not link to the project if you rename
the project folder.

Devices and Methods for Transferring Files
There are different options for transferring files, depending on the source and destination
systems. The tables in the following sections provide options for moving project files, media
files, or both. These tables list the various ways to transfer data, the prerequisite hardware or

software, and any restrictions.

For specific information about cross-platform transfers, see “Nonshared Storage Issues for
Cross-Platform Collaboration” on page 51.
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Transferring Files Between Windows Systems

The following table shows the available methods for transferring files between Windows

systems.

Options for Transferring Files Between Windows Systems

Method

Requirements

Restrictions

All Files (Can be used as media drives)

External SCSI drive

Fibre Channel drive

External 1394
(FireWire) drive

None

None

None

For compatibility information, see the Avid Drive Striping
Tables, which are available on the Avid Customer Support
Knowledge Base.

For compatibility information, see the Avid Drive Striping
Tables.

Cannot be used as a media drive for Symphony Nitris.

For compatibility information, see the Avid Drive Striping
Tables.

Project Files, OMF Files, and AAF Files (including embedded media)

Server-based network

External 1394
(FireWire) drive or
USB?2 drive

Floppy disk
CD-ROM

DVD

E-mail

FTP

48

None

None

PC-formatted disk

None

None

E-mail software that
supports attachments

Network access and FTP
software on both systems

None.

Size of the disk.

Holds 1.4 MB.

Do not use ISO 9660 format, which truncates the file
names. Files copied from a CD-ROM to a Windows system
retain the read-only attribute. To change this attribute, see
the Windows documentation

None, if you use the native DVD format.

Files copied from a DVD to a Windows system retain the
read-only attribute. To change this attribute, see the
Windows documentation.

See the documentation for the e-mail software.

See the FTP software documentation.
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Options for Transferring Files Between Windows Systems (Continued)

Method Requirements Restrictions
DigiDelivery™ Installation of None. See www.digidesign.com/products/digidelivery/.
DigiDelivery hardware

and software

Transferring Files Between Macintosh and Windows Systems

The following table shows the available methods for transferring files between Macintosh

and Windows systems.

Options for Transferring Files Between Macintosh and Windows Systems

Method Requirements

Restrictions

All Files (Can be used as media drives)

Macintosh external HFS+ format and an

drive (SCSI or Fibre  application that enables

Channel) the Windows system to
read Macintosh drives.

External 1394 HFS+ format and an

(FireWire) drive application that enables
the Windows system to
read Macintosh drives.

See “Nonshared Storage Issues for Cross-Platform
Collaboration” on page 51.

For compatibility information, see the Avid Drive Striping
Tables, which are available on the Avid Customer Support
Knowledge Base.

Cannot be used as a media drive for Symphony Nitris.

For compatibility information, see the Avid Drive Striping
Tables.

Project Files, OMF Files, and AAF Files (including embedded media)

Server-based network Macintosh and
Windows integration

External 1394 HFS+ format
(FireWire) drive or

USB2 drive

Floppy disk PC-formatted disk

Rename files to avoid problems with illegal characters. See
“System Compatibility” on page 27.

Size of the disk.

Holds 1.4 MB.
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Options for Transferring Files Between Macintosh and Windows Systems

Method Requirements Restrictions
CD-ROM An application that HFS+ format is recommended. Do not use ISO 9660 format,
enables the Windows ~ which truncates the file names. Do not use hybrid CD-ROMs,
system to read unless you create them with the Joliet extension, which
Macintosh drives. supports long file names. Properly created hybrid CD-ROMs
do not require an application that enables the Windows system
to read a Macintosh-formatted CD-ROM.
Files copied from a CD-ROM to a Windows system retain the
read-only attribute. To change this attribute, see the Windows
documentation.
DVD None None, if you use the native DVD format.
Files copied from a DVD to a Windows system retain the read-
only attribute. To change this attribute, see the Windows
documentation.
E-mail E-mail that supports See the documentation for the e-mail software.
attachments
FTP Network access and For more information on using Fetch on Macintosh systems,
FTP software on both  see www.fetchsoftworks.com.
systems
DigiDelivery Installation of None. See www.digidesign.com/products/digidelivery/.

DigiDelivery hardware
and software
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Nonshared Storage Issues for Cross-Platform Collaboration

When you share media files by using a nonshared storage device — either peer-to-peer, over
a network, or using removable storage — the following restrictions apply:

*  NTFS drives formatted on a Windows system can be read only on Macintosh systems
running Mac® OS X 10.4 or later.

»  Striped or nonstriped drives formatted as HFS or HFS+ on a Macintosh system can be
read on a Windows system, if an application that lets Windows systems read the drives
is installed on the Windows system.

To avoid problems when reading a connected HFS or HFS+ drive, do the following:

*  On the Macintosh system, after transferring the media files to the HFS or HFS+ drive,
give the media folder a name other than “OMFI MediaFiles” . You cannot change the
name of the OMFI folder after you connect the drive to the system.

*  Make sure the permissions on the HFS or HFS+ volume allow access by other users:
a. Select the drive in the Finder.
b. Select File > Get Info

c. Select “Ignore ownership on this volume.”

*  On the Windows XP system, after connecting the drive and transferring the media files
to an NTFS drive, turn off the system, disconnect the drive, reboot, and then restart the
Avid system.

Transferring Media Files from Media Composer Version 7.2 or
Avid Xpress Version 2.1

Video media from Media Composer v7.2 or Avid Xpress v2.1 is not directly compatible with
later releases.

To transfer video media from v7.2 or Avid Xpress v2.1 to a later release:

» In the Export Format dialog box, select OMFI Composition Standard -AIFC, Video
Only, OMFI 1.0, With Media. You can then import the OMFI file.

The import process might be slow and your media loses some quality.

For more information about working with Media Composer v7.2, Avid Xpress v2.1, and
other versions of Avid editing products released before July, 2001, see the Avid Products
Collaboration Guide, which is available on the Customer Support Knowledge Base.
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Chapter 2
Working with HD Media

Avid Symphony Nitris includes support for capture, editing, and output of high-definition
(HD) media in the following resolutions:

e 1:1 HD (uncompressed 8-bit and 10-bit)
*  Avid DNxHD (8-bit and 10-bit)

Avid DNxHD encoding technology delivers mastering-quality HD media at standard
definition (SD) data rates and file sizes.

Symphony Nitris also includes support for editing and output of DVCPRO HD media.
Symphony Nitris does not include support for editing and output of HDV media (see
“Conforming Sequences Created with HDV Media” on page 40).

All capturing into Symphony Nitris is done through the Avid Nitris, which does not contain

a

1394 connection. DV 25 and DV 50 sources can be captured through a baseband connection

to either the SDI or analog inputs on the Avid Nitris (Symphony Nitris does not support
capture of DVCPRO HD through a baseband connection). Alternatively, another Avid

product such as Avid Xpress Pro or Media Composer Adrenaline HD can be used to capture

native DV 25, DV 50, or DVCPRO HD media over IEEE-1394. You can then share, play,
edit, and render the media within Symphony Nitris. You can also transcode to these
resolutions, available resolutions depend on the format of the source media.

The following sections describe the features and options that let you capture, edit, and output

HD media:

*  High-Definition Television
+ HDTV Workflows

» Editing in HD
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High-definition television (HDTV) is a digital broadcasting technology that delivers a larger,
clearer, more detailed picture than standard definition television (SDTV). HDTV refers to
specific digital television (DTV) formats that have been standardized by the Advanced
Television Systems Committee (ATSC) and adopted by the United States Federal
Communications Commission (FCC). HDTV for PAL has been standardized by the Digital
Video Broadcasting (DVB) consortium.

For a table that lists the HDTV digital formats and resolutions that are supported in your
Avid application, see ‘“Resolution Specifications: HD” in the Help.

HDTYV uses a 16:9 aspect ratio in place of the standard definition 4:3 ratio. The following
illustration compares the pixel size of the most common HD formats — 720p and 10801 —
to that of the digital version of standard definition NTSC media (ITU-R 601). Both 10801
and 720p formats fill the 16x9 screen on HD television sets.

pixels

NTSC SD

486 lines

For more information about HD technology, see the Avid HD Handbook: An A to Z Guide,
which is available on the Avid web site, www.avid.com.
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HDTV Workflows

This section describes three common workflows for creating HDTV output:
*  Creation of film-based television programs
*  Creation of video-based television programs

»  Creation of video graphics for broadcast

For a more detailed description of the conform workflow, see “Conforming Workflow” on
page 24.

Film-Based Television Workflow

The following workflow describes the steps in creating film-based television programs that
originate on film footage and that are planned for NTSC HDTV broadcast. This workflow
uses features that let you change the project and sequence format, eliminating the need to
create a new project and sequence. Modifying the format of the sequence lets you keep both
offline SD material and online HD material available in the same project.

For PAL broadcast, transfer film at 1080p/25, edit offline in a 25p PAL project, and edit
online in a 1080p/25 project.

“Oftline Workflow: 24-fps Film Source for HDTV” on page 57 shows the offline stage of
the workflow for such programs, and “Online Workflow: 24-fps Film Source for HDTV” on
page 58 shows the online stage.

For a more detailed description of the conform workflow, see “Conforming Workflow” on
page 24 .
To create a film-based HDTV program:

1. Use a telecine process to transfer 24-fps film footage to HD 1080p/23.976 video at 1:1.
The transfer should also create a shot log (for example, a FLEXx file).

2. Create a 23.976p SD project on any Avid editing system that supports a 23.976p project.

3. Convert the shot log file with ALE and import it into the project to create one or more
bins.

4. Use a 24p deck to downconvert the HD video to ITU-R 601 SD video and batch capture
the logged clips in an offline resolution, based on the shot log. The deck adds 2:3
pulldown (NTSC) or 4.1% speedup (PAL). The Avid system removes the extra
pulldown fields and creates 23.976p media.

5. Edit at 23.976 fps, apply effects, and create a final sequence.
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10.

11.
12.

13.
14.
15.

. (Option) If a retransfer is needed, use FilmScribe to create an OCN (original camera

negative) pull list for another telecine process, to retransfer footage used in the final edit.

. (Option) Export an OMFI or AAF file to a Pro Tools digital audio workstation to create

a final audio mix. For more information, see “Transferring Audio Files” on page 43 .

. A negative cutter uses the pull list to create a reel of selects from the original negative

(picture only). The telecine process uses the assembled reel to create a full
color-corrected or flat-grade transfer to tape. The process also creates a new transfer file.

. Transfer the project files to a Symphony Nitris system. If you are using an Avid Unity

MediaNetwork shared storage system, the project links to the existing SD media. If you
are not using Avid Unity, transfer the SD media for reference.

Open the project and change its format to 1080p/23.976 (see “Changing the Project
Format” on page 62). Review the offline sequence. Then modify the format of the
sequence to create a new 1080p/23.976 sequence (see “Modifying the Format of a
Sequence” on page 64).

Convert the transfer file with ALE and import it.

Relink by KeyKode: relink the 1080p/23.976p sequence and clips by key numbers
(FTFT). Then batch capture clips as HD media, using an HD resolution.

(Option) Import the final audio mix.
Complete any other finishing, using the original offline sequence for reference.

Use the Digital Cut tool to output a 1080p/23.976 master tape. Then convert the master
tape to 720p/59.94 or 10801/59.94 for broadcast. Optionally, use the Avid editing system
to crossconvert to 720p/59.94 or 1080i/59.94 for preview or reference. The HD VTR
can also create 1080i/50 for PAL broadcast.



Offline Workflow: 24-fps Film Source for HDTV
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Online Workflow: 24-fps Film Source for HDTV
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Video-Based Television Workflow

The following workflow describes the steps in creating video-based television programs that
originate on video footage and are planned for HDTV broadcast.

The workflow for creating such programs uses a single system for offline and online editing,
but you can adapt it to use one system for offline editing and another for online editing. This
workflow uses features that let you change the project and sequence format, eliminating the
need to create a new project and sequence. Modifying the format of the sequence lets you
keep both offline SD material and online HD material available in the same project.

You can use this workflow for video footage shot at 720p/23.976, 720p/59.94 or
1080p/29.97. In these cases, however, you cannot simply change the project format (step 6).
Instead, you need to create a new project that matches the source footage, open the bin or
bins from the NTSC 301 project, change the sequence format, decompose, and batch capture
(see “Changing the Project Format™ on page 62).

For a more detailed description of the conform workflow, see “Conforming Workflow” on
page 24.
To create a video-based HDTV program:

1. Shoot HD video.

2. Use an HD VTR to downconvert the source tape to 301 NTSC, 251 PAL, or 25p PAL.

3. Create an offline project as shown in “Changing the Project Format” on page 62. For
example, if you plan to finish at 1080i1/59.94, create a 30i NTSC project.

4. Capture your material. Edit, apply effects, and create a final sequence.

5. (Option) Export an OMFI or AAF file to a Pro Tools digital audio workstation to create
a final audio mix.For more information, see “Transferring Audio Files” on page 43.

6. Change the project format to the corresponding HD online format (see “Changing the
Project Format” on page 62). Duplicate the final sequence, and then modify the format
of the sequence to create a new sequence in the corresponding HD format (see
“Modifying the Format of a Sequence” on page 64).

7. Decompose the new HD sequence and batch capture from the source tape.
8. (Option) Import the final audio mix.

9. Finish the sequence by batch capturing graphics, recreating title media and reviewing
the program for effects that need fine-tuning. Use the original offline sequence for
reference.

10. Render all effects and output a master tape.
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Broadcast Graphics Workflow

Another HDTV workflow produces graphics, such as bumpers and promos that are created
in graphics programs for HDTV broadcast.

1. Create files on a graphics workstation, using either 1280x720 for 720p or 1920x1080 for
1080i.

2. Export the files to a location that the Avid editing system can access.
3. Create a 720p or 10801 project, import the files, edit, and finish.

4. Create a broadcast master tape in the desired format. Cross-convert to output an
alternative format.

Broadcast Graphics Workflow
o Graphics
workstation
o Files created
— for 720p or
(B) | 1080i

Symphony Nitris
system

720p/59.94 1080i/59.94
broadcast master broadcast master
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Editing in HD

The following sections describe features that are specific to HD projects.

Changing the Project Format

62

The Format display in the Project window lets you change the format of the project to
another format that shares the same frame rate.

This feature is especially useful if you are working with downconverted HD material in an
offline-to-online workflow (see “Video-Based Television Workflow” on page 59). Each HD
format has an equivalent SD format that you can use for offline editing, as shown in the
following table.
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Offline Formats for HD

HD Online SD Offline Notes

720p/23.976 23.976p NTSC You cannot change between these project formats
because the edit rates are different. See “Converting
a23.976p NTSC Sequence to 720p/23.976” on
page 68.

720p/59.94 30i NTSC You cannot change between these project formats
because the edit rates are different (see “Editing at
60 fps” on page 69). Use an NTSC 30i project for
offline editing, then open a new 720p/59.94 project
for online editing. Open the desired NTSC 30i bins
and modify the final sequence, as described in
“Modifying the Format of a Sequence” on page 64.

1080p/23.976 23.976p NTSC or  For 23.976p NTSC, change the project format and
24p NTSC modify the sequence. 24p NTSC sequences require
additional conversion. See “Converting a 24p NTSC
Sequence to 1080p/23.976” on page 67.

1080p/24 24p NTSC or 24p  Change the project format and modify the sequence.
PAL

1080p/25 25p PAL Change the project format and modify the sequence.

1080p/29.97 30i NTSC You cannot change between these project formats

because the edit rates are different. Use an NTSC
30i project for offline editing, then open a new
1080p/29.97 project for online editing and open the
desired NTSC 30i bins. You do not need to modify
the sequence. Duplicate the sequence. Then batch
capture the duplicated sequence or decompose and
batch capture.

1080i/50 25i PAL Change the project format and modify the sequence.

10801/59.94 301 NTSC Change the project format and modify the sequence.

Another use for this feature is if you are working in an HD project and need to capture SD
material. In an HD project, you can capture only HD material, and in an SD project, you can
capture only SD material. Temporarily changing from an HD project to an SD project gives
you access to the SD compressions. You can capture the material you need, then change
back to the HD project and work with both SD and HD clips (see “Mixing SD and HD” on
page 68).
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To change the project format:
1. Click the Format tab on the Project window.

2. Select the corresponding format for your workflow.
You can select only projects with the same edit rate.

When you change the project format, the following changes take place:

*  The hardware changes to support input and output for the new project.
¢  The available resolutions change to those of the new project.

* Any new sequences you create use the format of the new project.

If necessary, you can then modify the format of an existing sequence (see “Modifying the
Format of a Sequence” on page 64).

Modifying the Format of a Sequence
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When the Avid editing system creates a sequence, it uses the format of the current
project.You can change the format of an existing sequence by selecting Clip > Modify.

The choice of formats is limited to compatible frame rates of the sequence. For example, you
can change an NTSC 30i sequence to 1080i/59.94 or to 720p/59.94, but not to
1080p/23.976. (You can, however, convert a 24p NTSC sequence to 23.976p. See
“Converting a 24p NTSC Sequence to 1080p/23.976” on page 67).

In some cases, where the timecode format needs to be changed, the Avid application creates
a new, modified sequence. Media for this new sequence is offline. In other cases, where the
timecode format does not need to be changed, the application modifies the existing sequence
and media stays online.
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You can check the format of the sequence in the Format column of the bin. (For instructions
on adding a column to a bin, see “Displaying Formats in a Bin” on page 69.)

New 720p sequence

Modified 1080i sequence

The following table shows the choices you have for modifying sequences and how each type

of sequence is modified.

Choices for Modifying Sequences

Original Sequence Choices for Modifying How Sequence is Modified

23.976p NTSC 1080p/23.976

24p NTSC 1080p/24
23.976 NTSC

24p PAL 1080p/24

25p PAL 1080p/25

25i PAL 1080i/50

Existing sequence is duplicated with the
extension 1080p. Media in the duplicated
sequence is offline.

To convert to 720p/23.976, see “Converting a
23.976p NTSC Sequence to 720p/23.976” on
page 68.

Existing sequence is duplicated with the
extension 1080p. Media in the duplicated
sequence is offline.

Existing sequence is duplicated with the
extension 23.976 fps. Media is offline. See
“Converting a 24p NTSC Sequence to
1080p/23.976” on page 67.

Existing sequence is duplicated with the
extension 1080p. Media in the duplicated
sequence is offline.

Existing sequence is modified. Media remains
online.

Existing sequence is modified. Media remains
online.
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Choices for Modifying Sequences (Continued)

Original Sequence Choices for Modifying How Sequence is Modified

30i NTSC 720p/59.94 Existing sequence is duplicated with the
extension 60 fps. Media in the duplicated
sequence is offline.

1080i/59.94 Existing sequence is modified. Media remains
online. Not available in 720p projects.

For 1080p/29.97 projects, you can work with
the 301 NTSC sequence without converting it.

To modify the format of clips not used in the sequence, create a sequence of the selected
clips and then modify the sequence. One way to create a sequence of clips is to select the
clips, hold down the Alt key, and select Bin > AutoSequence. See “Using the AutoSequence
Command” in the Help.
To modify the format of a sequence:
1. (Option) Duplicate the sequence.
2. Select the sequence you want to modify.
3. Select Clip > Modify.
The Modify dialog box opens.
4. Select Set Format from the top list.
5. Select the format to which you want to convert from the Format menu.
6. Click OK.
A message box tells you whether the sequence has been duplicated or modified.

The Avid editing application changes the format of the sequence. In cases where
timecode needs to be converted, the application creates a new sequence and unlinks the
media. No media is converted.
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Converting a 24p NTSC Sequence to 1080p/23.976

The most efficient offline format for a project that needs to be delivered as 1080p/23.976 is
23.976p (NTSC). In some cases, however, you might need to edit the offline sequence at
24 fps — for example, if the offline system does not support 23.976p NTSC projects. To
convert a 24p NTSC sequence to 1080p/23.976p, you need to take an intermediate step and
first convert it to 23.976p NTSC.

Several limitations apply to this conversion:

Audio captured without pulldown (60 Hz) needs to be recaptured with pulldown (NTSC
reference at 59.94 Hz).

Media for the new 23.976p sequences and clips is offline. Sequences and clips cannot be
linked to the original 24p media.

You need to batch capture and import media. In most cases, you would do this after
converting the sequence to 1080p/23.976.

The last two limitations also apply to other sequence conversions that create new sequences.

To convert a 24p NTSC sequence to 1080p/23.976:

1.

W

On the Symphony Nitrissystem, open your 1080p/23.976p project or create a new one.

2. Switch the project format to 23.976p NTSC.
3.
4. Select Clip > Modify.

Open the bin that contains the original 24p sequence and select the sequence.

The Modify dialog box opens.

. Select Set Format from the top list and select 23.976 NTSC from the Format menu.
. Click OK.

The application creates a new sequence labeled with the extension 23.976 fps.

. Switch the project format back to 1080p/23.976p project.

8. Select the new 23.976p sequence.

. Select Clip > Modify.
10.
11.
12.

Select Set Format from the top list and select 1080p/23.976 from the Format menu.
Click OK.

Batch capture, import graphics, and finish the sequence.
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Converting a 23.976p NTSC Sequence to 720p/23.976

Because the source edit rates are different for these formats, you cannot simply change the
project and sequence format. The following sequence is based on source material shot or
transferred to 720p/23.976 and edited offline in a 23.976p NTSC project.

To convert a 23.976p NTSC sequence to 720p/23.976:
1. In the 23.976p NTSC project, duplicate the final sequence and move it to a new bin.
Decompose the sequence.
Select the master clips and export them as a shot log file.
Create a 720p/23.976p HD project.
Import the shot log file into a bin.
Batch capture the clips.
Open the SD bin containing the duplicated sequence.

® N kv

Relink the SD sequence to the new HD clips (see “Relinking Clips to a New Project
Format” in the Help).

Mixing SD and HD

68

You can mix SD and HD material in the same project. You can even mix SD and HD
material in the same Timeline if the edit rates match. For example, you can edit both NTSC
301 and 1080i/59.94 into the same sequence and then play the sequence in real time. This
feature is useful if you want to preview SD material in an HD project. For more information,
see “Mixing Resolutions” in the Help.

* Inan HD sequence, an SD image is stretched to fill a 16:9 monitor.

* Inan SD sequence, an HD image is anamorphically squeezed to fit the 4:3 monitor.

You cannot output a sequence that mixes SD and HD material. To output a mixed sequence,
you need to transcode the clips that use the unsupported resolution to an HD resolution (see
“Transcoding HD Media” on page 70). All master clips then share the same format.

You might also need to apply an effect, such as Reformat or Resize, in which case you need
to render the effects. This process creates new media in the format of the sequence.

You can set an option to highlight clips that do not match the project format. See
“Highlighting Clips in a Mixed-Format Timeline” in the Help.

If you have a sequence that mixes SD and HD clips, and you need to recapture the SD clips
in an HD resolution, you can create a subsequence of the SD clips, modify the format of the
subsequence (see “Modifying the Format of a Sequence” on page 64), decompose, and
recapture.
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Displaying Formats in a Bin

The Format column displays the format of a clip or sequence as determined by the project
type, such as 30i NTSC or 10801/59.94. This is especially useful if you have both SD and
HD clips in the same bin.

Format column

For information on displaying a column, see “Showing and Hiding Columns” in the Help.

Editing at 60 fps

The project type 720p/59.94 uses a screen resolution of 1280 x 720 at a frame rate of
60 frames per second. Editing at 60 fps is similar to editing at 24 fps because both
resolutions are progressive — they use full frames instead of interlaced fields. Note the
following:

+ Single-frame step commands move at 1/60th of a second. Single-field step commands
are deactivated; if you click a button, the application beeps.

*  You can mark IN and OUT points at 1/60th of a second increments.

*  You can trim at 1/60th of a second increments.

» Transition effects default to one-second duration (60 frames).

*  Deck control for capture and digital cut is limited to 30 fps. A message box warns you if

you try to mark an odd timecode value (such as 01:00:00:03).

1080i/50 and 1080i/59.94 are interlaced resolutions that you edit at 25 frames per second
and 30 frames per second.
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Working with True 24 FPS Timecode

Avid HD editing systems support direct device control at 24 fps, enabling you to capture true
24-fps timecode from HD decks. When you are capturing 23.976-fps or 24-fps material in
HD, the Capture tool displays 24-fps timecode for the Mark IN and Mark OUT points. After
you capture a clip, the Start and End timecodes are also shown as 24-fps timecode.

Transcoding HD Media

For HD projects, the Consolidate/Transcode dialog box lists compatible HD resolutions, as
listed in “Resolution Specifications: HD” in the Help. For information on transcoding
media, see “Using the Transcode Command” in the Help.

Video Color Space for HD

70

Color space determines how the color components of the video signal are stored and
processed. HD video uses an international specification for the YCbCr color space called
ITU-R 709. It is an expansion of the earlier YCbCr specification for SD called ITU-R 601.
ITU-R 601 and ITU-R 709 share some information: for example, for 8-bit components,
black is mapped to 16 and white is mapped to 235. However, color values can change when
you are converting from SD to HD, and vice versa. Avid HD systems automatically
compensate for these differences.

YCbCr and YPbPr refer to the same color space. Avid editing systems use YPbPr to
designate HD analog output, both in the Video Output tool and on the back of the Avid Nitris
hardware. The HD tab of the Video Output tool provides sliders to adjust the YPbPr analog
output through the YPbPr connectors on the back of the Avid Nitris.



Section 2
Finishing Tools

Avid Symphony Nitris offers a wide range of tools for adding the finishing touches
to your project. The following chapters describe features that are unique to
Symphony Nitris:

*  Motion Tracking and Stabilization

*  Understanding Color Correction Mode

*  Performing Color Corrections

*  Managing Color-Corrected Sequences

*  Color Correction Techniques

*  Spot Color Correction

* Safe Colors

For information about other tools and features you might use, see the following topics
in the Help:

*  Using the Reformat Effects

*  Understanding the Intraframe Effects

»  Getting Started with the Paint and AniMatte Effects

e Scratch Removal
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Chapter 3
Motion Tracking and Stabilization

Your Avid editing application can track the motion of a selected area in an image over time.
Once you have obtained tracking data, you can use it to control the motion of a digital video
effect such as a Picture-in-Picture or a Paint effect. You can also use tracking data to
stabilize an image to compensate for camera motion.

This chapter includes the following sections:

Understanding Motion Tracking

Workflow for Motion Tracking

Effects and Effect Parameters That Use Tracking Data
Understanding the Tracking Interface

Setting Up an Effect for Tracking

Preparing to Generate Tracking Data

Generating Tracking Data

Offset Tracking

Understanding Generated Tracking Data

Customizing Tracking Data Display

Setting the Reference Frame

Using SteadyGlide and Smoothing

Modifying Tracking Data

Limiting the Effect of Position Tracking Data to a Single Axis
Playback of Effects Using Tracking Data

Stabilizing an Image

Guidelines for Using Multiple Trackers When Stabilizing
Using the Region Stabilize Effect

Editing Segments That Use Tracking Data

Reusing Existing Tracking Data



Chapter 3 Motion Tracking and Stabilization

*  Conforming Symphony Meridien Sequences with Tracking Data

»  Examples of Effects Using Motion Tracking

Understanding Motion Tracking

This section includes conceptual information that helps you to understand how tracking
works and when you might want to use it.

Understanding the Tracking Process

Motion tracking works by searching for a distinctive pattern of pixels in each frame of a
video segment. As the pattern moves over time, your Avid application records the movement
as a series of points, one for each frame or field in the segment. For example, if a car is
moving across a segment, you can track a distinctive pattern on the side of the car, such as
the shape of its side mirror. The result is a set of tracking data points that represent the
movement of the car over time.

Once you have a set of data points, you can associate them with an effect parameter to
control how an effect moves. For example, if you needed to hide the identity of the person
driving the car in your segment, you could associate the tracking data with the Position
parameter of a Blur effect. The tracking data would then control the movement of the Blur
effect so that the blurred area remained over the person’s head throughout the segment.

Each set of data points is contained within a structure called a tracker. Depending on the
kind of motion you need to track, you might need one, two, or more trackers. For simple
two-dimensional movement, a single tracker is sufficient. If you need to track rotational
movement or scaling information, you need two trackers so that the system can calculate the
position of one point in the image relative to a second point. For even more complex motion,
such as that involved in corner pinning an image, you might need three or four distinct points
to correctly track perspective or the angle at which the image is tilted.

Uses of Motion Tracking

74

One common use for motion tracking is to replace a moving area in one image with new
material. For example, you can track the motion of a distinctive area on a vehicle and then
use that data to replace an advertising sign on the vehicle or to replace or blur the license
plate. In many cases, especially when the motion of the vehicle is complex, using tracking
data to control the movement of the foreground replacement is much quicker than using
keyframes to define the movement by hand. For an example of this use of motion tracking,
see “Example 1: Replacing the License Plate on a Moving Vehicle” on page 121.
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Sometimes a shot is designed from the outset with motion tracking in mind. A director might
attach a target to the moving vehicle so that it can be tracked easily. You could create a
replacement sign as a graphic and import it or shoot a replacement sign against a keying
background. During editing, you use tracking data to control the movement of the
replacement material in a Picture-in-Picture or a chroma key effect promoted to 3D Warp.

Another use for motion tracking is to create an effect in which a foreground object follows a
background object but remains offset from it. For example, you might track the movement of
a hand in a background clip and then use that tracking data to control the movement of a
foreground object so that the object’s movement appears to be controlled by the moving
hand.

When you stabilize an image, you use tracking information somewhat differently. By
tracking an object that should be motionless — for example, part of a building — you collect
information about the movement of the camera from one frame to the next. The Stabilize
effect then applies the inverse of that movement to each frame in order to eliminate the
camera motion.

Motion Tracking and Footage Characteristics

Your Avid editing application provides motion tracking tools that make it possible to track
movement in many kinds of footage successfully.

However, there will always be some footage that is difficult or even impossible to track
successfully because there is no consistent pattern to track across multiple frames or because
there is insufficient distinction between the pattern you want to track and the surrounding
material. Typically, tracking requires a distinct edge in the target area, for example the edge
of a moving vehicle against a background, or the edge of an advertising sign against the
body of a vehicle.

In some cases, you might be able to temporarily apply a color correction or a Color Effect
that you can use to make a pattern more distinct. For example, if a blue vehicle does not
track well against a sky background that is a similar shade of blue, you could use a
secondary color correction on the vehicle to change its color temporarily.

Workflow for Motion Tracking

The following workflow outlines the main stages of the motion tracking process and
indicates where to find more detailed information and procedures for each stage.

Motion tracking provides considerable workflow flexibility. As you become a more
experienced user of motion tracking, you can modify the order of these stages or merge them
together to suit your editing style and the requirements of a particular project.
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1. (Option) Before you begin working with the motion tracking tools, develop a general
concept and design for the effect you want to create.

In some cases, you can design your shoot itself with tracking in mind, for example, by
attaching a distinctive target to a moving object that you can later track and replace with
an effect.

2. Set up the effect that you want to control using tracking information.

You access motion tracking from within an effect parameter for a specific effect, so you
must set up the effect first. For more information, see “Setting Up an Effect for
Tracking” on page 83.

3. Prepare to generate tracking data by creating trackers and customizing how the system
will conduct the tracking operation. For more information, see “Preparing to Generate
Tracking Data” on page 85.

4. Generate tracking data.

Depending on the complexity of the movement you want to track, you might need to
track one, two, or more distinct points in the image. Also, if you are not able to track one
target area successfully throughout your segment, you might need to add one or more
additional tracker regions and track each additional region.

For more information, see “Generating Tracking Data” on page 94 and “Performing
Offset Tracking” on page 98.

5. If necessary, process or modify the tracking data.

For example, you might want to smooth the path of the tracking points, or adjust some
of the points by hand. For more information, see “Using SteadyGlide and Smoothing”
on page 103 and “Modifying Tracking Data” on page 104.

6. Play back the effect.

The system calculates the motion of the effect by incorporating the tracking data and
displays the result. For more information, see “Playback of Effects Using Tracking
Data” on page 110.

7. If necessary, continue to adjust the tracking information or other effect parameters until
you are satisfied with the look of the effect.
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Effects and Effect Parameters That Use
Tracking Data

You can enable tracking and use tracking data for most segment effects that can move over
time, including Picture-in-Picture, keys, Intraframe™ effects, titles, and all 3D effects. In
some cases, you must promote an effect to 3D to access tracking for the effect or to access
the full range of tracking options.

Effect parameters that can use tracking data divide into two groups:

»  The Position, Scaling, and Rotation parameters allow you to use tracking data to control
the specific kinds of motion associated with each parameter. You can work with tracking
enabled in any combination of these parameters at the same time. For example, you can
work with tracking enabled in both the Position and the Scaling parameters to control
both the position of an effect on the X and Y axes and the size of the effect.

*  The Tracking parameter category provides a more flexible way to define and use
tracking data by allowing you to enable up to four trackers. The Tracking parameter is
the only parameter that allows you to work with more than two trackers at one time and
is therefore the only option for controlling complex motions that involve perspective
changes or tilting of the effect.

You can also use the Tracking parameter with only one or two trackers enabled to
control simpler motions such as position and scaling. This is the only option for such
control in effects that do not have Position, Scaling, and Rotation parameters, such as
Intraframe effects. This is also an alternative method for controlling simpler motions in
effects that do have Position, Scaling, and Rotation parameters.

It is important to understand that the two groups of parameters that use tracking data are
mutually exclusive. When you enable the Tracking parameter, tracking is automatically
disabled in the Position, Scaling, and Rotation parameters. When you enable tracking in the
Position, Scaling, or Rotation parameters, the Tracking parameter is automatically disabled.

The following table provides a complete list of the effects and effect parameters that can use
tracking data. For reference information on these effects and their parameters, see “2D
Effects Reference” and “3D Effects Reference” in the Help.
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Effects and Effect Parameters for Tracking

Effect Available Parameters
Picture-in-Picture (2D) Position, Scaling

Paint Tracking

AniMatte

Blur Effect

Mosaic Effect

Scratch Removal

Spot Color Correction

Stabilize Position, Scaling, Tracking
Matte Key effect (applied from Key category in the Position, Scaling

Effect Palette)

Imported Matte Key clip (2D) Position, Scaling

Titles (2D) Position, Scaling

3D Warp (including promoted Picture-in-Picture effects, Position, Rotation, Scaling, Tracking
keys, 3D Xpress shape effects, and titles)

Understanding the Tracking Interface

The interface items that you use when tracking divide into three groups according to their
location. These groups are described in the following topics.

Tracking Controls in the Effect Editor
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The Effect Editor includes tracking controls within those effect parameter categories that can
use tracking information. These controls allow you to enable tracking for the parameter and
to define which trackers apply to that parameter.

The appearance of tracking controls in the Effect Editor varies somewhat depending on
whether or not the effect has been promoted to advanced keyframes.

The following illustration shows the tracking controls for the Position parameter category in
both standard keyframes and advanced keyframes.



Understanding the Tracking Interface

Tracker controls for Position
parameter category — effect
with standard keyframes

Tracker controls for Position
parameter category — effect
promoted to advanced keyframes

For more information, see:

»  “Effects and Effect Parameters That Use Tracking Data” on page 77
*  “Enabling Tracking in the Effect Editor” on page 85
*  “Creating and Mapping Trackers” on page 87

Tracking Controls in the Effect Preview Monitor

The Effect Preview monitor displays tracking controls that you can manipulate directly. The
monitor displays the tracking boxes that you use to define the target area and the search area
on the first frame or field of the region that you want to track. As tracking takes place, the
monitor displays the generated data points for each frame or field. Once tracking data has
been generated, you can display tracking data points in various ways and manipulate them in
the monitor. For more information, see the following sections:

*  “Setting Up Tracking in the Effect Preview Monitor” on page 90
*  “Tracking Data in the Effect Preview Monitor” on page 99

*  “Customizing Tracking Data Display” on page 100

*  “Modifying Tracking Data” on page 104

The following illustration shows a typical display of tracking boxes and data points.
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The Tracking Window

80

Many of the controls that you use to create, customize, and modify trackers are located in the
Tracking window.
To open the Tracking window, do one of the following in the Effect Editor:
» Enable tracking in an effect parameter for a tracker that is not currently mapped.
For more information, see “Creating and Mapping Trackers” on page 87.
»  Click the Tracking Tool button.
You might need to resize the Effect Editor to see the Tracking Tool button in the column
of buttons on the right side.
The Tracking window has the following main features:

* An area containing controls for setting up and performing tracking, controlling the
display of tracking data, and modifying tracking data

* A timeline representation of each tracker for the current effect
The following illustration shows the Tracking window. The following table provides a brief

description of each interface item in the window and indicates where to find more detailed
information.
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Tracking Window Controls

Understanding the Tracking Interface

Control Description

Start Tracking Starts a tracking operation from the current location
of the position indicator. For more information, see
“Generating Tracking Data” on page 94

Tracking Engine Allows you to choose between the two available
tracking engines, Correlation Tracker and
FluidTracker. For more information, see “Choosing
a Tracking Engine” on page 93.

Track Allows you to choose between tracking the

Background/Foreground background shot and tracking the foreground shot,

Go to Previous Region
and Go to Next Region

New Tracker

Point Range

Display

Stretch Points Mode

Ll .
&
- -
. . N h

In the great majority of cases, you will want to track
the background shot. For more information, see
“Choosing Background or Foreground Tracking” on
page 94.

Click one of these buttons to move to the previous or
next region boundary in the tracker timelines. For
more information, see “Moving to a Tracking
Region” on page 98.

Creates a new tracker. For more information, see
“Creating and Mapping Trackers Manually” on
page 88.

Controls how many of the tracking data points
appear in the Effect Preview monitor. For more
information, see “Customizing Tracking Data
Display” on page 100.

Controls the display in the Effect Preview monitor,
allowing you to view either the tracking data or the
results of the effect. For more information, see
“Customizing Tracking Data Display” on page 100.

Allows you to stretch data points. For more
information, see “Stretching a Range of Tracker
Data Points” on page 108.
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Tracking Window Controls (Continued)

Control

Description

Enable Tracker button
(Tracker timeline - L

displays)

Offset Tracking (Tracker m
timeline displays)

SteadyGlide (Tracker .
timeline displays)

Smoothing (Tracker
timeline displays) .

Smoothing Value

50
(Tracker timeline E‘
displays)
Tracker Color box
(Tracker timeline L

displays; also visible in
the Effect Editor)
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When the Enable Tracker button is active for a
tracker, tracking boxes and tracking data points
display in the Effect Preview monitor. Also, when
the Enable Tracker button is active for a tracker, the
system generates tracking data for that tracker
during a tracking operation. The button is purple
when active and gray when inactive. For more
information, see “Enabling, Disabling, and Deleting
Trackers” on page 89.

When this option is selected, the tracker uses offset
tracking to calculate a continuous motion for the
effect from multiple regions of tracking data. For
more information, see “Offset Tracking” on page 96.

When this option is selected, the tracking data for
the tracker is processed to remove unwanted jittery
motion while preserving underlying smooth
movement such as a camera pan or zoom. The value
set in the Smoothing Value text box controls the
extent of the processing. For more information, see
“Using SteadyGlide and Smoothing” on page 103.

When this option is selected, the tracking data for
the tracker is processed to smooth the path between
selected points. The value set in the Smoothing
Value text box controls the amount of smoothing
applied. For more information, see “Using
SteadyGlide and Smoothing” on page 103.

Enter a value in this text box between 1 and 100 to
control the amount of smoothing performed by the
SteadyGlide or Smoothing processes. The larger the
value, the more smoothing is performed. For more
information, see “Using SteadyGlide and
Smoothing” on page 103.

Shows the color the system uses to display
information for this tracker in the Effect Preview
monitor and allows you to change the tracker’s
display color. For more information, see
“Customizing Tracking Data Display” on page 100.
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Tracking Window Controls (Continued)

Control

Description

Tracker Name text box o=
X . ! oint A
(Tracker timeline
displays; also visible in
the Effect Editor)

Tracker timeline | H_E' ¢

(Tracker timeline
displays)

Tracker Close button
(Tracker timeline E
displays)

Shows the name of the tracker and allows you to
change the name of the tracker. For more
information, see “Creating and Mapping Trackers
Manually” on page 88.

Shows information about the tracking data in the
tracker. Color coding indicates the status of the data.
For more information, see “Adjusting Tracking
Boxes” on page 90 and “Tracking Data in the
Tracker Timelines” on page 99.

Closes the tracker and permanently deletes any
information within it. For more information, see
“Enabling, Disabling, and Deleting Trackers” on
page 89.

Setting Up an Effect for Tracking

The first stage of the motion tracking workflow is to set up the effect to which you want to
apply tracking data. To do this, you need to edit the necessary footage into a sequence and
apply the effect. In most cases, you will also want to make initial parameter adjustments to

the effect.

Understanding Video Layers and Motion Tracking

Since motion tracking either controls the movement of an effect in relation to a moving area
in a clip or controls the stabilization of a clip, you need one of the following situations for

motion tracking to be useful:

*  Two (or more) layers in the Timeline, where one contains the video you intend to track
and another contains the material to which you will apply the effect (that material might
be video, an imported graphic, or a title clip).

* A single video layer on which you draw one or more Intraframe objects. When you
track movement in the video, you can use that tracking data to control the movement of

the Intraframe objects.

» For stabilizing only, a single video layer that you intend to stabilize.
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In most circumstances when you are working with two video layers, the material you intend
to track will form the background layer and the effect will be on the foreground layer.
However, the system can track either the foreground or the background layer, so you can
place the material you want to track on top of the material that receives the effect if
necessary.

Applying an Effect for Motion Tracking

You apply an effect for motion tracking in the same way that you apply any effect that either
operates on a multilayer sequence or allows you to draw a foreground object on top of a
video layer. For more information, see “Applying Effects” in the Help.

Making Non-Tracking Parameter Adjustments to an Effect
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The final look of an effect that uses tracking is almost always the result of combining the
tracking data with standard effect parameter adjustments. You will usually need to define the
appearance of the effect in the first frame or field of the segment; you might also need
keyframe adjustments at other points in the segment.

In most cases, you can choose whether to make these adjustments before or after you
generate the tracking data itself. As long as both the standard adjustments and the tracking
data are in place when you play the effect, you will see the final result of all the adjustment
data.

For example, if you are replacing a sign on a moving vehicle, you need to use standard effect
parameter adjustments to set the initial size, shape, and position of the sign. Depending on
the complexity of the material, you might make these adjustments using basic parameters
such as Position and Scaling, or you might need to place each corner independently using
the Corner Pin parameter.

If you want the effect to be offset from the moving area that you plan to track, you can
establish that offset by adjusting the Position parameters. The final motion of the effect will
maintain that offset from the tracking data points as it moves. If you want the size of the
effect to change in a manner that is not dependent on changes in the moving area, you can set
up that change in size by using keyframes and the Scaling parameters.

When you are working with Intraframe effects, you must draw the foreground object that
you want to control with tracking information and select it with the Selection tool before you
can generate tracking data. As with other effects, however, you can establish the precise size,
shape, and position of the object either before or after generating tracking data.

You can choose which frame in a tracked segment is the reference frame — the frame at
which the tracking data makes no change to the look of the effect. For more information, see
“Setting the Reference Frame” on page 102.
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Preparing to Generate Tracking Data

There are several procedures that you need to follow before you can generate tracking data.
These procedures control how the system operates as it creates the tracking data.

Enabling Tracking in the Effect Editor

The first step in creating tracking data is to enable tracking for an effect parameter in the
Effect Editor. Once you do this, other tracking controls become available.

The basic procedure for enabling tracking in an effect parameter is simple, but there are
slight variations depending on:

The parameter type
Whether the effect you are working with is 2D or 3D

Whether the effect you are working with is using standard keyframes or advanced
keyframes

To enable tracking for an effect parameter:

4

Perform the appropriate steps for your effect type and effect parameter, as described in
the following table.

Once you have enabled tracking for a parameter, the Tracking window opens. For more
information on the Tracking window, see “The Tracking Window” on page 80.

When you first enable tracking for a parameter, the system creates appropriate default
trackers and maps them to the parameter, as described in the table. For more
information, see “Creating and Mapping Trackers” on page 87.

For Intraframe effects, trackers can be enabled only when an Intraframe object is selected.
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Options for Enabling Tracking in the Effect Editor

Parameter and
Keyframe Type Procedure and Result Illustration

Position, Rotation, P Click the Use Tracking button.
or Scaling in any
effects using
standard keyframes

The application creates an appropriate
number of trackers (one for Position, two
for Rotation or Scaling) and maps them to
the parameter.

Position or Scaling P Open the Position or Scaling category, then
in 2D effects using click the enable button for the Tracking
advanced keyframes subcategory.

The application creates an appropriate
number of trackers (one for Position, two
for Scaling) and maps them to the
parameter. You must open the Tracking
subcategory to see the list of mapped
trackers and any additional controls.

Position, Rotation, P  Open the Position, Rotation, or Scaling

or Scaling in 3D category, and then click the enable button
Warp effects using for the Position Tracking, Rotation
advanced keyframes Tracking, or Scale Tracking subcategory.

The application creates an appropriate
number of trackers (one for Position, two
for Rotation or Scaling) and maps them to
the parameter. You must open the Position
Tracking, Rotation Tracking, or Scale
Tracking subcategory to see the list of
mapped trackers and any additional

controls.
Tracking in any » Click one or more of the individual tracker
effect using enable buttons.

standard keyframes The application creates and maps a tracker

for each tracker enable button you click,
and also enables the Tracking parameter
category.
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Options for Enabling Tracking in the Effect Editor (Continued)

Parameter and

Keyframe Type Procedure and Result lllustration
Tracking in 2D » Open the Tracking parameter category, and

effects using then click one or more of the individual

advanced keyframes tracker enable buttons.

The application creates and maps a tracker
for each tracker enable button you click,
and also enables the Tracking category.

Tracking in 3D » Open the Corner Tracking parameter
Warp effects using category, and then click one or more of the
advanced keyframes individual tracker enable buttons.

The application creates and maps a tracker
for each tracker enable button you click,
and also enables the Corner Tracking
category.

Creating and Mapping Trackers

Your Avid editing application performs initial tracker creation and mapping automatically
when you first enable tracking for an effect parameter, but you can also create and map
trackers manually when necessary.

Understanding Tracker Selectors and Tracker Function

Each parameter includes a number of tracker selectors appropriate to its function in
controlling movement. When you enable tracking in a parameter, the application looks for
existing trackers and maps them to the parameter’s tracker selectors. If trackers do not yet
exist, the system creates them and then maps them to the parameter’s tracker selectors. In the
Tracking parameter category, new trackers are created and mapped as you enable individual
tracker selectors.

When you are working in the Position, Scaling, and Rotation parameters, the number of
trackers you can use is limited by the type of movement controlled by the parameter. For
example, the Position parameter includes a single tracker selector since only one point is
required to define movement in X and Y.

When you are working in the Tracking parameter, you can use any number of trackers up to
a total of four. The following table describes the kinds of motion that you can control with a
given number of trackers.
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Multiple Tracker Function

Number of Trackers

Description

One

Two

Three

Four

Allows control of position on the X and Y axes only. Use one tracker if you want
your effect to move in only two dimensions on the plane of the screen.

Allows control of position, scaling, and rotation. Use two trackers if you want your
effect to change size or rotate.

Allows control of position, scaling, rotation, and skew. Skew refers to a
transformation that tilts or squashes an object along one axis while retaining its
orientation along the other axis. This has the effect, for example, of transforming a
rectangle into a parallelogram. Use three trackers if you want your effect to skew in
this manner.

Allows control of position, scaling, rotation, skew, and perspective. Perspective
refers to the way parallel lines appear to converge and changes depending on the
angle from which an object is viewed. Use four trackers if you want to control
perspective for your effect.

Creating and Mapping Trackers Manually

For most tracking work, there is no need to create additional trackers beyond those that are
created automatically by the system. Accepting the defaults and creating your tracking
information with them is quicker and more straightforward.

In some situations, however, you might want to create extra trackers. For example, you
might want to track more than the minimum number of points necessary for a parameter so
that you can experiment with different combinations of tracking points. You also might want
to change the mapping of trackers so that an effect parameter uses a different tracker or
combination of trackers from that orginally created by the application.

The system allows up to eight trackers for each effect.

To create a new tracker manually:

@ 1. In the Tracking window, click the New Tracker button. For more information, see “The
Tracking Window” on page 80.

A new tracker timeline display appears in the bottom area of the Tracking window. The
system names the tracker using the next letter of the alphabet that is not already in use,
up to the letter D. If all of the letters A through D are in use, subsequent new trackers are
named “Untitled Tracker.”
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2. (Option) If you want to rename the new tracker, click the Tracker Name text box, and
type a new name.

!Llntitled Tracker Tracker Name text box

The new tracker appears as an option in all the tracker selector Fast menus in the Effect
Editor.

To map a tracker manually, do one of the following depending on the interface style in
the Effect Editor:

P Click the Fast Menu button for the appropriate tracker selector in the parameter, and
then select the tracker you want.

P Click the tracker selector in the parameter, and then select the tracker you want.

Enabling, Disabling, and Deleting Trackers

m.

Once you have created a tracker, you can enable and disable it as necessary. Enabling and
disabling a tracker has a different effect depending on whether you do it in the Tracking
window or in the Effect Editor.

*  When you enable or disable a tracker in the Tracking window, you control whether or
not the tracker displays in the Effect Preview monitor and whether or not your
application generates tracking data for that tracker.

*  When you enable or disable a tracker in the Effect Editor, you control which sets of
tracking data your application uses to control the effect. This allows you to compare the
look of an effect under the control of different tracker combinations.

You can also delete existing trackers. When you do so, you permanently erase that tracker
and any tracking data associated with it.

To enable or disable a tracker in the Tracking window:

P  Click the Enable Tracker button for the tracker in the tracker’s timeline.

Alt+click the Enable Tracker button for any tracker to enable or disable all trackers at once.

To enable or disable a tracker in the Effect Editor:

p  Click the Enable button for the appropriate tracker selector.

In the Tracking (or Corner Tracking) parameter category, clicking the Enable button that
controls the whole parameter disables all the trackers at the same time but does not change

the enable status or the mappings of the individual trackers. When you click the Enable
button for the whole parameter again, the system re-enables all the individual trackers.
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To delete a tracker:

» In the Tracking window, click the Close button in the top right corner of the tracker’s
timeline.

Setting Up Tracking in the Effect Preview Monitor

You define the region of interest (the area of an image that each tracker will track) and the
larger area it will search within by making direct adjustments to the tracking box display in
the Effect Preview monitor.

Displaying Tracking Boxes

To display tracking boxes in the Effect Preview monitor:

1. If you have not already done so, enable, create, and map the trackers with which you
want to work.

2. In the Display Tracking Data area of the Tracking window, make sure that Tracking
Data is selected in the Display menu.

Wy 3. Make sure that the Enable Tracker button is active (purple) in the tracker timeline
display of the Tracking window for each tracker that you want to display.

4. Make sure that you are monitoring the track in the Timeline that contains the material
you want to track.

5. Move the position indicator to the first frame or field of the segment, or to the first frame
or field of the tracker region.

A tracking box display appears in the Effect Preview monitor for each tracker. For more
information on tracking regions, see ‘“Performing Offset Tracking” on page 98.

Adjusting Tracking Boxes

Each tracking box display includes three elements:
* An inner rectangle used to define the target area
*  An outer rectangle used to define the search area

* A data point locator, which appears at the center of the rectangles

Each rectangle has a corner adjustment handle.

90



Preparing to Generate Tracking Data

The following illustration shows the tracking box display.

Search Area box

.7
— Adjustment handles
R |
/\< Data point locator
=1

Target area box

You can change the color of the tracking boxes display for a tracker. This might make it
easier to see the display against the background image. For more information, see
“Customizing Tracking Data Display” on page 100.

To move a tracking box display in the monitor:

P Click anywhere within the boxes except the adjustment handles, and drag the boxes to a
new position.

To resize a box in a tracking box display:

P Drag the adjustment handle for the box.

For more information on what to consider when making these adjustments, see
“Guidelines for Positioning Tracking Boxes” on page 91.

If you have multiple trackers enabled, you might find it difficult to select one. You can
disable some of the trackers temporarily in the Tracking window to simplify the display in
the Effect Preview monitor and make it easier to select and manipulate a particular tracker.

Guidelines for Positioning Tracking Boxes

When you position tracking boxes, consider the following factors:
* Locating the boxes over material that the system can track successfully

*  Locating the boxes so that the tracking data you generate accurately represents the
movement you want to track
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The system tracks most successfully on an area of the image that is easily distinguishable
from the parts of the image that surround it. For example, a bright dot will track extremely
well if it is generally surrounded by darker material. You will often need to scrub through the
entire clip to get a sense of which areas are good candidates for tracking.

To represent the movement you want to track accurately, you need to consider the geometry
of the motion that you want to achieve. For complex movement such as controlling a
replacement sign for a bus that is receding into the distance as well as moving across the
screen, you need to track enough points to represent the change in shape and size of the sign
over time. Tracking two corners will allow you to control changes in scale and rotation (the
corners should be diagonally opposite if scaling on the X axis differs from scaling on the Y
axis). Adding third and fourth trackers would fill in the other two corners as needed for more
complex transformations.

Remember that you do not have to track points at the exact location where you want the
finished effect to appear. You can track any set of points that will represent the right
movement. For example, you might want to add a small sign to the door of a moving car.
Since the door panel is a uniform surface you cannot track areas on it. However, you can
gather tracking data to control the positioning and scaling you need for the sign, for example
by tracking two or more of the corners of the car’s window.

Guidelines for Resizing Tracking Boxes
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When you make adjustments to resize either of the tracking boxes, you should consider the
following factors:

*  Defining material that the system can track successfully

*  Ensuring that tracking will proceed successfully from frame to frame or from field to
field throughout the range of frames or fields you are tracking

*  Minimizing the length of time the system spends generating tracking data

In general, the smaller you can make the boxes, the less image information the tracking
engine has to search and the faster it can work. However, if you set the boxes too small, you
increase the possibility that the system will lose the search pattern between one frame or
field and the next.

You can also refine how the system follows a target area by setting controls in the Tracking
window. For more information, see “Setting Up Tracking in the Tracking Window” on
page 93.

Size the Target Area box so that it is as small as possible while still enclosing a distinct area
to track. Remember that the pattern needs to remain distinct throughout the range you
are tracking.
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Size the Search Area box so that it is as small as possible while remaining large enough to
encompass the movement of the target area from one frame or field to the next. You will
probably need to scrub through the clip you are tracking to check how much a prospective
target area moves from one frame or field to another.

Setting Up Tracking in the Tracking Window
In addition to defining the search criteria for a tracker in the Effect Preview monitor, you can
also set up the following aspects of tracking behavior in the Tracking window.
*  Choose which tracking engine to use

*  Choose whether the region to track is in the background or the foreground clip

The following illustration shows the area of the Tracking window that contains these
controls.

Choosing a Tracking Engine

The term tracking engine refers to the calculation methods that your application uses to
recognize a moving pattern and generate data for it. Your Avid editing application lets you
choose between two tracking engines:

*  Correlation Tracker
This is the same tracking engine that is used in Avid DS Nitris systems.
*  FluidTracker

This tracking engine uses the same motion analysis methods used in FluidMotion
Timewarp.

The two tracking engines both produce accurate tracking data when the target area is
distinctive. The difference between the two trackers is primarily one of speed. In general, the
Correlation Tracker will generate tracking data faster than the FluidTracker when the area
being searched is small. If you need to search a larger area, you might find that the
Correlation Tracker becomes too slow to be useful, in which case you should switch to

the FluidTracker.
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To switch the tracking engine:

» Inthe Setup Tracking area of the Tracking window, select the tracking engine you want
to use from the Tracking Engine menu.

Choosing Background or Foreground Tracking

You can choose to track either the background or foreground for a multilayer effect. In the
great majority of situations you will want to track the background to define the movement of
an effect or painted object layered above the background shot.

One situation in which you need to choose Track Foreground is when you are stabilizing an
image using a 3D Warp effect promoted to advanced keyframes. For more information, see
“Stabilizing an Image” on page 111.

To switch between background and foreground tracking:

» In the Setup Tracking area of the Tracking window, select the option you want to use
from the Track Background/Foreground menu.

Generating Tracking Data
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When you have made all the preparations necessary to set up the tracking operation, you can
generate tracking data.

You can generate tracking data for any number of the available trackers in a single operation.

You can generate tracking data for the entire length of the segment, or for any part of the
segment starting from the location of the position indicator. This allows you to stop tracking
at any point in the segment and resume later, or to retrack over any part of the segment
whenever you need to do so.

You can also create separate tracking regions for different parts of your segment, and define
a different target area for each region. This is primarily useful for performing offset tracking.
Once you have created a region, you can move the position indicator to the start of that
region and generate tracking data for the region. For more information, see “Offset
Tracking” on page 96.

As the system generates tracking data, it updates the tracker timeline displays to show the
status of tracking data over time. For more information on the tracker timeline display, see
“Understanding Generated Tracking Data” on page 99.
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To generate tracking data:

1. In the Tracking window, click the Enable Tracker button for each tracker you want the
system to track.

Alt+click the Enable Tracker button for any tracker to enable all trackers at once.

2. Move the position indicator to the location where you want to start generating tracking
data.

This location can be at any point in the segment, but in most cases, the position indicator
will be either:

At the beginning of the segment.
At the beginning of a region.

At the location where you stopped generating tracking data and from where you
want to resume tracking.

For information about moving to the beginning of a tracking region, see “Moving to a
Tracking Region” on page 98.

3. Click the Tracking button.

The system begins to generate tracking data.

As the tracking operation proceeds:

The Effect Preview monitor displays each frame or field on which tracking is being
performed, and shows the tracking data point for that frame or field as a cross.

The application updates the timeline for each tracker to indicate the status of the
tracking data over time. If you are tracking where there is no existing tracking data,
the application replaces the red bar at the bottom of the line with a black bar at the
top as data is generated, as shown in the following illustration. If you are re-tracking
where tracking data already exists, you see no change in the tracker timeline, but the
old tracking data is being replaced with new data.

¥ | &

When you start tracking from the beginning of a tracking region, Symphony Nitris steps back
one frame from the region boundary before it starts tracking. This is normal behavior to
ensure that motion at the region boundary is tracked correctly.
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To stop a tracking operation, do one of the following:
P  Press the space bar.

»  Press Ctrl+period.

» Click any element of the application’s interface.

The tracking operation stops.

Offset Tracking

You can use your application’s offset tracking capabilities to create smooth effect motion
from tracking data that you generate using more than one target area. This lets you track
motion successfully when a single target area is not available for the full duration of a
segment.

Understanding Offset Tracking
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The simplest case for motion tracking is when you can track a single distinct area for the full
length of a segment. For example, if a bus is moving through the scene and the entire side of
the bus is visible throughout the segment, you can select any area or set of areas on the side
of the bus and track them throughout the segment.

Other situations might be more complex. For example, if a bus is moving slowly through the
scene but is also relatively close to the camera, you might find that an area you choose to
track at the beginning of the segment is no longer visible later in the segment because it has
moved out of the frame. Or perhaps you have a shot where a bus moves through a scene but
passes behind a foreground sign, again with the result that an area you choose to track at the
beginning becomes unavailable later in the segment.

In these situations, you can generate useful tracking data by using offset tracking. Offset
tracking lets you track one target area until it becomes unavailable because it leaves the
frame or is hidden by another object, then track another target area that shows the same kind
of motion as the first. Your application calculates the offset from the first set of tracking
points to the second, and takes account of this offset when animating the final effect. The
result is an effect that follows a continuous path.

If necessary, you can track more than just two targets. You can also track one target, switch
to a second (for example, when the first becomes temporarily hidden), and then return to the
first when it becomes visible again.

To track more than one target area in a segment, you add a new tracker region to a tracker
timeline. You can then set a new target area in the first frame or field of the new region and
track that target area.



Offset Tracking

Adding and Deleting Tracker Regions

If you have a situation where you cannot track a single target area successfully for the whole
length of a clip, you can add one or more new tracker regions to the tracker timeline and
track a new target area for each of the regions.

In most cases, you use tracker regions in combination with the offset tracking feature, so that
your finished effect combines the tracking data from more than one target area into one
continuous motion. For more information on the concept of offset tracking, see
“Understanding Offset Tracking” on page 96.

To add a new tracker region for a tracker:

1. In the tracker’s timeline, move the position indicator to the location where you want the
new region to start.

2. Right click in the tracker’s timeline, and select Add New Tracker Region.

Your application creates a new region that extends from the location of the position
indicator to either the start of the next tracker region or the end of the timeline. The start
of the new region appears as a vertical bar in the tracker timeline.

] [ @

Tracker Region boundaries

To delete a tracker region for a tracker:
1. In the tracker’s timeline, move the position indicator to any location within the region.
2. Right-click in the tracker’s timeline, and select Delete Tracker Region.

Your application deletes the tracker region. The region’s vertical boundary bar
disappears from the timeline, and any tracking data for the region is deleted. A red bar
appears at the bottom of the tracker’s timeline for the duration of the old region,
indicating that you need to retrack these frames to get new tracking data, as shown in the
following illustration.

] | &

Location of start of deleted tracker region
boundary. Previous tracking data has been
deleted from this point to the end of the
deleted region, as indicated by the red bar.
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Moving to a Tracking Region

When you have multiple tracking regions in the tracker timelines, you can move between
them by using the Go to Previous Region and Go to Next Region buttons.

To go to the beginning of the previous or next tracking region:

e

Click the Go to Previous Region or Go to Next Region button.

Performing Offset Tracking

To perform offset tracking:

1.

Make sure that offset tracking is enabled for each tracker you plan to use.

Offset tracking is enabled by default, and the Offset Tracking button is purple when
offset tracking is enabled.

. In the first frame or field of your segment, set up a tracker for your first target area, as

described in “Preparing to Generate Tracking Data” on page 85.

3. Begin generating tracking data, as described in “Generating Tracking Data” on page 94.

8.

. When the target area disappears, stop tracking, for example by pressing the space bar.

. (Option) If necessary, step back a few frames or fields in the segment until the position

indicator is on the last frame or field with a good tracking data point.

. Right-click in the tracker timeline and select Add New Tracker Region.

A vertical bar appears in the tracker timeline to show the beginning of the new region,
and the tracking boxes for the tracker appear in the Effect Preview monitor.

. Drag the tracking boxes to the location of your second target area and size them as

necessary.

Begin tracking from the start of the new region by clicking the Tracking button.

When you start tracking from the beginning of a tracking region, Symphony Nitris steps back
one frame from the region boundary before it starts tracking. This is normal behavior to
ensure that motion at the region boundary is tracked correctly.

9.
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(Option) If necessary, repeat steps 3 through 7 for additional target areas (or to return to
tracking the original target area when it becomes visible again).
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Understanding Generated Tracking Data

Once the system has completed generating tracking data, a set of tracking data points exists
for each tracker enabled during the tracking operation. You can display these points in the
Effect Preview monitor. You can also view information about the status of the tracking data
in the tracker timeline display.

Tracking Data in the Effect Preview Monitor
Tracking data points display in the Effect Preview monitor.

While tracking is taking place, your application shows the location of the current tracking
data point as a cross.

Once tracking has stopped, your application displays, by default, every point created during
the tracking operation. The data point for the current frame or field displays as a flashing
cross; all other data points display as solid dots.

You can control which sets of data points display and how many of the points display. You
can also manipulate the points directly in the monitor in a variety of ways. For more
information, see “Modifying Tracking Data” on page 104.

Tracking Data in the Tracker Timelines

The tracker timeline display shows you the status of tracking data over the length of the
effect. The following table describes the display options.

Tracker Timeline Display

Color Description

Black Line at top  Tracking data exists for this part of the segment, and the data points for this part
of timeline of the segment are not currently selected in the Effect Preview monitor. For
more information, see “Generating Tracking Data” on page 94.

White Line at top  Tracking data exists for this part of the segment, and the data points for this part
of timeline of the segment are currently selected in the Effect Preview monitor. For more
information, see “Selecting Tracker Data Points” on page 105.

Red Line at bottom Tracking data does not exist for this part of the segment.
of timeline
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Tracker Timeline Display (Continued)

Color

Description

Vertical Bar Marks the start of a new tracking region. For more information, see “Offset

Tracking” on page 96.

Display Markers ~ Define the beginning and end of a range of frames. When In to Out is selected

B

Reference Frame  Marks the location of the reference frame — the frame at which the tracking
Marker

&

in the Point Range menu, the Effect Preview monitor only shows tracking data
points for this range of frames. For more information, see “Customizing
Tracking Data Display” on page 100.

data does not modify the effect. For more information, see “Setting the
Reference Frame” on page 102.

Tracking data exists for this part of the Tracking data exists for this part of the E:' ':E Display Markers define

&

timeline. The data points are not timeline. These data points are currently a range of frames for
selected in the Effect Preview monitor selected in the Effect Preview monitor IN to OUT tracking data
| | display
I |
| |

Reference Frame Marker

marks the frame at which

the tracking data does not
alter the effect

Vertical bar marks the start No tracking data exists for
of a new tracking region this part of the timeline

Customizing Tracking Data Display

You can customize how your application displays tracking data in the following ways:
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You can enable or disable display for each tracker

You can customize the color used to display each tracker

You can control how many of the tracking data points display

You can control whether the Effect Preview monitor shows tracking data or shows the
results of applying the tracking data to the effect



m

Customizing Tracking Data Display

To turn the tracking display on or off for a tracker:

P In the Tracking window, click the Enable Tracker button for the appropriate tracker.
The Enable Tracker button is purple when the display is on.

Alt+click the Enable Tracker button for any tracker to turn the display on or off for all

trackers at once.

To customize the display color for a tracker:

P Click the Tracker Color box, and then on the Color palette click the color you want to
use.

To define the range of data points in the display:

1. (Option) If you want to define a range of frames for which you want data points to
display, do one of the following:

» Drag the Display Markers in any one of the tracker timelines to define the beginning
and end of the range you want.

P Use the position indicator in the tracker timelines along with the Mark IN and Mark
OUT buttons to define the beginning and end of the range you want.

The Display Markers move to the beginning and end points you establish.

2. In the Display Tracking Data area of the Tracking window, click the Point Range menu,
and then select an option.

The following table describes the available options.

Tracking Data Point Range Options

Option Description

Current Displays the data point at the current location of the position indicator for each
enabled tracker.

In to Out Displays the data points for the range currently defined by the Display Markers in the
Tracking window for each enabled tracker. Shows the points for the current frame or
field as flashing crosses.

All Displays every data point for each enabled tracker. This is the default option. Shows
the points for the current frame or field as flashing crossess.

To choose Tracking Data or Effect Results display:

P Inthe Display Tracking Data area of the Tracking window, select the option you want to
use from the Display menu.
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The Display menu affects what you see in the Effect Preview monitor once tracking data is
available and while you are parked on a frame or are stepping through the effect. The
Display menu does not affect what you see in the Effect Preview monitor while tracking is
taking place (when you always see the current data point represented as a cross). Also, when
you play an effect with tracking data, for example by clicking the Play button in the Effect
Preview monitor, you always see the results of the effect.

Setting the Reference Frame
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The reference frame for a tracked segment is the frame at which the tracking data makes no
change to the appearance of the effect. For example, for a Stabilize effect, the reference
frame is the frame at which the tracking data causes no change in the position of the image.
The location of the reference frame is marked on the tracker timeline by a red diamond.

Reference Frame Marker

By default, Symphony Nitris considers the first frame of a tracked segment to be the
reference frame. In every frame after the first, the effect is modified by the tracking data for
that frame.

You can choose to set the reference frame to any other frame in the segment. This can be
useful when trimming changes the location of the head frame for the segment, or in other
circumstances where the position of the reference frame influences the final look of the
effect. For example, if you set the reference frame for a Stabilize effect to the frame at the
midpoint of the segment, the tracking data at that frame causes no change in the position of
the image. In all earlier and all later frames, the effect is modified by the tracking data for
that frame.

To set the reference frame for a tracker:

1. In the tracker timeline, move the position indicator to the frame you want to set as the
reference frame.

2. Right-click the tracker timeline, and select Set Reference Frame.

The red diamond reference frame marker moves to the location of the position indicator.
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Using SteadyGlide and Smoothing

Your Avid editing application provides two options for processing the tracking data in a
tracker to smooth the motion it represents. You can turn these options on or off at any time,
and you can control the extent of the processing they perform by setting a smoothing value.
The original set of tracking data points is not changed in any way by the processing.

SteadyGlide™ processes tracking data to reduce abrupt, jittery movements without affecting
underlying motion. SteadyGlide is particularly useful as a tool for stabilizing unwanted
camera motion without eliminating desirable motion. For example, you can use SteadyGlide
to reduce any jittery motion in a pan shot with a hand-held camera while retaining the
underlying motion of the pan itself. For this purpose, you would use SteadyGlide with the
Stabilize effect, or with Stabilize Tracking turned on for an effect parameter in the 3D Warp
effect. For more information on stabilizing, see “Stabilizing an Image” on page 111.

The Smoothing option processes tracking data to smooth out the path between the tracking
data points. The higher the Smoothing value you define, the smoother the path becomes.

To use SteadyGlide or Smoothing:
1. In the tracker timeline, click the SteadyGlide button or the Smoothing button.
The button is purple when the processing option is turned on.
SteadyGlide and Smoothing are mutually exclusive processing operations. You cannot
perform both SteadyGlide and Smoothing at the same time, and if you turn on one, the other
will automatically be turned off if it was on previously.
2. In the Smoothing Value text box, type a smoothing value between 1 and 100.

The smoothing value controls the extent of the smoothing performed by both the
SteadyGlide and the Smoothing options. The larger the value, the more smoothing is
performed.

If you are displaying tracking data in the Effect Preview monitor, the display updates to
show the results from the processing.

3. (Option) If necessary, check the effect results and adjust the smoothing value until you
are satisfied with the results, or click the SteadyGlide or Smoothing button again to turn
off the processing if you decide you do not want it.

When you are using SteadyGlide, the display shows a graph of the jittery motions that your
application is removing. It is not easy to assess the final look of the effect from this
information, so you should view the effect results to determine whether you need to adjust
the smoothing value further.
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When you are using Smoothing, the display shows the smoothed curve that results from the
processing, which gives a useful visual indication of the amount of smoothing your
application is applying. The following illustrations show typical results for Smoothing using
different smoothing values.

Tracking points before smoothing Smoothing with Smoothing Value = 10

Smoothing with Smoothing Value = 50 Smoothing with Smoothing Value = 90

Modifying Tracking Data
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You can manipulate tracking data points in the Effect Preview monitor in a variety of ways.
You can select individual data points or ranges of data points. You can delete points, move
one or more points, and stretch a range of points. If necessary, you can move points outside
the limits of the frame to extend the movement of an effect smoothly out of the frame.

Unlike the processing performed by SteadyGlide and Smoothing, these kinds of adjustments
change the tracking data itself. They are reversible only by using your application’s Undo
feature, or by retracking to generate a new set of tracking data points.



Modifying Tracking Data

Depending on the speed of the motion you have tracked, your tracking data points might be
very close together at normal magnification and therefore hard to distinguish from one
another. You can use your Avid editing application’s standard methods for zooming and
panning in the Effect Preview monitor to zoom in on your tracking data and view it more
clearly. For more information, see “Using the Effect Preview Monitor” in the Help.

Finding a Specific Tracker Data Point

Whenever multiple data points are displaying for a tracker (when In to Out or All is selected
in the Point Range menu), the data point for the current frame or field displays as a flashing
cross in the Effect Preview monitor. This makes it easy to see the current data point even
when a set of points are very close together.

To find a specific data point:

P  Move the position indicator to the frame or field for which you want to find the data
point.

The data point for that frame or field flashes in the Effect Preview monitor.

To isolate the point further, you can select Current in the Point Range menu in the
Tracking window, so that the point for the current frame or field is the only point that
appears in the Effect Preview monitor.

Selecting Tracker Data Points

To select a single data point:

P Click the point in the Effect Preview monitor.
The point is highlighted with a circle in the monitor, and the corresponding part of the
tracker timeline display changes to white.

To select a single data point and move to the frame or field for that point:

» Double-click the point in the Effect Preview monitor.

The point is highlighted with a circle in the monitor and with a flashing cross, the
corresponding part of the tracker timeline display changes to white, and the system
automatically moves to the frame or field for that point.

To select a contiguous range of data points, do one of the following:

p  Click the first data point in the range you want to select, and then Shift+click the last
data point in the range you want to select.

P Drag the pointer across the range of data points that you want to select to lasso them.

The points in the range are highlighted with a circle and the corresponding part of the
tracker timeline display changes to white.
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The following illustration shows a range of selected data points.

Deleting Tracking Data From Points

You can delete the tracking data generated by the tracking engine for a single data point or
for a range of data points. When you do this, your application repositions the selected point
or points onto a straight line between the two unselected points that bound your selection.
The data points remain fully functional. They display in the Effect Preview monitor at their
newly-calculated locations, and they remain available for you to modify further.

Selected points before deleting Result of deleting — points are repositioned in a straight
line between the unselected bounding points

To delete one or more selected data points:
»  Press the Delete key.

The system repositions the selected data pointsalong a straight line between the two
unselected points that bound the selected points.
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Moving Tracker Data Points

To move a single selected data point:

» Drag the point to a new location.

To move a range of selected data points:
P Drag any one of the points in the range to a new location.

All the selected data points move along with the one you drag and maintain their
positions relative to one another, as shown in the following illustrations.

bs

Selected range of data points Selected range of data points Selected range of data points
before move during move. The points move after move

as a group and maintain their

positions with respect to one

another.

Moving Tracker Data Points Outside the Frame Boundary

If you track a target area that moves out of the frame, the tracking engine can no longer track
the target area and will generate invalid data points. You have two options to ensure
consistent motion if you want your effect to move smoothly out of the frame.

*  You can use offset tracking to track a second target area that does not leave the frame
until the end of the segment. For more information, see “Offset Tracking” on page 96.

*  You can move the very last data point outside the boundary of the frame so that it
extends the line of motion that has been successfully tracked earlier in the segment.
(You will need to reduce the magnification in the Effect Preview monitor to less than
100% to view the area outside the frame.) You can then delete all of the invalid points
between that final point and the last valid data point. Your application will reposition the
points you delete on a straight line. When the effect plays back, the repositioned data
points ensure that the effect moves smoothly out of the frame. If the motion you are
tracking is, for example, simple straight line movement, this might be quicker than
setting up an extra tracking region.
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Stretching a Range of Tracker Data Points
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You can select a range of data points and then stretch them into a new position. In contrast to
simply moving a range of points, the stretching process uses one moving point and one or
two anchor points. As you move the moving point, all the other points in the selected range
stretch to new relative positions.

This feature is particularly useful when the system generates tracking data points that are
slightly offset from the area you are tracking but otherwise represent the motion you are
tracking accurately. For example, if you are tracking an area on a moving vehicle, a
combination of changes in the image from frame to frame and the system’s updating of the
target area might yield tracking data points that lag behind the area you are tracking.

The following illustration shows this behavior.

Frame 1
Object being ®
tracked ®
¢ Frame 6
° rame
° Tracking data [ ]
points ®
[ J
® Frame 11
[}
[ J
[ J

This illustration represents data points created by tracking an area across 11 frames.
Until Frame 6, the system tracks the object accurately. After Frame 6, a small amount of
error is introduced. By Frame 11, the data point lags behind the object being tracked
somewhat. Stretching the points between 6 and 11 so that the last point is placed over
the last triangle will quickly create a complete set of usable points.

You can select a range of points that are slightly out of the ideal position in this way and
stretch them so that they more exactly represent the path of the object you want to follow.
This enables you to achieve the motion you need for your effect without re-tracking or
moving many data points individually.
To stretch a range of data points:
1. Select the range of points as described in “Selecting Tracker Data Points” on page 105.
2. In the Modify Tracking Data area of the Tracking window, click Stretch Points Mode.

The button is purple when Stretch Points mode is turned on.

3. Drag one of the selected points to a new location.



Limiting the Effect of Position Tracking Data to a Single Axis

The points in the selected range are relocated proportionally along the path between the
point you have moved and the anchor point or points. If you move a point at either end
of the selected range, the point at the opposite end becomes the anchor. If you move a
point in the middle of the range, the two end points become anchors.

The following illustrations show these two behaviors.

Original range of selected points
before stretching.

When you stretch by moving one end point, the point at
the other end of the range becomes the anchor while you
drag the moving point. After the stretching process, all
the selected points are relocated proportionally between
the point you have dragged and the anchor point.

When you stretch by moving a point in the middle of
the range, both end points of the range become
anchors while you drag the moving point. After the
stretching process, all the selected points are
relocated proportionally between the point you have
dragged and the two anchor points.

Limiting the Effect of Position Tracking Data to a
Single Axis

In some circumstances, you might want to track an area to generate data on its X, Y position
but then control the movement of the effect on only one axis. You can limit the effect of
Position tracking data to one axis to achieve this effect.
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Limiting Position motion to a single axis is also an option when you want to stabilize a shot
without eliminating camera motion in one direction, such as a pan. However, a more flexible
approach to handling this scenario for most shots is to use data from both axes and then use
SteadyGlide to process the data. For more information, see “Stabilizing an Image” on
page 111 and “Using SteadyGlide and Smoothing” on page 103.

To limit the effect of Position tracking data to a single axis:
1. In the Effect Editor, open the Position parameter category.
2. Click the Enable button for X Only or Y Only.

The Enable button changes to pink when selected.

w Position
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X Only and Y Only buttons

Playback of Effects Using Tracking Data
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Once you have generated tracking data and have modified it to create acceptable sets of data
points, you can play the effect to check its movement over time.

The real-time status of an effect is not altered when it uses tracking data. If an effect is
normally real-time, it remains real-time when it uses tracking data. If an effect normally
requires rendering, it continues to require rendering when it uses tracking data. Playback of
an effect while still in Effect mode also follows the normal behavior of the effect.
To play an effect that uses tracking data:
1. Move the position indicator to the beginning of the effect.
2. Click the Play button.
If you are not satisfied with the appearance of the effect, you can do one of more of the
following to further modify its movement:
»  Adjust the effect’s keyframe parameters.
For more information, see “Changing a Standard Keyframe’s Parameters™ in the Help.
» Modify the existing tracking data.
For more information, see “Modifying Tracking Data” on page 104.
» Re-track all or part of the segment to generate new tracking data.

For more information, see “Generating Tracking Data” on page 94.



Stabilizing an Image

Stabilizing an Image

If you need to eliminate unwanted motion in a video clip, such as motion from an unstable
camera or even more subtle motion such as that introduced during the telecine process as a
result of gate weave, you can use:

e The Stabilize effect

»  The Stabilize Tracking parameter control in a 3D Warp effect promoted to advanced
keyframes.

The Region Stabilize effect is an alternative option for stabilizing a clip. For more
information, see “Using the Region Stabilize Effect” on page 114.

Stabilizing allows you to track an object in a shot that should not be in motion and then use
the tracking data to keep that object stationary and eliminate the unwanted motion. (Objects
such as buildings, telephone or light poles, and fixed objects in nature such as rocks, are
good candidates for tracking when you use the Stabilize effect.) This process will expose
black around the edges of the repositioned frames, so you might need to resize or reposition
the clip to remove the exposed edges.

If you use stabilizing and also process the tracking data using SteadyGlide, you can
eliminate unwanted jittery movement while retaining underlying camera motion such as a
pan. For more information, see “Using SteadyGlide and Smoothing” on page 103.

You can also use stabilizing to create unusual special effects. For example, if you stabilize an
object that is actually moving in a clip, you force other parts of the clip to move from frame
to frame. You can take a clip of a person running down a street, stabilize on that person, and
force the buildings in the shot into motion.

Unlike other effects that use motion tracking, stabilizing works with only one layer of video,
using the tracking data to move each frame of the video as much as is needed to keep the
tracked object stationary.

Clips that contain extreme camera motion might be hard to stabilize successfully since they
will need to be resized substantially to remove exposed edges. As a result, you might lose so
much of the image information that the clip will no longer be useful.
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To stabilize a segment:
1. Do one of the following:
» Apply the Stabilize effect from the Image category in the Effect Palette.

» Apply the 3D Warp effect from the Blend category in the Effect Palette (or promote
an effect that uses tracking data to 3D), and then promote the effect to advanced
keyframes by clicking the Promote to Advanced Keyframes button in the Effect
Editor.

The Stabilize effect itself is one of the effects that you can promote both to 3D and to
advanced keyframes, so you can stabilize an image using the Stabilize effect and then
promote it to access additional effect functionality. When you promote the Stabilize effect to
3D and to advanced keyframes, Stabilize Tracking is automatically activated for all effect
parameters that use tracking data.

2. Enable and prepare one or more trackers, by doing one of the following:

» For the Stabilize effect, open the Tracking parameter category and click the Enable
button for one or more trackers.

» For the 3D Warp effect promoted to advanced keyframes, open the Position
Tracking, Rotation Tracking, Scaling Tracking, or Corner Tracking parameter
categories, then click the Stabilize Tracking button, and then enable one or more
trackers.

For more information, see “Preparing to Generate Tracking Data” on page 85. For
specific information on the number of trackers to use when stabilizing, see “Guidelines
for Using Multiple Trackers When Stabilizing” on page 113.

3. (Option) If you are using the 3D Warp effect, in the Tracking window, choose Track
Foreground from the Track Background/Foreground menu.

4. Generate the tracking data.
For more information, see “Generating Tracking Data” on page 94.
5. Click the Play Loop button to play the segment repeatedly.

The system repositions each frame or field in the segment so that the object you have
tracked remains in the same position that it occupies in the first frame or field.

6. (Option) Use SteadyGlide with your trackers if you want to remove jittery motion, such
as that in a hand-held camera shot, while retaining underlying motion such as a pan.

For more information, see “Using SteadyGlide and Smoothing” on page 103.

7. As the segment plays, notice where black has been exposed at the edges of the frame by
the stabilizing process.

8. When you have finished reviewing the stabilized segment, press the space bar to
stop playback.



Guidelines for Using Multiple Trackers When Stabilizing

9. (Option) If necessary, re-center the image using the Position parameter sliders in the
Effect Editor.

This step is useful if you see more exposed edge material on one side of the image than on
the opposite side. By re-centering the image, you can balance the size of the exposed edges
on either side and reduce the amount of resizing needed to eliminate the edges.

10. (Option) If necessary, adjust the Scaling parameter sliders in the Effect Editor to enlarge
the image enough to eliminate the exposed edges.

11. Continue to review the effect and adjust parameter controls until you are satisfied with
the final look.

Guidelines for Using Multiple Trackers When
Stabilizing

As with other effects that use motion tracking, the number of trackers that you need when
stabilizing depends on the complexity of the motion you want to stabilize. However,
multiple trackers might introduce unnecessary additional motion that is detrimental to the
final look of the clip, so you should use them only when they are absolutely necessary.

When the motion of an unstable camera is limited to movement on the X and Y axes only,
you need only one tracker (enabled either in the Position parameter category or in the
Tracking parameter category). Even when you see a small amount of rotational movement or
change in scale in an image you want to stabilize, you will probably find that a single point
will stabilize the image well enough to give an acceptable result without introducing
unwanted motion.

If you are stabilizing a clip that shows significant changes in scaling, rotational, or other
movement, or if you are using the Stabilize effect to create a special effect, you might need
to use two or even more tracking points.
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Using the Region Stabilize Effect

The Region Stabilize plug-in effect provides an alternative option for stabilizing an image.
Although the Region Stabilize effect provides fewer controls than the Stabilize effect or the
Stabilize Tracking option in 3D Warp, its simplicity makes it easier to use, and it might be
all you need in some circumstances. Region Stabilize also provides two options that are
unavailable in Stabilize:

*  The AutoZoom option automatically resizes and repositions the segment to remove
exposed black around the edges of frames repositioned as a result of the stabilization
process.

»  The Progressive Source option allows you to specify that the footage you are tracking is
progressive material so that it is tracked correctly in an interlaced project.

The following illustration shows the Region Stabilize parameters.
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For a reference summary of the Region Stabilize effect and its parameters, see “Image:
Region Stabilize” in the Help.

Stabilizing an Image with the Region Stabilize Effect

You apply the Region Stabilize effect from the Image category in the Effect Palette.
To stabilize a clip:
1. Enter Effect mode by selecting Toolset > Effects Editing.
For more information, see “Entering Effect Mode” in the Help.
The Effects Editing toolset appears.
2. In the Effect Palette, click the Image category.

3. Drag the Region Stabilize Effect icon to the segment you want to stabilize.
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4. Move the effect position bar to the segment with the Region Stabilize effect.

A wire frame appears in the Effect Preview monitor to indicate the region of interest.
This is the area you want to use in stabilizing the image.

5. Reposition and resize the wire frame by doing one of the following:
»  Use the sliders in the Region of Interest parameter category.
P Click the wire frame, and drag it in the Effect Preview monitor.

Select a region that contains one or more features that do not change much from frame
to frame, for example, objects such as buildings or rocks. Another approach is to shoot
the scene with stabilization in mind: include an object, such as a reflective sticker, that
you intend to use as your region of interest.

B, 6. Click the Model Fast Menu button, and select the type of stabilization:

- Translational keeps the region of interest steady along both the horizontal and the
vertical axes.

- Horizontal constrains horizontal motion in the region of interest. Features in the
region of interest can move vertically but not horizontally.

- Vertical constrains vertical motion in the region of interest. Features in the region
of interest can move horizontally but not vertically.

7. (Option) Turn on Auto Zoom:
a. Click the triangular opener for the Options parameter category.
b. Select Auto Zoom.

Stabilization exposes black around the edges of the repositioned frames. Auto Zoom
compensates by resizing and, if necessary, repositioning the clip to remove the
exposed edges.

115



Chapter 3 Motion Tracking and Stabilization

m

8.

(Option) Select Progressive Source:
a. Click the triangular opener for the Options parameter category.
b. Select Progressive Source.

Select Progressive Source if your footage was captured or converted to progressive
footage (not interlaced). If your sources are progressive, selecting Progressive Source
produces smoother results.

Progressive Source has no effect in 24p projects because the application assumes that you
are using progressive footage.

If you click the Progressive Source button and your underlying source is not progressive, you
may see motion artifacts between fields in the rendered effect.

9.

10.
11.
12.

Render and review the effect.

If the rendered clip does not perform as expected, see “Making Adjustments to the
Region Stabilize Region of Interest” on page 116.

(Option) Add keyframes to further refine the motion of the stabilized clip.
Continue to review and refine the effect until you achieve the results you want.

(Option) Resize and, if necessary, reposition the clip to eliminate black edges.

Making Adjustments to the Region Stabilize Region of Interest

116

If the Region Stabilize effect does not perform as expected, it might be due to one of the
following:

Large motion. If an object in your region of interest moves too far away from the region
from one frame to the next, the rendered clip might display unexpected results.

Extraneous motion. An object in your region of interest might move over the course of
the clip in a way that unpredictably affects the stabilization.

Insufficient texture. The region of interest might not have enough features to allow
Region Stabilize to track it effectively.

If the Region Stabilize effect does not perform as expected, experiment with the following
adjustments:

Increase the size of the region of interest, or reposition it, to encompass large motion.

Decrease the size of the region of interest to eliminate extraneous motion that is
affecting the stabilization.

Select a new region of interest.

Add keyframes to reestablish or refine the region of interest over the course of the clip.



Editing Segments That Use Tracking Data

Editing Segments That Use Tracking Data

Once tracking data exists for a segment, you can edit that segment in a number of standard
ways without losing the tracking data and having to re-track.

Segment Mode Editing with Segments That Use Tracking Data

Tracking data persists during Segment mode editing. For example, if you shift the position
of a segment that contains tracking data, or copy a segment to another point in your
sequence, the data is still available. If you lift a portion of the segment out of your sequence,
tracking data is preserved on all parts of the segment for the range of frames in each part.

Remember, however, that if you move only the foreground layer of a multilayer effect, the
tracking data will be useful only to the extent that it corresponds, or can be made to
correspond, to the background layer at its new location. For example, if you shift an effect
segment with tracking data a few frames with respect to the background material beneath it,
you might be able to continue to use the tracking data to follow the background area
(perhaps by selecting all the points and moving them a little). If you shift the effect segment
substantially, or even place it over a different background clip, the tracking data remains
available but has no practical use.

In some situations, it might be useful to create a multilayer effect with motion tracking as a
nested effect. If you do this, you can move or divide the nested effect during segment editing
and be sure that the effect will stay in sync with the tracked material. For more information,
see “Nesting Effects” in the Help.

Trimming Segments That Use Tracking Data

If you trim in from the edges of a segment, tracking data is preserved for both the new length
of the segment and for the material you have trimmed. If you later trim the edges of the
segment back out, the tracking data is still available to control the motion of your effect.

If you trim out beyond the tracked data for an effect, you must track over the range of these
new frames to generate data for them.

If you edit a segment into a sequence by marking it to be longer than you will finally need,
you can track the whole segment, trim it in, and know that you will be able to adjust the
trims back out when fine-tuning your sequence without having to re-track. This might be a
useful approach if you know that a clip is likely to be trimmed.
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Adding Transition Effects to Tracked Segments

If you add a transition effect to a tracked segment you will usually need to track the
additional frames that are used by the transition. For example, if you add a standard one-
second, centered-on-cut dissolve at the beginning of a tracked segment, the dissolve will use
one-half-second of new material from the tracked segment’s master clip.

It might be difficult to track these additional frames after you apply the transition effect

because the Effect Preview monitor displays the combination of outgoing and incoming

media created by the transition effect. In the case of a dissolve, for example, the monitor
shows the blend of outgoing and incoming frames, which often obscures the pattern you
need to track.

You can avoid this problem by doing the following:
1. Trim the tracked segment out by the number of frames that the transition will require.
2. Track the frames added by this trim.

3. Trim the tracked segment back in to the original edit point.

4. Add the transition effect.

Reusing Existing Tracking Data

Once you have created tracking data for an effect, that data is available for reuse in several
different contexts. You can reuse tracking data within the same effect. You can copy and
paste tracking data to another effect.

When to Reuse Tracking Data
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Trackers initially created and mapped to one effect parameter are available for use in any
other parameter in the effect that can use tracking data. For example, you might create a
single tracker with the default Point A name in the Position parameter category. This tracker
is available for use in other parameters such as Scaling.

The Tracking parameter and the Position, Scaling, and Rotation parameter categories form
two mutually exclusive groups. You cannot have tracking enabled in both groups at the same
time. For more information, see “Effects and Effect Parameters That Use Tracking Data” on
page 77.



Reusing Existing Tracking Data

You are less likely to want to use tracking information outside the effect for which it was
created since the information refers specifically to the motion in one particular background
clip. No other background clip is likely to contain exactly the same movement. However,
there are some circumstances in which you might want to move tracking data to a new effect,
such as the following two examples:

*  You might want to move tracking data to an additional effect applied over the same
background clip in the sequence. This might be a duplicate use of the background at
another point in the sequence or an extra effect layered above the first (such as a second
Picture-in-Picture effect tied to the same background movement).

*  You might want to destabilize a stable shot so that it has a handheld look. To do this, you
can track a segment that does have unsteady camera motion, and then copy the resulting
tracking data to an effect on the segment you want to destabilize.

Copying and Pasting Tracking Data

You can copy one or more trackers and their associated tracking data and then paste those
trackers into another effect. You can also copy one or more trackers and paste them within
the same effect to create two versions of a tracker. This might be useful if you want to make
two different sets of modifications to tracking data and then compare the effect of each set
on the effect.
To copy and paste tracking data into another effect:
1. Enable the trackers you want to copy in the Tracking window.
2. Do one of the following:
P Select Edit > Copy.
P Press Ctrl+C.
3. Move the position indicator to the effect to which you want to copy the trackers.
4. Make sure that the Tracking window is active.
5. Do one of the following:
» Select Edit > Paste.
P Press Ctrl+V.

The trackers appear in the Tracking window below any existing trackers. For example, if
you are pasting into an effect that has trackers T1 and T2, the pasted trackers will be
numbered T3 and T4.

6. (Option) If existing trackers in the effect have the same name or color as the trackers
you paste, you might want to rename the trackers that have duplicate names or change
their assigned colors to avoid confusion.
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To copy and paste tracking data within the same effect:
1. Enable the trackers you want to copy in the Tracking window.
2. Do one of the following:
» Select Edit > Copy.
» Press Ctrl+C.
3. Do one of the following:
» Select Edit > Paste.
» Press Ctrl+V.

Duplicate copies of the enabled trackers appear in the Tracking window with new
tracker numbers.

4. Rename the duplicate copies, and change their assigned colors so that you can continue
to distinguish between the different versions.

Conforming Symphony Meridien Sequences with
Tracking Data

Tracking data in sequences originally created on Symphony Meridien systems is available
for use when those sequences are opened in your Avid editing application. You can
manipulate the data in all the ways described in “Using SteadyGlide and Smoothing” on
page 103 and “Modifying Tracking Data” on page 104. You can also add new regions to the
tracker timelines, for example, to perform offset tracking.

Neither of the tracking engines used by Symphony Nitris works in the same way as the
tracking engine used in Symphony Meridien systems. As a result, if you retrack all or part of
a segment containing tracking data created on a Symphony Meridien system, the new data
that you create will not match the old data exactly.

Examples of Effects Using Motion Tracking
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This section includes two illustrated examples of typical uses of motion tracking to control
effects. Studying these examples will help you to understand how you can use motion
tracking in your own work.

If you find it difficult to distinguish details in the printed versions of the following
illustrations, you can view them in full color in the online version of this guide available
from the Online Library for your application.



Examples of Effects Using Motion Tracking

Example 1: Replacing the License Plate on a Moving Vehicle

This example uses motion tracking to track the license plate on a truck and then replace the
plate with an imported graphic.

In this case, the license plate in the footage is white and the surrounding areas of the truck
are generally dark, so the exact corners of the license plate are good targets for the tracking
operation. However, if tracking the exact corners of the plate is difficult, you can track other
points on the back of the truck to achieve the same control over the changing size and shape
of the replacement plate. For more information, see “Guidelines for Positioning Tracking
Boxes” on page 91.

All four corners of the license plate have been tracked for this example to ensure that any
skew and perspective changes are recorded by the tracking data. In fact, changes in
perspective are relatively small in this clip since the plane of the back of the truck remains at
almost exactly the same angle with respect to the plane of the screen. You might be able to
achieve an acceptable finished look for this clip by using three trackers or even just two
trackers on opposite corners of the license plate, especially since the replacement object is
small.

Original Material

These illustrations show the original materials used for this example. On the left is the
first frame of the video clip. The effect will replace the white license plate. On the right is
the graphic used as the replacement license plate. A blur has been applied to the
graphic so that it will blend in with the clip. (You could do this in a graphics application or
use Blur mode in the Paint Effect.) In the finished effect, a softened border is also
applied to disguise the sharp edge of the graphic.
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Tracking Information

This illustration shows the location of the
four tracking boxes at the four corners of
the license plate.

. il [}
This illustration shows the tracking data points that the system generates for the four
trackers. As the truck moves into the distance and the plate gets smaller, the points
move closer together.



Examples of Effects Using Motion Tracking

Comparison of Original Video and Finished Effect

These illustrations show images from the beginning, middle, and end of the clip. The
images on the left are from the original clip; the images on the right show the final effect
with the replacement license plate. The replacement plate is positioned and sized
manually in the first frame of the clip. The size and shape of the replacement changes
under the control of the tracking data in the remaining frames of the clip.
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Example 2: Special Effects Using Targets for Motion Tracking
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This example uses special effects footage that has been specifically created to make use of
motion tracking. White targets have been placed in the shot to be tracked. After tracking
these targets, you can use the tracking data to control the movement of an effect layer, for
example, a keyed video image or an object created with the Paint Effect. In this example, the
tracking data controls the movement of an object created with the Paint Effect.

Original Material

These two illustrations show the first frame of the clip. On the left is the original video showing
the target white dots on the wand. On the right is the image with the Paint object added.

Tracking Information

This illustration shows the two tracking This illustration shows the generated
boxes located over the targets. tracking data points for the entire clip.



Examples of Effects Using Motion Tracking

Comparison of Original Video and Finished Effect

These illustrations show images from the beginning, middle, and end of the clip. The
images on the left are from the original clip; the images on the right show the final effect
with the Paint object.
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Chapter 4
Understanding Color Correction Mode

Like other modes in Avid Symphony Nitris, such as Trim mode and Effect mode, Color
Correction mode reconfigures the Edit monitor display to provide a specialized interface.

“Color Correction Mode Basics” in the Help provides basic information on how to enter
Color Correction mode and descriptions of the main elements of the Color Correction mode
display. This chapter provides more detailed information on how to control and customize
the Color Correction mode display.

This chapter contains the following main sections:

*  The Composer Window in Color Correction Mode

*  The Color Correction Tool

*  Working with Color Correction Effect Templates

» Displaying Color Correction Information in the Timeline

The Composer Window in Color Correction Mode

The Composer window in Color Correction mode allows you to view material from three
segments at once, making it easy to compare material on a shot-by-shot basis. This three-
monitor view shares many of the features of the monitors in other modes but also includes
several features specific to Color Correction mode.

The following illustration shows the features of the Composer window in Color Correction
mode.
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The following topics in the Help provide basic information on the Composer window in
Color Correction mode:

e “Composer Window Monitors in Color Correction Mode”
e “Switching Between Current and Reference Monitors Using the Escape Key”
e “Composer Window Buttons in Color Correction Mode”

This section provides additional detail about using and customizing the Composer window
in Color Correction mode.

Activating Monitors
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As in Source/Record mode, only one of the monitors is active at any one time. The position
bar is highlighted in the active monitor, and the image from the active monitor is displayed
in the Client monitor.

To activate a monitor:

» Click anywhere in the monitor’s image area, in the position bar, or on the Tracking
Information Display menu.

To switch between the center and right monitors:
» Press the Escape key.
For more information, see “Switching Between Current and Reference Monitors Using

the Escape Key” in the Help.

When you click one of the Composer Window buttons below a monitor, Symphony Nitris
activates that monitor and performs the action associated with the button.



The Composer Window in Color Correction Mode

Displaying Tracking Information

The Composer Window monitors in Color Correction mode have the same options for
displaying tracking information that are available in other modes.

To display tracking information:

»  Click the monitor’s Tracking Information Display menu, and then select the format you
want from the menu.

By default, the Tracking Information Display menu shows no information until you
select a tracking format.

If you select the option in the Composer Settings dialog box for two information rows above
the monitors, you can display two different types of tracking information in each monitor,
just as you can in other modes.

For more information on tracking information display, see “Displaying Tracking
Information” in the Help.

Displaying Images in Monitors

The default Color Correction display shows images from three adjacent segments in the
Timeline. You can customize the display to show images from other parts of the sequence, to
show specific images in a split-screen display, to hide the video, or to display wide-screen
(16:9) video.

Understanding Default Monitor Display

By default, the center monitor shows the current segment (the segment the position indicator
is on in the Timeline). The left monitor shows the previous segment (the segment before the
current segment), and the right monitor shows the next segment (the segment after the
current segment).

When you move in the sequence by clicking a Composer Window button or by placing the
position indicator on a new segment in the Timeline, all three monitors update to maintain
the same relationship between displayed segments.

The following illustrations show the default monitor display behavior.
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Configuring Image Display in Monitors
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following table.

To configure the display in a monitor:

Example 1

The position indicator
is on segment B in the
Timeline. The three
monitors display
segments A, B, and C.

Example 2

The position indicator
has moved to segment C.
All three monitors have
updated so that they now
display segments B, C,
and D.

You can configure each monitor to display those segments that are most useful for making
comparisons in your project.

» Click the monitor’s Source menu, and select one of the options described in the



The Composer Window in Color Correction Mode

Source Menu Commands

Option

Description

Empty

Entire Sequence

Reference

Current

Previous

Next

Second Previous

Second Next

Waveform and

Vectorscope commands

Quad Display
RGB Histogram
RGB Parade
Vectorscope

Y Waveform

YC Waveform
YCbCr Histogram
YCbCr Parade

Displays no image (black).

Makes the entire sequence available in the monitor. This is useful when you want to
compare shots from many different places in a sequence. For example, you can display
the current segment and the next segment in two monitors for immediate shot-to-shot
comparison and display the entire sequence in the third monitor so that you can quickly
navigate to any other part of the sequence you want to view. When you change the
current segment, the entire sequence updates to that segment.

You can use the Play Loop button in the Command palette to play the whole
sequence in the active monitor even if the monitor is not set to Entire Sequence.
For more information, see “Using the Play Loop Button in Color Correction
Mode” on page 134.

Locks the current frame (the frame the position indicator is on) in the monitor. For
more information, see “Working with Reference Images” on page 132.

Displays the current segment. This option is not available in the Source menu if another
monitor is already set to Current.

Displays the segment immediately before the current segment.
Displays the segment immediately after the current segment.

Displays the segment two segments before the current segment (the segment the
position indicator is on in the Timeline).

Displays the segment two segments after the current one.

These commands configure the monitor as a Waveform monitor or a Vectorscope
monitor. For more information, see “Working with the Waveform Monitors and the
Vectorscope Monitor” on page 256.
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Working with Reference Images

You can lock the current frame in a monitor to use as a reference image. When the other
monitors update as you navigate in the Timeline, this frame continues to display as a
reference. This is useful if you want to use a specific place in your sequence as a reference
against which to compare all other shots, for example, a segment that contains optimal skin
tones.

If you use the right monitor to display a reference image and keep the current segment in the
center monitor, you can use the convenient Escape key shortcut to switch between these two
monitors. For more information, see “Switching Between Current and Reference Monitors
Using the Escape Key” in the Help.

To lock the current frame as a reference:

» Right-click in the Composer window or the Color Correction tool, and select Reference
Current.

If another monitor is already set to display a reference image, the current frame displays
in that monitor. If no monitor is set to display a reference image, the right monitor’s
Source menu is set to Reference and the current frame displays in that monitor.

The Reference Current command is also available as a button in the CC tab of the Command
Palette. You can map this button to any mappable key on your keyboard or to any mappable
button location in the user interface. For more information, see “Using the Command
Palette” in the Help.

Splitting the Image Display in Monitors

B

132

You can configure a monitor so that it splits the screen to show the image before and after
the current color correction adjustments are applied.

To display uncorrected and corrected images in a split screen (Dual Split):
»  Click the Dual Split button for the monitor you want to display the split screen.
The split-screen display appears in the monitor and in the Client monitor.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version available from the Online Library for your application.



The Composer Window in Color Correction Mode

Image with currently
active corrections
applied

Uncorrected image

The uncorrected image appears on the left, and the image with currently active corrections
applied appears on the right. You can resize the box that contains the split-screen image by
dragging its triangular handles in the monitor.

Triangular handle for
adjusting size of
uncorrected image

The Dual Split command is also available as a button in the Other tab of the Command
Palette. You can map this button to any mappable key on your keyboard or to any mappable
button location in the user interface. For more information, see ““Using the Command
Palette” in the Help.

To cancel the Dual Split display:

p  Click the Dual Split button for the monitor that contains the Dual Split display.

The monitor returns to a single-image view.

Hiding the Video in Monitors

You can hide the video image area of the monitors at any time. When the video is hidden,
you see only the Source and Tracking Information Display menus and the position bars for
the monitors. The other parts of the Color Correction mode display expand to fill the
remainder of your screen. This might be a preferable setting if you can perform your color
correction tasks using only the Client monitor to view your image.
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To hide the video in the monitors:

» Right-click in the Composer window or in the Color Correction tool, and select Hide
Video.

When the video is hidden, a check mark appears beside the Hide Video command.

To display the video again:

» Right-click in the Composer window or in the Color Correction tool, and select Hide
Video.

When the video is visible, there is no check mark beside the Hide Video command.

Displaying 16:9 Video in Monitors

You can display wide-screen 16:9 video as well as standard format 4:3 video in the monitors
in Color Correction mode just as you can in other modes.

To display 16:9 video in the monitors:
» Right-click in the Composer window, and select 16:9 Video.

When the monitors are set to display 16:9 video, a check mark appears beside the 16:9
Video command.

To display standard format 4:3 video again:
» Right-click in the Composer window, and select 16:9 Video.

When the monitors are set to display 4:3 video, there is no check mark beside the 16:9
Video command.

Using the Play Loop Button in Color Correction Mode

wka
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The Play Loop button has a specialized function in Color Correction mode. The Play Loop
button does not appear in the Composer window but does control the playback of material in
the Composer window. You can access the Play Loop button from the Play tab of the
Command palette or from the keyboard if it has been mapped to a keyboard location.

When you click the Play Loop button, Symphony Nitris plays the whole sequence in the
active monitor, starting from the current position of the position indicator. Playback is not
limited to the current segment alone, regardless of the Source menu option selected for the
monitor. This is useful whenever you want to view the whole sequence quickly without
switching monitors or making a new Source menu selection.



The Composer Window in Color Correction Mode

Reviewing Color-Corrected Clips with the Edit Review Button

=

The Edit Review button has a specialized function in Color Correction mode. Symphony
Nitris plays the current clip along with parts of the previous and next clips, allowing you to
quickly review the color correction on a clip in the context of the adjoining clips.

The Edit Review button does not appear in the Composer window in Color Correction mode,
but you can access the Edit Review button from the Play tab of the Command palette or from
the keyboard if it has been mapped to a keyboard location.

When you click the Edit Review button, Symphony Nitris plays part of the previous clip, all
of the current clip, and part of the next clip. When playback is complete, the position
indicator returns to its location in the current clip before you clicked the button.

The amount of material the system plays from the previous and next clips is determined by
the current Preroll and Postroll settings in the Play Loop tab of the Trim Settings dialog box.
For more information on trim settings, see “Trim Settings” in the Help.

Controlling Frame Display in the Composer Window

You control the behavior of the Go to buttons in the Composer window (Go to Previous
Shot, Go to Next Shot, Go to Previous Uncorrected Shot, and Go to Next Uncorrected Shot)
by selecting options in the Fast Forward and Rewind area of the Composer Settings dialog
box.

You can set your application to jump to the first frame of the relevant segment (the default
setting), the last frame, or the frame that is marked with a locator. For more information, see
“Composer Settings: FF/REW Tab” in the Help.

Although the default first-frame behavior might be acceptable in many circumstances, the
availability of the option Stop at Locators makes it possible to mark a reference frame for
each segment in your sequence before you begin color correction. As you move around in
your sequence, you always see the reference frame in the monitors.
To control frame display with locators:
1. In Source/Record mode, add a locator to your chosen reference frame for each segment
of the sequence using the standard procedure described in “Using Locators” in the Help.

1o navigate successfully in the sequence while in Color Correction mode, you must place a
locator in every segment. You should not have more than one locator in any segment.

2. In the Settings tab of the Project window, double-click Composer.
The Composer Settings dialog box opens.
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3. In the FF/REW tab, select Stop at Locators, and then click OK.

- 4. Enter Color Correction mode by clicking the Color Correction Mode button at the
bottom of the Timeline.

As you use the Composer Window buttons to move around in your sequence, the
Composer window changes to display the frame marked by the locator in each segment.

You can add locators while in Color Correction mode by mapping the Add Locator button to
the keyboard or by using the Command palette in Active mode. However, you cannot change
Composer settings while in Color Correction mode.

The Color Correction Tool

The Color Correction tool is the part of the Color Correction mode display that you use to
make adjustments to color. It is also where you control how much and what kind of material
you are correcting at any one time.

The following illustration shows the Color Correction tool in its default configuration.

Correction Type button Group tabs Color Match control. For more information, see Color Correction Tool buttons
“Using the Color Match Control” in the Help.

Subdividing tabs  Color adjustment sliders Enable buttons Automatic Color Color Correction buckets
Correction buttons

Working with Correction Types
The Color Correction tool has a Correction Type button that you use to select the type of

color correction you want to make. Selecting a correction type is one of the first and most
important steps you take when making any color correction in the Color Correction tool.
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When you move the position indicator to a segment that has color correction, the Correction
Type button changes to indicate the type of correction that is applied to that segment. If you
click the Correction Type button, the correction type for the segment is highlighted in the
Correction Type menu.

To select a correction type:

P  Click the Correction Type button, and select the type you want from the menu.

The options available in the Correction Type menu fall into two categories:

* Relationship color corrections. All but one of the options allow you to select a
relationship so that you can apply a correction to a group of related clips in one
operation. For more information, see “Understanding Relationship Color Corrections”
on page 137.

* Color Correction effect corrections. The last option allows you to make a color
correction using the Color Correction effect. There are some situations where you need
to use a Color Correction effect rather than a relationship color correction to make a
correction. For more information, see “Using the Color Correction Effect” on page 266.

Understanding Relationship Color Corrections

Relationship color corrections allow you to define the scope of any correction you make. For
example, if all the material from one source tape in your project needs the same color
correction because the camera had poor white balance, you can make that correction to every
segment in a sequence that you captured from that source tape in one operation.

Relationship color corrections also distinguish between Source corrections and Program
corrections. You can make both a Source correction and a Program correction on a segment,
allowing you to make two different correction passes on the same material. A common use
of this feature is to make color corrections for different purposes at different stages in your
editing workflow. For example, you might make a set of corrections specifically to correct
problems with the color in your source footage, and then later make a separate set of
corrections to make final adjustments for artistic or editorial purposes. The terms “Source”
and “Program” reflect this kind of workflow.

The Color Correction tool uses color coding on both the Correction Type button and the
active Color Correction tabs to indicate the type of correction you are applying or the type of
correction that currently exists for a segment:

» Green indicates Source corrections.
*  Blue indicates Program corrections.

* Qray indicates a Color Correction effect correction.
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138

Relationship color corrections appear in the Timeline with green dots, indicating that they
will play back in real time, subject to the playback capabilities and constraints of your
system. Like any other effect, you might need to render a relationship color correction to
ensure real-time, full-quality playback in some circumstances. For more information, see
“Real-Time Preview of Video Effects” in the Help.

Symphony Nitris processes relationship color corrections before all other effects, with the
exception of Timewarp effects. (Timewarp effects are processed first to ensure that they do
not become unrendered when you apply a color correction.) This processing order can
determine how you choose to apply color corrections in combination with other effects, and
is one of the factors that might require you to use a Color Correction effect rather than a
relationship color correction. For more information, see “Using the Color Correction
Effect” on page 266.

The following table describes the relationship color correction options available in the
Correction Type menu.

Relationship Color Correction Options

Relationship Description

Src (Source) Tape Corrects the current segment and all other segments in the sequence
that use material from the same source tape.

Src (Source) Clip Name Corrects the current segment and all other segments in the sequence
that have the same clip name. (This relationship ignores clip name
extensions — .new and any subsequent characters — created during
decomposing and batch capturing.) For more information on using this
option, see “Using the Source Clip Name Relationship” on page 139.

Master Clip Corrects the current segment and all other segments in the sequence
that use material from the same master clip.

Sub Clip Corrects the current segment and all other segments in the sequence
that use material from the same subclip.

Src (Source) Segment  Corrects only the current segment (the segment the position indicator is
on in the Timeline).

Prog (Program) Track ~ Corrects the current segment and all other material on that segment’s
track.

Prog (Program) Segment Corrects only the current segment.

You can also apply a Source Segment or a Program Segment correction to the material
between marked IN and OUT points. For more information, see “Customizing Color
Correction Settings” on page 148.
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Using the Source Clip Name Relationship

For many project situations, the Source Tape, Master Clip, and Sub Clip relationships are
sufficient to allow you to make any Source color corrections to groups of related clips.

When a sequence is moved to an Symphony Nitris system from another Avid editing
application, however, a common workflow involves decomposing the sequence and
recapturing. This destroys the original clip relationships by creating a new master clip (with
a .new.xx extension) for every segment in the sequence. (For more information on this
process, see “Using Decompose When Recapturing” in the Help.)

The Src (Source) Clip Name relationship is designed to allow you to make related
corrections after decomposing and recapturing by referencing the clip name. It applies a
correction to the current segment and to any other segment that has the same clip name. The
Source Clip Name relationship ignores the clip name extensions that are created during the
decomposing and recapturing cycle.

As long as the clip names are consistent, this relationship effectively allows you to color
correct by the original master clip relationship even though that relationship is not directly
available to you. If you use the Source Clip Name relationship in this way, you should check
the clip names before color correcting and verify that they are consistent. If you find names
that are in conflict, you can rename them so that they will be correctly referenced by the
Source Clip Name relationship.

Converting Relationship Color Corrections

You can convert one kind of Source relationship correction to another, or one kind of
Program relationship correction to another.

You cannot directly convert a Source relationship correction to a Program relationship
correction, or a Program relationship correction to a Source relationship correction.
However, you can use your application’s color correction effect template capabilities to
make such a conversion indirectly.

To convert a Source relationship correction to another Source relationship correction,
or a Program relationship correction to another Program relationship correction:

1. Move the position indicator to the segment that carries the correction you want to
convert.

2. Click the Correction Type button, and choose a new type from the menu.
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To convert a Source relationship correction to a Program relationship correction, or a
Program relationship correction to a Source relationship correction:

1. Move the position indicator to the segment that carries the correction you want to
convert.

2. Save the adjustment values for the existing correction as a template, for example by
dragging from the Color Correction Effect Template button to a bin.

3. Click the Remove Effect button to remove the existing correction.
4. Click the Correction Type button and select the new correction type you want.
5. Drag the color correction effect template that you saved in step 2 from the bin, and drop

it in the monitor displaying the current segment.

For full information on working with color correction effect templates, see “Working with
Color Correction Effect Templates” on page 154.

Working with the Group and Subdividing Tabs
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The Color Correction tool uses a tabbed design to arrange its controls and to indicate their
relationship to one another. At the top level of the hierarchy are five tabs that contain the
controls for each main color correction group. Within some of these group tabs are one or

more additional sets of tabs, arranged vertically on the left side of the tool, that subdivide the
controls for that group.

For more information on the detailed organization of each group and the controls within
each tab, see the chapter “Performing Color Corrections” on page 163.

You can hide any of the top-level tabs (along with their subdividing tabs) so that they do not
appear in the Color Correction tool. This is useful if you normally use only a small number
of the tabs. For more information, see “‘Customizing Color Correction Settings” on

page 148.

S Segment

Group tabs at the top of the Color Correction tool with a Source
correction type selected. The Correction Type button and the active tab
are colored green

Group tabs at the top of the Color Correction tool with a Program
correction type selected. The Correction Type button and the active tab
are colored blue
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Subdividing tabs on the left side of the Color
Correction tool, shown in relation to the higher level
HSL group tab. The active tabs are green. Names
on the inactive tabs appear dimmed.

The complete hierarchical structure of the Color Correction tool is as follows:

Group tab — for example, HSL

v

Group subdividing tab — for example, Controls within
HSL (The HSL group has a second level of subdividing
tabs — for example, Highlights within Controls.)

'

Individual control — for example, Brightness
slider within the Highlights pane of the Controls
subdividing tab within the HSL group.

Displaying a Group Tab

To display a color correction group tab:

P Click the tab in the area containing the group name.

Click in this area of a tab to display the tab.
Do not click the Enable button.

The tab name is highlighted and colored based on the correction type, the tab moves to
the front, and the specific controls for that tab appear.

Do not click the Enable button when you want to display a color correction group tab.

The following illustrations show how the display changes when the Curves tab is clicked.
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Before

The Curves tab name appears
dimmed, and the tab displays behind
the currently active HSL tab. The
active HSL tab appears blue.

After

The Curves tab appears blue, and
the tab displays in front of the other
group tabs. The curves controls are
now visible in the tab.

You can cycle through the group tabs using the Page Down key (to cycle from left to right) or
the Page Up key (to cycle from right to left).

For detailed information on adjusting color using the controls within the color correction
groups, see the chapter “Performing Color Corrections” on page 163.

Displaying a Subdividing Tab
To display a subdividing tab:
1. Click the group tab in the area containing the group name.
2. Click the subdividing tab in the area that contains the subdivision name.

The tab name is highlighted and colored based on the correction type, the tab moves to
the front, and the specific controls for that tab appear.

3. (Option) If necessary, click the second-level subdividing tab in the area that contains the
second-level subdivision name.

This step is necessary when you want to display the second-level subdividing tabs
within the Controls and Luma Ranges subdivisions of the HSL group.
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Associating Group and Subdividing Tabs with Tab Buttons

The Command palette contains twelve Tab buttons that you can use to provide one-click
access to specific tab displays. For example, if you adjust the Luma Ranges graphs
frequently as part of your color correction work, you can configure three Tab buttons to
display the three Luma Ranges tabs (Highlights, Midtones, and Shadows).

To associate a Color Correction tab with a Tab button:

1.

In the Color Correction tool, click the tab that you want to map to a Tab button.

For example, click the Highlights tab within the Luma Ranges tab within the HSL group
to assign that specific subdividing tab.

2. Select Tools > Command Palette.

3.

4.
S.

The Command palette opens.
Click the CC tab.

The Color Correction buttons appear, including the twelve Tab buttons.

Tab buttons

At the bottom of the Command palette, select Active Palette.

Alt+click the Tab button with which you want to associate the Color Correction tab.

To display a group or subdividing tab using a Tab button:

1.

wn kA~ W N

Enter Color Correction mode by clicking the Color Correction Mode button at the
bottom of the Timeline.

. Select Tools > Command Palette.

. Click the CC tab.

. Select Active Palette.

. Click the Tab button with which the group or subdividing tab is associated.

In the Color Correction tool, the tab is highlighted, the tab moves to the front, and the
specific controls for the tab appear.

143



Chapter 4 Understanding Color Correction Mode

You can also map the Tab buttons to any mappable key on your keyboard or to any mappable
button location in the user interface. For more information, see “Using the Command
Palette” in the Help.

Understanding Interaction Between Color Correction Groups

144

Understanding how the color correction groups work together is important. Adjustments
made in each group are applied cumulatively to the current segment and its related material.
If you make an adjustment in one group and then go on to make another adjustment in a
different group, the image shows the cumulative effect of both adjustments.

This behavior provides you with a great deal of flexibility. For example, you can use one
group of controls to make relatively broad initial adjustments and then switch to another
group to fine-tune your correction. If you are unhappy with some of your finer adjustments,
you can disable that group or reset its controls to default settings without disrupting the
initial group.

The following illustration shows an example of this kind of control over color correction
groups.

Enable button for Enable button for Curves
HSL tab is turned on. tab is turned off.

The Green and Blue curves are adjusted, but the Curves tab is turned off. The Curves tab
adjustments are not currently applied to the segment. Adjustments made in the HSL tab
are applied to the segment because the HSL tab is turned on, even though the HSL
controls are not currently visible.

In effect, you have up to five layers of correction available for a Source correction, and
potentially another five if you also apply a Program correction to the same segment. For
more information on enabling, disabling, and resetting the groups, see “Working with the
Enable Buttons” on page 145.
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If you make adjustments in multiple groups, keep in mind how the cumulative adjustments
will affect the final image. Adjustments might accumulate, or cancel each other out, in ways
that you do not want. Keep each stage of your correction distinct, and do not duplicate the
same adjustment in more than one group.

Working with the Enable Buttons

Each group tab in the Color Correction tool, each subdividing tab and individual control
within each group, and each color vector within the Secondary groups has an Enable button.
These buttons provide an immediate visual guide to the status of the controls while you are
making corrections. They also allow you to turn controls on and off in various combinations
and quickly reset controls to their default values.

Turning Controls On or Off

To turn on a control or tabbed group of controls, do one of the following:
p  Click the Enable button for the control or tabbed group of controls.
»  Adjust any individual control that is linked to the Enable button.

The Enable button changes to pink, and the control or tabbed group of controls becomes
active. Symphony Nitris includes the adjustments in that control or group of controls
when calculating the corrected color.

To turn off a control or tab:

»  Click the Enable button for the control or tab.

The Enable button changes to gray.

Resetting Controls

To reset a control or a tabbed group of controls to its default values:
1. Display the control or group of controls you want to reset.
2. Alt+click the Enable button for that control or group of controls.
The Enable button changes to gray, and all controls linked to that button return to their

default values.

You cannot reset controls not currently displayed. If you Alt+click the Enable button for a
tab whose controls are not currently displayed, you display the controls but do not reset
them. Alt+click the button again to reset the controls.

145



Chapter 4 Understanding Color Correction Mode

Understanding Interaction Between Enable Buttons
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The Enable buttons are linked in a hierarchical relationship that mirrors the relationship of
the tabs themselves. When you change the status of an Enable button, the change can affect
several levels of the hierarchy.

When you turn on an individual control, for example, you automatically turn on all related
Enable buttons at higher levels in the hierarchy. By enabling an individual slider in the HSL
group, you enable not only the button for that slider but also the buttons for all the associated
tabs, up to and including the HSL group tab itself.

When the Enable button for the Hue
slider is turned on, the Master tab,
Controls tab, and HSL tab Enable
buttons are also turned on.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version available from the Online Library for your application.

When you Alt+click an Enable button to reset controls, you automatically reset all controls

at a lower level in the hierarchy. For example, if you Alt+click the Enable button for the Red
curve in the Curves tab, only that one control will reset to its default value. However, if you
Alt+click the Enable button for the Curves tab, all the controls in the Curves tab will reset to
their default values.
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When you turn off an Enable button, the system stops including controls below that button in
the hierarchy when it calculates the corrected color for the segment. Individual controls
below that button retain their values and can be reactivated at any time. Their Enable buttons
remain pink.

A small number of controls in the Color Correction tool appear in more than one tab as a
convenience for users who prefer to remain in a single tab whenever possible, but their
enable behavior remains tied to the tab that is their primary home. For example, several
HSL slider controls also appear in the Curves tab. If you adjust one of these sliders in the
Curves tab, you turn on the Enable buttons for the HSL > Controls > Master tab hierarchy.

The Curves tab Enable button is
turned off, so none of the
adjustments in the Curves tab are
applied to the correction. Individual
controls inside the tab retain their
values and can be reactivated by
clicking the Curves tab again.

Using the Color Correction Tool Buttons

In addition to the Enable buttons, and specific control buttons within groups, the Color
Correction tool has a group of buttons on the right side that control several important
operations.

Color Correction Effect Template button =~ Comments button

Correction Mode Settings button  Safe Color Settings button
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Use these buttons to:
»  Create Color Correction effect templates.

For more information, see “Working with Color Correction Effect Templates™ on
page 154.

*  Customize the Color Correction tool.

For more information, see “Customizing Color Correction Settings” on page 148.
*  Set Safe Color limit values.

For more information, see “Safe Colors" on page 301.
* Add comments to color-corrected segments.

For more information, see “Adding Comments to Color Correction Effects” on
page 152.

Customizing Color Correction Settings

You can customize the appearance and behavior of the Color Correction tool in a variety of
ways by selecting options in the Correction Mode Settings dialog box. For example, you can
control which of the group tabs display, allowing you to remove from the tool any group that
you do not normally use.
To customize the Color Correction tool:
1. Do one of the following:
B » In the Color Correction tool, click the Correction Mode Settings button.

» In the Project window, click the Settings tab, and then double-click Correction in
the Settings scroll list.

The Correction Mode Settings dialog box opens.

The table following this procedure describes the options available in the Correction
Mode Settings dialog box.

2. Click one of the tabs, and then select the options you want.
3. Repeat step 2 until you are satisfied with all settings.
4. Click OK.
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Correction Mode Settings Options

Tab Option Description
Tabs « HSL Define which group tabs appear in the Color Correction tool. Select the
«  Channels groups that you want to display in the Source tab.
* Levels
*  Curves
* Secondary
Units RGB: For each type of color adjustment, select an item from the menu to
. 10Bit define the unit of measurement used for that adjustment type in the
Color Correction tool. The following units of measurement are
+ 8Bit available in one or more of the menus:
Percent 10 Bit —Measures the adjustment on a scale from 0 to 1024.
 IRE 8 Bit — Measures the adjustment on a scale from 0 to 255.
*  mVolts % The RGB value for a color in the Color Correction tool will not
Hue: be identical to the RGB value for the same color in a graphics
) application such as Adobe Photoshop®™. For example, the 10-bit
* 8Bit RGB values for reference black and reference white are 288 and
+  Degree 7206 respectively. The 8-bit RGB values for reference black and
. . reference white are 16 and 235 respectively.
Saturation/Gain:
. The 10-bit and 8-bit options for RGB units provide different
© 8Bit measurement scales for the adjustment, but do not change the
* Percent degree of precision with which the correction is made. For more
Luma: information, see “How Color Correction Handles Color Space
’ and Bit Depth” on page 152.
+ 8Bit .
! Percent — Measures the adjustment on a percentage scale from 0 to
* Percent 100.
« IRE IRE — Measures the adjustment in IRE units.
* mVolts mVolts — Measures the adjustment in millivolts.
Composite: Degree — Measures the adjustment on a scale of degrees that represent
« IRE a position on the color wheel. 0/360 represents the existing hue; 180
represents the opposite hue on the wheel (inverts the hue).
*  mVolts
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Correction Mode Settings Options (Continued)

Tab

Option

Description

Levels

150

Solid Histograms

Color Histograms

Dynamic Histograms

Use Full Ranges

When this option is selected, the histograms in the Levels tab of the
Color Correction tool display as solid forms. When this option is
deselected, the histograms display as a line graph.

Solid histogram selected Solid histogram deselected

When this option is selected, histograms that represent a single color
channel display in the color of that channel. For example, histograms in
the Red tab display in red.

When this option is selected, the histograms update on-the-fly as you
move other controls such as triangular sliders and control points on the
Curve graph. This provides instant feedback on your adjustments, but
the updating process might not always be smooth due to system
processing limitations.

When this option is deselected, the histograms do not update until you
release the controls you are adjusting.

When this option is selected, some histograms redraw to display the full
10-bit range of level values on the horizontal axis. The option applies to
the Red, Green, Blue, and Master histograms. You then have additional
headroom and footroom available for making adjustments beyond the
normal range of values.

This is sometimes useful when dealing with extreme color deficiencies
in analog video material, such as very low RGB levels. It is not usually
necessary to use full ranges with digital material since digital video has
built-in headroom and footroom limits.
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Correction Mode Settings Options (Continued)

Tab

Option

Description

Features

Secondary Vectors:
+ Show All

» Show Standard
*  Show Custom

¢ Show Enabled

Saved Color Labels:
*  None

+ RGB

* Name

e Name and RGB

Use Marks for
Segment Correction

Eyedropper 3 x 3
Averaging

Show Eyedropper Info

Eyedropper Picks from
Anywhere in
Application

Controls which color vectors appear on the input vector color wheel in
the Secondary group. For more information and illustrations of these
options, see “Customizing a Vector Display” on page 238.

Select an item from the menu to control how custom colors are named
in bins. For information on saving custom colors, see “Saving Custom
Colors to a Bin” on page 181.

When None is selected, the system does not supply a name.

When RGB is selected, the system uses the 8-bit values for the red,
green, and blue components as the name.

When Name is selected, the system uses the name from the standard
HTML color scheme that most closely matches the color you are
saving.

When Name and RGB is selected, the system uses both the Name and
the RGB information as the name. This is the default option.

When this option is selected, the system applies either Source Segment
or Program Segment color correction to all segments between marked
IN and OUT points. If the IN and OUT points are in the middle of
segments, the system includes the whole segments when it makes the
correction.

This option is deselected by default.

When this option is selected, the system calculates the color value to
pick by averaging the values of a 3 x 3 sample of pixels centered on the
eyedropper’s position. This is often useful for picking up a color
accurately by sight because it compensates for shifts in color value from
one pixel to another. When this option is deselected, the system selects
the color value of the exact pixel at the eyedropper’s position.

When this option is selected, the numerical RGB values appear on the
color swatches in the Color Match controls.

When this option is selected, the eyedropper can pick a color from
anywhere within the Symphony Nitris interface, for example the swatch
for a custom color in a bin.
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Correction Mode Settings Options (Continued)

Tab

Option Description

Show ChromaWheel and When this option is selected, the system displays color backgrounds for
ChromaCurve Graphs  the ChromaWheels in the Hue Offsets tab of the HSL group and for the
ChromaCurve graphs in the Curves tab. These backgrounds can make it
easier to understand the effect that an adjustment will have on an image.

When this option is deselected (the default option), the system does not
display the color backgrounds. You might prefer to use this option when
you are working since it allows you to assess color in your video images
without interference from other brightly colored on-screen elements.

AutoCorrect Contains three menus for defining the automatic color corrections that

are made when you apply the Color Correction effect from the Effect
Palette. For information on the options available in the AutoCorrect tab
of the Correction Mode Settings dialog box, see “Setting AutoCorrect
Options” on page 166.

How Color Correction Handles Color Space and Bit Depth

When Symphony Nitris makes some color correction adjustments, it converts the YCbCr
color information in the media stored on disk into RGB color information (a better format
for many color corrections) and then converts the information back to the original format for
playback and storage. This round-trip conversion takes the color information from an 8-bit
or 10-bit YCbCr color space into a 12-bit RGB color space and then back to 8-bit or 10-bit
YCbCr. The 12-bit RGB color space that the system uses is designed to preserve color
information as fully as possible during this process. Clipping of the original color values is
virtually eliminated, and round-off errors from the two conversions are minimized.

The options for measuring units available in the Correction Mode Settings dialog box are a
convenience that allows you to make adjustments using the units that are most useful or
familiar to you. When the system makes the color correction adjustments, it always uses the
12-bit RGB color space and always works with the same degree of accuracy.

Adding Comments to Color Correction Effects
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You can add comments to color-corrected segments to assist you in your work. For example,
you might want to briefly note the type of adjustment you made to a segment or to make
notes during a Source correction pass of ideas for adjustments to be done later during a
Program pass. You can display these comments in the Timeline as well as in the Comments
dialog box.
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The Comments button also indicates whether a comment is present on a segment.

If the position indicator is on a segment that has a comment, the icon on the Comments
button is yellow.

If the position indicator is on a segment that has no comment, the icon on the Comments
button is not yellow.

To add a comment to a segment:

1.

If you are not in Color Correction mode, click the Color Correction Mode button below
the Timeline.

. Move the position indicator to the segment to which you want to add a comment.

Click the Comments button in the Color Correction tool.

The Comments dialog box opens.

_ Comments x|
*
¥

Remove | QK | Cancel ||7

4. Type your comment in the text window, and click OK.

To remove a comment:

1.

If you are not in Color Correction mode, click the Color Correction Mode button below
the Timeline.

Move the position indicator to the segment from which you want to remove the
comment.

Click the Comments button in the Color Correction tool.
The Comments dialog box opens.

Click Remove.
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To view or edit a comment in the Comments dialog box:

1. In Color Correction mode, move the position indicator to the segment for which you
want to view the comment.

2. Click the Comments button in the Color Correction tool.
The Comments dialog box opens and displays the text of the comment.
3. (Option) To edit the comment, click in the text window and make your edits using
standard word processing procedures.
To display comments in the Timeline:
» Click the Timeline Fast Menu button, and select Clip Text > Comments.

Your Color Correction comments appear in the Timeline.

Working with Color Correction Effect Templates

Color Correction mode offers several versions of Color Correction effect templates.

*  The Automatic Effect Templates feature saves recent corrections automatically and lists
them in the Effect Palette.

*  The Color Correction buckets provide an easily accessible location within the Color
Correction tool for the short-term storage of Color Correction effect templates.

e The Color Correction Effect Template button allows you to create a template for any
color correction and save it to a bin in the same way that you save other kinds of
Symphony effect templates. The Save Correction button in the CC tab of the Command
palette performs the same function.

Like templates for other effects, Color Correction effect templates save all the adjustment
values for a color correction so that you can apply those values quickly to another segment.
You can apply all the values at once by clicking the template icon in the bin or in the Effect
Palette, and dragging it into the monitor containing the current segment, or you can apply the
values for the controls in a single tab in the Color Correction tool by clicking the template
icon and dragging it to the tab that contains the group of controls you want to change.

You can also save custom colors to bins. For more information, see “Saving Custom Colors
to a Bin” on page 181.
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Understanding How Color Correction Effect Templates Save Settings

mm

When you create a Color Correction effect template, the system saves all the Color
Correction settings for the segment. This is true whether the template is created
automatically by the system or manually by saving to a bin or a bucket. The system
remembers both the values set for each control and the status of each Enable button.

Automatic templates update when you make new adjustments on the same segment. For
example, when you have made only a single adjustment, the template contains the value of
that adjustment. If you make another Source side adjustment to the same clip, the template
updates to include the value of the new adjustment. In contrast, templates saved to a bin or a
bucket do not update when you make new adjustments to the segment. To save the new
adjustments you must save a new template to a bin or a bucket.

If you make multiple corrections on the same segment, for example a Source correction and
a Program correction, the template includes all those adjustments. When you apply the
template globally by dragging it into the active monitor, you apply all corrections that the
template includes.

Since this behavior might lead to confusing results, it reinforces the need in most
circumstances to keep Source and Program color corrections completely separate. In
general, you should use Program corrections only for final adjustments, which are often
made across a whole track. For more information on keeping Source and Program
corrections separate, see the note at the end of “General Workflow for Making Color
Corrections” on page 163.

Remember that you can specify which settings you apply in a template by dragging the
template to the active tab in the Color Correction tool. This changes only those settings
contained within that tab.

If you make a Source color correction on a clip and then make a Program correction, the
system saves a second template in the Effect Palette list. This second template is a duplicate.
The two templates are identical in the information they contain — each contains both the
Source and the Program information — and applying either to a new segment will apply all
the saved information.
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Using Automatic Effect Templates

Effect categories

Bin that contains
saved effects

Color-corrected ——

Symphony Nitris saves the most recent color corrections made in a sequence (up to a limit of
16 corrections) and makes them available in the Effect Palette. This provides you with
automatically created templates for all your most recent corrections. You can quickly apply
any one of these templates to another segment in the sequence by dragging it or simply by
highlighting it in the Effect Palette and pressing Enter.

The Effect Palette lists all color-corrected sequences that are loaded in the Record monitor at
the bottom of the scrollable list of effect categories. The effect categories list might therefore
contain effect categories, bins that contain saved effects, and color-corrected sequences.

The following illustration shows an effect categories list containing all three of these items.

= Newest correction

2 ;[ Telephone poles
3 [ Prairie landscape )
4 .[@] CL happy farmer Oldest correction

Apress 30 Effect

TutorizlSelects Bin

sequences in the
Record monitor
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When you select a color-corrected sequence in the effect categories list of the Effect Palette,
a list of templates for the most recent corrections made to that sequence appears in the right
side of the Effect Palette.

Each template is named using either the clip name of the segment on which it was originally
made or, if a comment is associated with that segment, the text of the comment. For more
information on comments, see “Adding Comments to Color Correction Effects” on

page 152.

The templates are ordered in the Effect Palette based on the time at which they were created,
with the most recently created template at the top of the list. The templates are also
numbered to indicate the order of their creation, with the most recently created template
always numbered “1.”

The list is limited to the 16 most recent corrections. If the list already contains 16 templates,
the system removes the oldest template from the list when you make a new correction.
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Saving a Color Correction Effect Template to a Bin

You can save a color correction template to a bin using either the Color Correction Effect
Template button in the Color Correction tool or the Save Correction button in the CC tab of
the Command palette.

Color correction templates saved to a bin are saved permanently, unlike templates saved to a
bucket, which are not saved beyond the current working session, or automatic templates,
which are deleted when you have made 16 more recent corrections.

To save a Color Correction effect template to a bin:

1. In Color Correction mode, make sure that the position indicator is in the segment that
contains the settings you want to save.

2. Do one of the following:
p  Click the Color Correction Effect Template button, and drag the effect icon to a bin.
P With Active Palette selected in the Command palette, click the Save Correction
button in the CC tab.
p Ifthe Save Correction button is mapped to a key, press that key.

A new effect template appears in the bin, containing all the color correction adjustment
values for the segment. The new effect template is identified in the bin by its effect icon.
By default, Symphony Nitris names the template using the clip name of the segment.
Effect icons for open bins are also displayed in the Effect Palette.

3. (Option) To rename the template, click the template name and type a new name.

EjcCTemplates SEES

Text

Marme Creation Date

CU happy farmer(Program CC) OFM 202005121515
Prairie landscape(Source CC) 07202005 121418
Dezat with AutoContrast 071252005 12:14:06

To permanently save a color correction effect template currently stored in a bucket:
P Click the color correction icon in the bucket’s icon holder and drag it to a bin.

For more information, see “Saving a Color Correction Effect Template to a Bucket” on
page 158.
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Saving a Color Correction Effect Template to a Bucket

The Color Correction tool provides four buckets, located below the Color Match control, that
you can use to save Color Correction effect templates for the duration of a working session.
You can then apply the template quickly to any segment. The buckets are labeled C1
through C4.

The Color Correction buckets are also available as buttons in the CC tab of the Command
Palette. You can map these buttons to any mappable key on your keyboard or to any
mappable button location in the user interface. For more information, see “Using the
Command Palette” in the Help.

The following illustration shows the Color Correction buckets.

Icon holders

Buckets

To save a Color Correction effect template in a bucket:

1. In Color Correction mode, make sure that the position indicator is in the segment that
contains the adjustment values you want to save.

2. Alt+click the bucket in which you want to save the template.

3. Select a bucket from the range C1 to C4. Empty buckets have a blank icon holder above
them. If you Alt+click a bucket that already contains a template, you overwrite the
previous template with the new adjustment values.If you Alt+click (Windows) or
Option+click (Macintosh) a bucket that already contains a template, you overwrite the
previous template with the new adjustment values.

The values are saved as a template, and a Color Correction icon appears in the icon
holder above the Color Correction bucket.

Clearing Color Correction Effect Templates from Buckets
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Color correction effect templates that are saved to buckets do not persist from one editing
session to another. When you quit Symphony Nitris, the templates are deleted. To save a
color correction effect permanently, you should always save it to a bin. For more
information, see “Saving a Color Correction Effect Template to a Bin” on page 157.
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To clear a Color Correction bucket of its saved correction during an editing session:

P  Move the position indicator to any uncorrected segment in the Timeline and then
Alt+click the bucket.

Applying Color Correction Effect Templates

mm

To apply all adjustment values in a Color Correction effect template to the current
segment, do one of the following in Color Correction mode:

P Click the effect icon for the template in the bin, the Effect Palette, or the Color
Correction bucket icon holder, and drag it to the monitor containing the current segment
or to the segment in the Timeline.

For tips on working with templates in the Effect Palette, see “Saving a Color Correction
Effect Template to a Bin” on page 157.

P Select the template in the bin or the Effect Palette, and then press Enter.
Click the appropriate Color Correction bucket (for example, C1).

» If you have mapped the Color Correction bucket to the keyboard, press the appropriate
key.

The system applies all the Color Correction adjustments in the template to the segment
that is the current location of the position indicator.

To apply adjustment values from a Color Correction effect template selectively to a
single tab of color correction controls:

1. In the Color Correction tool, click the tab to which you want to apply the template.

2. Click the effect icon for the template in the bin, the Effect Palette, or the Color
Correction bucket, drag it to the tab, and drop it anywhere in the tab.

The controls in that tab update to reflect the values in the template. Other color
correction controls are not affected.

If you apply template settings to a subdividing tab (for example, the Controls tab in the HSL
group), the image in the monitor does not reflect those settings until you enable the group
tab (for example, the HSL tab).

If you apply a saved Color Correction effect template to a segment that already has a color
correction, you overwrite the existing correction. The existing Color Correction settings are
lost. If the existing correction is itself saved as a template, the template might also be lost
(depending on the scope of the existing correction). Make sure that you want to replace the
existing correction before you apply a saved Color Correction effect template to a clip that
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already has a correction. You can use the Undo command to undo the effect of a Color
Correction effect template. However, once the Undo command is no longer available, you
cannot recover the original Color Correction settings.

Working with Color Correction Effect Templates in the Effect Palette
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The following list of reminders and suggestions can help you work quickly when you are
using saved Color Correction effect templates in the Effect Palette.

*  Press Ctrl+8 to open the Effect Palette or to make the Effect Palette active.

The Effect Palette becomes inactive whenever you perform an action in another area of
the interface (for example, when you move the position indicator in the Timeline).
Pressing Ctrl+8 is a quick keyboard method for reactivating the Effect Palette. The
Effect Palette must be active before you can use it to apply a Color Correction

effect template.

»  Use the Tab key to make one side or the other of the Effect Palette active.

For example, if the effect categories list on the left side of the Effect Palette is active,
press the Tab key to activate the list of templates on the right side. Press the Tab key
again to activate the effect categories list. Clicking a specific item in either list also
activates that side of the Effect Palette.

» To display a group of effect templates in the Effect Palette, select the bin or the color-
corrected sequence that contains the templates in the effect categories list on the left side
of the palette.

*  Use the Up Arrow and Down Arrow keys to move through the active list.

For example, you can quickly move from the most recent correction to the third most
recent in the list by pressing the Down Arrow key twice.

*  The Effect Palette remembers the currently selected item in the list of corrections even
when it becomes inactive or is closed.

For example, if you have the most recent correction in the list selected and then leave the
Effect Palette to perform another operation or close the Effect Palette, that correction is
the selected correction when you reactivate or reopen the Effect Palette.

This makes it easy to apply the same template successively to a number of segments,
especially if you have navigation buttons such as Fast Forward, Rewind, Go to Next
Uncorrected Shot, and Go to Previous Uncorrected Shot mapped to the keyboard. Once
you have the template you want selected in the Effect Palette, you simply navigate to
another segment, press Ctrl+8 to activate the Effect Palette, and then press Enter to
apply the template.
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Displaying Color Correction Information in the
Timeline

The Timeline works the same way in Color Correction mode as it does in other modes. You
can move the position indicator from one place to another in your sequence, select and
deselect tracks, and perform other normal Timeline operations.

The only control in the Timeline that is specific to color correction is the Color Correction
option in the Timeline Fast menu. When you select Color Correction, the Timeline displays
indicator lines to show which segments have relationship color corrections.

A segment that has Source color correction is marked with a green line at the bottom of the
segment; a segment that has Program color correction is marked with a blue line at the top of
the segment. The appearance of the indicator line indicates the relationship that applies to
the correction on that segment. A dotted line indicates a correction that applies only to that
segment (Source Segment or Program Segment relationship); a solid line indicates a
correction that applies beyond the individual segment (Source Tape, Source Clip Name,
Master Clip, Sub Clip, or Program Track).

Color Correction is available in the Timeline in all modes, but it might be most useful while
you are working in Color Correction mode as a guide to which segments have already
received either Source or Program adjustment.

As effects that normally play in real time, all relationship color corrections appear with
green dots in the Timeline unless they have been rendered. These dots continue to display in
the Timeline even if the Color Correction option is dselected in the Timeline Fast menu.

To display color correction information in the Timeline:

p  Click the Timeline Fast Menu button, and select Color Correction.

The Timeline display updates to show the color correction indicator lines.

Blue lines indicate Green lines indicate
Program color corrections. Source color corrections.
Car passing sign & Prairie Ia.dscaﬂ TeIeEhona;Eoles I CU happy farmer ) l | Car LS down raad Car drives into sunzat
T u T |l—!_
(2826 00;00;33:26 00;00;38;26 00;00;33 26 00004226 00,005

Telephonespoles CU happy farmer &

Dotted line indicates that the correction  Solid line indicates that the correction
applies to this segment only. applies beyond this individual segment.

161



Chapter 4 Understanding Color Correction Mode

162



Chapter 5
Performing Color Corrections

This chapter describes procedures for making color corrections and provides a complete
explanation of all the individual controls in the Color Correction tool and how to use them.

This chapter contains the following main sections:

General Workflow for Making Color Corrections

Using Automatic Color Corrections

Using the Color Match Control

The HSL (Hue, Saturation, Luminance) Group

The Channels Group

The Levels Group

The Curves Group

The Secondary Group

Working with the Waveform Monitors and the Vectorscope Monitor

Using the Color Correction Effect

General Workflow for Making Color Corrections

The Color Correction tool gives you a great deal of flexibility when you make color
corrections. The exact workflow that you employ depends on your individual methods, your
degree of familiarity with the color correction controls, and the requirements of your project.
However, the basic steps to take when making a correction will be similar for all users.

The following procedure outlines a typical color correction operation. You can adapt the
exact order in which steps are performed or repeated to conform to your particular needs.
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To color correct a sequence:
1. In Source/Record mode, load the sequence into a monitor.

2. Click the Color Correction Mode button below the Timeline to enter Color Correction

mode.

. (Option) If necessary, configure the Color Correction mode display so that it conforms

to the requirements of your project and editing style. For more information on the
display and how to configure it, see “Color Correction Mode Basics” in the Help and
“Understanding Color Correction Mode” on page 127.

. Preview the material in the sequence to develop a sense of the kinds of corrections that

are needed and the approach you will use to make them.

For example, you might look for a shot that you would like to use as a reference for your
adjustments and lock that shot in one of the monitors. You might also make decisions
about the Source or Program relationships that you want to use as you work. For general
guidance on what to look for when previewing material, see “Color Correction
Techniques” on page 279.

You might prefer to preview extensively and plan your corrections in advance. If you have
more color correcting experience, you might work by moving back and forth frequently
between making corrections and assessing the material on which you are working.

5. Make sure that the Record Track button for the track on which you want to make

corrections is the topmost selected button in the Track Selector panel in the Timeline.

You can color correct any number of tracks, including nested tracks by stepping into the
nest. However, you can correct only one track at a time. Color correction is applied to
the topmost selected track in a sequence.

. Use the Composer Window buttons or the position indicator in the Timeline to move to

a segment you want to correct.

. Select a relationship to control the scope of the corrections, or choose to apply a Color

Correction effect correction.

Depending on your circumstances, you might use the same relationship throughout the
sequence, or you might select different relationships for different segments. For more
information, see “Working with Correction Types” on page 136.

. Click the appropriate tabs in the Color Correction tool to display the controls you want

to use to make the correction.

For more information, see “Working with the Group and Subdividing Tabs” on
page 140.
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9. Adjust the controls until you are satisfied with the correction.

Remember that you can repeat steps 7 and 8 to make successive adjustments using
several different groups of controls and to selectively turn them on and off while you
assess their effect on the segment. You can use the Dual Split button in the monitors to
view corrected and uncorrected images side by side.

10. (Option) Add a comment for the correction.
11. Repeat steps 5 through 10 for each segment you want to correct.

12. When you are satisfied with the corrections throughout the sequence, click one of the
mode buttons (Source/Record, Trim, or Effect) or make a selection from the Toolset
menu to exit Color Correction mode and return to other editing operations.

In general, you should not attempt to make Source relationship corrections and Program
relationship corrections as part of the same corrective operation or to use Program
corrections for your first color correcting pass. If you do so, you lose flexibility and control
for later stages of your project and you reduce the power of the Color Correction tool. Even
if you expect to need only one color correction pass (and could use Program relationships
for that pass), you should make that pass using Source relationships. If your needs for the
project change, you will still be able to make a second set of corrections using Program
relationships.

m BEE

Using Automatic Color Corrections

Both color correction groups include buttons that allow you to make automatic color
corrections to correct contrast problems, balance color, or remove color casts by identifying
areas of an image that should be color neutral.

You can also apply up to three automatic color corrections in a single operation by selecting
options in the AutoCorrect tab of the Correction Mode Settings dialog box and applying the
Color Correction effect from the Effect Palette to one or more segments in a sequence. For
more information, see “Correcting Color Automatically Using the Color Correction Effect”
in the Help and “Setting AutoCorrect Options” on page 166.

The Color Match control also corrects automatically by adjusting an image so that a poor
color value matches a better one. You select the colors on which you want Color Match to
operate using an eyedropper. For more information, see “Using the Color Match Control” on
page 173.
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Understanding Automatic Color Correction

Automatic color correction simplifies the work of correcting common color problems in
video images. When you use one of the automatic color corrections, Symphony Nitris
analyzes the existing color characteristics of an image and makes adjustments to color
correction controls that usually eliminate or at least significantly reduce a specific color
problem.

You will often want to begin your color correction work by using automatic color
corrections, especially if you do not have time for detailed manual adjustments, if you only
need to correct basic color problems such as color casts, or if you lack experience with the
manual controls in the Color Correction tool.

Since automatic color correction adjusts controls in the Color Correction tool just as you
would when making manual corrections, you are always free to make additional adjustments
manually if you need to fine-tune the correction. Also, automatic color corrections can help
you learn how to recognize color problems in images and what kinds of adjustments you
might make to correct images manually. For example, if the Auto Balance automatic
correction in the Hue Offsets subdividing tab adjusts an image by adding yellow in the
ChromaWheels, then the analysis of that image revealed a blue color cast.

Automatic color corrections operate within normal limits for legal video levels. For
example, an automatic color correction does not make an adjustment that takes a significant
area of an image beyond legal luminance levels.

Setting AutoCorrect Options
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You control how Avid Color Correction makes automatic corrections when you apply the
Color Correction effect from the Effect Palette by choosing options in the AutoCorrect tab of
the Correction Mode Settings dialog box.

For information on applying the Color Correction effect from the Effect Palette, see
“Correcting Color Automatically Using the Color Correction Effect” in the Help.
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To set AutoCorrect options:
1. Do one of the following:
» In the Settings tab of the Project window, double-click Correction.
»  In the Color Correction window, click the Correction Mode Settings button.

The Correction Mode Settings dialog box appears.

First Correction menu

Second Correction menu

Third Correction menu

2. Click the AutoCorrect tab.

3. Select an option from each of the three menus to define the first, second, and third
automatic color correction that Avid Color Correction makes when you apply the Color
Correction effect from the Effect Palette.

The following table describes the available options in each of the menus.

For information to help you to decide on the best order for these corrections, see
“Considerations When Using Automatic Color Correction” on page 172.
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AutoCorrect Options

Option

Description

Nothing

HSL Auto Balance

HSL Auto Black

HSL Auto Contrast

HSL Auto White

Curves Auto Balance

Curves Auto Contrast

Makes no adjustment. For example, if you only want to make two automatic
corrections when you drag the Color Correction effect from the Effect
Palette, set the Third Correction menu in the AutoCorrect tab to Nothing.

Makes adjustments to the three ChromaWheels to balance the colors in the
image. The equivalent of clicking the Auto Balance button in the Hue Offsets
subdividing tab of the HSL tab.

Adjusts the Setup slider in the Hue Offsets subdividing tab of the HSL tab to
make the darkest areas of the image as dark as possible. The equivalent of
clicking the Auto Black button in the Hue Offsets subdividing tab of the HSL
tab.

Adjusts the Gain and Setup sliders in the Hue Offsets subdividing tab of the
HSL tab to maximize the tonal range in the image. The equivalent of clicking
the Auto Contrast button in the Hue Offsets subdividing tab of the HSL tab.

Adjusts the Gain slider in the Hue Offsets subdividing tab of the HSL tab to
make the brightest areas of the image as bright as possible. The equivalent of
clicking the Auto White button in the Hue Offsets subdividing tab of the
HSL tab.

Makes adjustments to the Red, Green, and Blue curves to balance the colors
in the image. The equivalent of clicking the Auto Balance button in the
Curves tab.

Makes an adjustment to the Master curve to maximize the tonal range in the
image. The equivalent of clicking the Auto Contrast button in the Curves tab.

Adjusting Contrast and Balance Automatically
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You can adjust the contrast and balance the color automatically for an image simply by
clicking buttons. An automatic contrast adjustment expands the tonal range of the image,
which usually improves sharpness and detail. An automatic balance adjustment evens out
the influence of the different color channels in the image, which usually greatly reduces or
even eliminates any color cast.
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Automatic contrast and balance buttons appear in the Color Correction tool in the following
locations:

»  The HSL > Controls > Master tab, as shown in the following illustration:

Auto White button
Auto Black button Auto Contrast button

*  The HSL > Hue Offsets tab, as shown in the following illustration:

Auto Balance Auto White button
button

Auto Black button  Auto Contrast button

*  The Curves tab, as shown in the following illustration:

Auto Contrast button

Auto Balance button

For information on correcting contrast or balance automatically in the Hue Offsets
subdividing tab, see “Correcting Color Automatically in the Hue Offsets Tab” in the Help.
To make an automatic contrast or balance adjustment in the Curves tab:

1. Enter Color Correction mode, for example, by selecting Toolset > Color Correction.

2. In the Timeline, make sure that the Record Track button for the video track on which
you want to make corrections is the topmost selected track.

3. In the Timeline or in the Composer window, navigate to the segment you want to
correct.

4. In the Curves tab of the Color Correction tool, click either the AutoBalance or the
AutoContrast button, as described in the following table.

The system analyzes the currently selected frame in the segment and adjusts the
appropriate color correction controls.
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Automatic Color Correction Buttons in the Curves Tab

Location in Color

Button Correction Tool Description
Auto Balance Curves tab Makes adjustments to the Red, Green, and Blue curves to balance the
colors in the image. This eliminates any color cast for most images.
+
L
Auto Contrast Curves tab Makes an adjustment to the Master curve to maximize the tonal range in
_ the image. The brightest areas of the image and made as bright as
& possible and the darkest areas of the image are made as dark as possible.

Using the Remove Color Cast Buttons

You can remove a color cast automatically by clicking a Remove Color Cast button and
using an eyedropper to identify an area in your image that you want to be color neutral
(white, black, or a shade of gray). Symphony Nitris analyzes the current color characteristics
of the area you have selected and then adjusts color correction controls to make that area
color neutral.

Remove Color Cast buttons provide more precise control over color cast removal than Auto
Balance buttons because their adjustments are limited either by luminance range or by the
impact that they have on existing curve graphs. However, Remove Color Cast buttons are
only useful when you are working with an image that has areas that should be color neutral.

Remove Color Cast buttons appear in the Color Correction tool in the following locations:

*  Below each of the three ChromaWheels in the Hue Offsets subdividing tab of the HSL
tab, as shown in the following illustration:

-Huel 0.00 | 0.00 mi—l— Remove Color Cast button

* In the Curves tab, as shown in the following illustration:

ﬁ’ﬂ-ﬁ-

Remove Color Cast button
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Each ChromaWheel Remove Color Cast button is associated with the wheel above it.
Adjustments are made only to that wheel; only the parts of the image that fall within the
luminance range controlled by that wheel are changed. You choose which ChromaWheel to
adjust based on the luminance level of the area you want to identify, as follows:

»  To make white or light gray areas of an image color neutral and remove a cast
throughout the lightest part of the image, use the Remove Color Cast button below the
Highlights ChromaWheel.

*  To make mid-gray areas of an image color neutral and remove a cast throughout the
midtones of the image, use the Remove Color Cast button below the Midtones
ChromaWheel.

» To make black or dark gray areas of an image color neutral and remove a cast
throughout the darkest parts of the image, use the Remove Color Cast button below the
Shadows ChromaWheel.

The Curves tab Remove Color Cast button works by adding a point to each of the Red,
Green, and Blue curves that makes the area you identify with the eyedropper color neutral.
You can use the Curves tab Remove Color Cast button repeatedly to identify multiple areas
that you want to be color neutral. Each new use adds another point to each of the three
curves. (You can add new points up to the 16-point limit, although once several points are
distributed along the curve, further points are unlikely to improve the image significantly.)

The effect of each added point on the image as a whole varies depending on the shape of the
entire curve. In general, each new point affects the image most in areas with similar
luminance values to the area you identify with the eyedropper, and affects the image least in
areas with very different luminance values.
To use a Remove Color Cast button:

1. Enter Color Correction mode, for example, by selecting Toolset > Color Correction.

2. In the Timeline, make sure that the Record Track button for the video track on which
you want to make corrections is the topmost selected track.

3. In the Timeline or in the Composer window, navigate to the segment you want to
correct.

4. Do one of the following:

P  Click the Remove Color Cast button below a ChromaWheel in the Hue Offsets
subdividing tab of the HSL tab.

P  Click the Remove Color Cast button in the Curves tab.
The button appears highlighted.

171



Chapter 5 Performing Color Corrections

5. Drag the pointer into the image.

The pointer changes to an eyedropper.

6. Continue to drag the eyedropper until it is over the part of the image you want to

become color neutral, and then release the mouse button.

Avid Color Correction analyzes the part of the image you have identified and adjusts the
controls to remove the color cast.

Considerations When Using Automatic Color Correction

Although automatic color corrections are much simpler to learn and perform than manual
corrections, practice and experience will still improve your ability to correct a range of
images with different color characteristics. If one set of automatic corrections does not
produce good results, remove it and try a different combination. Remember also that some
images might require manual correction in addition to or instead of automatic correction.

The following tips and suggestions will help you to achieve the best possible results when
using automatic color correction:
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The Auto Contrast correction is most useful for images that should have areas of strong
highlight (white or close to white) as well as areas of strong shadow (black or close to
black). If you make an Auto Contrast correction on an image that should not have such a
full tonal range (many close-ups fall into this category), the correction might introduce
too much contrast. When an image requires strong highlights but not strong shadows (or
the reverse), you can use the Auto White or the Auto Black button to set the white or
black point without making the overall range of tones too extreme.

When you perform both an Auto Contrast and an Auto Balance correction, the order in
which you perform these two operations affects the final quality of the correction. In
most cases, you achieve the best results for most images by doing the following:

- Inthe Hue Offsets subdividing tab of the HSL tab, use Auto Contrast first, and then
use Auto Balance

- In the Curves tab, use Auto Balance first, and then use Auto Contrast

There is usually no gain in performing an automatic correction more than once on the
same image, even if the second correction would be made in a different group from the
first. For example, once you have performed an Auto Balance in the Curves tab, you do
not usually see any improvement in the color balance of the image if you perform a
second Auto Balance either in the Curves tab or in the Hue Offsets subdividing tab of
the HSL tab.

If an Auto Contrast and Auto Balance combination has improved an image but some
color cast remains, you can often fine-tune the correction using one or more of the
Remove Color Cast buttons.



Using the Color Match Control

* Automatic corrections you make in the Hue Offsets subdividing tab of the HSL tab and
those you make in the Curves tab do not produce identical results for most images (and
might produce markedly different results for some images). This is because the methods
for calculating the corrections are different and because the controls that are being
adjusted operate differently. Automatic corrections in the Curves tab often work well for
correcting basic problems caused by incorrect camera color balancing. Automatic
corrections in the Hue Offsets subdividing tab of the HSL tab are often better for more
extreme problems such as bad lighting conditions. However, there are no rules that
cover all situations. If automatic correction in one color correction group does not yield
good results, remove it and try a correction in the other group.

Using the Color Match Control

Input color
swatch

Match Type

button

Each Color Correction group includes a Color Match control. This control allows you to
quickly make a correction by selecting input and output colors from your images, or from
the Windows Color dialog box.

When you use the Color Match control, the system replaces the input color value with the
output color value and adjusts all the other color values in the image proportionally. The
system also automatically adjusts the other controls in the group to reflect the change. You
can set the combination of color channels or components the system uses to determine the
match by making menu selections.

For example, if you want to replace the blue sky tone in one image with that in another to
match the two shots, you can use the Color Match control to pick the two colors and
automate the color adjustment.

When you are working in the Curves group, the Color Match control also includes the
NaturalMatch™ feature. NaturalMatch allows you to replace the hue values in an image with
new output values without distorting the saturation and luminance values in the image.

You can also Alt+drag colors to a bin and save them as custom colors. You can then drag a
custom color into the Color Match control at any time.

The following illustration shows the Color Match control.

Output color
swatch

Match Color
button
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Slightly different versions of the Color Match control also appear as effect parameters in the
Spot Color Correction effect and the Paint Effect. For more information on spot color
correction, see the chapter “Spot Color Correction” on page 297.

Making a Correction with the Color Match Control

To make a correction using the Color Match control:

1. If you have not already done so, click the Color Correction Mode button below the
Timeline to enter Color Correction mode.

2. In the Color Correction tool, click the tab that includes the Color Match control with
which you want to work.

3. (Option) Select Eyedropper 3 x 3 Averaging in the Correction Mode Settings dialog
box.

When you select Eyedropper 3 x 3 Averaging, the system calculates the color value to
pick by averaging the values of a 3 x 3 sample of pixels centered on the eyedropper’s
position. This is often useful for picking up a color accurately by sight because it
compensates for shifts in color value from one pixel to another. When this option is
deselected, the system selects the color value of the exact pixel at the eyedropper’s
position.

For information on the Correction Mode Settings dialog box, see “Customizing Color
Correction Settings” on page 148.
4. Select the input color (the color to be replaced):
a. Move the pointer over the input color swatch.
The pointer changes to an eyedropper.

b. Press and hold the mouse button, and then drag the eyedropper to the area of the
image in the monitor from which you want to select an input value.

The input color swatch in the Color Match control updates as you move the
eyedropper in the image.

c. Release the mouse button to complete the selection.
The input color appears in the input color swatch.
You can also select an input color from the Windows Color dialog box by double-clicking the

input color swatch. However, you will usually want to select your input color from the
current segment.

174



Using the Color Match Control

5. Select the output color:
a. Move the pointer over the output color swatch.
The pointer changes to an eyedropper.

b. Press and hold the mouse button, and then drag the eyedropper to the area of the
image in the monitor from which you want to select an output value.

The output color swatch in the Color Match control updates as you move the
eyedropper in the image.

c. Release the mouse button to complete the selection.

The output color appears in the output color swatch.

Your output color is usually selected from an image other than the current segment, such as
the next segment or a reference frame. Alternatively, you can double-click the output color
swatch and select a color from the Windows Color dialog box. The Windows Color dialog
box is useful for selecting an “ideal” replacement color such as a completely neutral gray.
You can also use the Windows Color dialog box to create and store custom colors. For more
information on using the Windows Color dialog box, see “Using the Windows Color Dialog
Box” in the Help.

6. Click the Match Type button, and select a Match Type to determine the exact nature of
the match the system makes.

The options available in the Match Type menu depend on the group in which you are
working. For more information on Match Type options, see “Selecting Match Type
Options” on page 175.

7. Click the Match Color button to make the correction.

The system adjusts the current segment and resets the group controls to reflect the
adjustment. The corrected image displays in the monitor that contains the current
segment.

Selecting Match Type Options
The options available in the Match Type menu reflect the way in which color is handled in

the group in which you are working. The following tables describe the options available in
the Match Type menu.
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The following table describes the Match Type options for the HSL group in the Controls tab.

HSL Group (Controls Tab) Match Type Options

Option Description

H+S+L The system matches based on the hue, saturation, and luminance of the color selected
in the output color swatch.

Hue The system matches based on only the hue of the color selected in the output color
swatch.
Saturation The system matches based on only the saturation of the color selected in the output

color swatch.

Luminance The system matches based on only the luminance of the color selected in the output
color swatch.

H+S The system matches based on both the hue and the saturation of the color selected in
the output color swatch.

H+L The system matches based on both the hue and the luminance of the color selected in
the output color swatch.

S+L The system matches based on both the saturation and the luminance of the color
selected in the output color swatch.

The following table describes the Match Type options for the HSL group in the Hue Offsets
tab.

HSL Group (Hue Offsets Tab) Match Type Options

Option Description

Master The system matches based on both the hue and the saturation across the full tonal
range.

Highlights The system matches based on both the hue and the saturation across the highlights

portion of the tonal range as defined in the Luma Ranges tab.

Midtones The system matches based on both the hue and the saturation across the midtones
portion of the tonal range as defined in the Luma Ranges tab.

Shadows The system matches based on both the hue and the saturation across the shadows
portion of the tonal range as defined in the Luma Ranges tab.
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The following table describes the Match Type options for the Channels tab.

Channels Tab Match Type Options

Option Description

Master The system matches based on the luminance of the color selected in the output color
swatch.

R+G+B The system matches based on the values of all three color channels of the color
selected in the output color swatch.

Red The system matches based on only the value of the Red color channel of the color
selected in the output color swatch.

Green The system matches based on only the value of the Green color channel of the color
selected in the output color swatch.

Blue The system matches based on only the value of the Blue color channel of the color
selected in the output color swatch.

R+G The system matches based on the values of the Red and Green color channels of the
color selected in the output color swatch.

R+B The system matches based on the values of the Red and Blue color channels of the
color selected in the output color swatch.

G+B The system matches based on the values of the Green and Blue color channels of the
color selected in the output color swatch.

The following table describes the Match Type options for the Levels tab.
Levels Tab Match Type Options

Option Description

Black Point The system adjusts the black point of the image to the brightness value of the color
selected in the output color swatch.

Gray Point The system adjusts the gray point of the image to the brightness value of the color
selected in the output color swatch.

White Point The system adjusts the white point of the image to the brightness value of the color

selected in the output color swatch.
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The following table describes the Match Type options for the Curves tab.

Curves Tab Match Type Options

Option Description

Master The system matches based on the luminance of the color selected in the output color
swatch.

R+G+B The system matches based on the values of all three color channels of the color
selected in the output color swatch.

Red The system matches based on only the value of the Red color channel of the color
selected in the output color swatch.

Green The system matches based on only the value of the Green color channel of the color
selected in the output color swatch.

Blue The system matches based on only the value of the Blue color channel of the color
selected in the output color swatch.

R+G The system matches based on the values of the Red and Green color channels of the
color selected in the output color swatch.

R+B The system matches based on the values of the Red and Blue color channels of the
color selected in the output color swatch.

G+B The system matches based on the values of the Green and Blue color channels of the
color selected in the output color swatch.

NaturalMatch Select NaturalMatch to select or deselect the NaturalMatch feature.
When this command is selected, all the match types in the Curves and Secondary
groups use NaturalMatch when making a correction and match types appear in the
Color Match control with the extension (Nat). For more information on NaturalMatch,
see “Understanding NaturalMatch” on page 179.

The following table describes the Match Type options for the Secondary tab.
Secondary Tab Match Type Options

Option Description

Hue The system matches based on only the hue of the color selected in the output color
swatch.

Saturation The system matches based on only the saturation of the color selected in the output
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Secondary Tab Match Type Options (Continued)

Option Description

H+S The system matches based on both the hue and the saturation of the color selected in
the output color swatch.

NaturalMatch Select NaturalMatch to select or deselect the NaturalMatch feature.

When this command is selected, all the match types in the Curves and Secondary
groups use NaturalMatch when making a correction and match types appear in the
Color Match control with the extension (Nat). For more information on NaturalMatch,
see “Understanding NaturalMatch” on page 179.

Understanding NaturalMatch

In many situations when you are correcting on a shot-to-shot basis, color matching is
complicated by differences in lighting between one shot and another. For example, you
might want to match the skin tone in Shot A, which is in shadow, with that in Shot B, which
is brightly lit. To achieve a natural-looking correction, you need to replace the hue of Shot A
while preserving luminance and saturation characteristics that suggest shadow.

NaturalMatch solves this problem by making calculations that compensate for the luminance
and saturation qualities of the original image when making the correction. The correction
that is made when you use NaturalMatch adopts the new hue value, preserves the original
luminance value, and adjusts the saturation value in relation to the other values.
NaturalMatch allows you to use the quick correction method offered by the Color Match
control even when images show significant differences in lighting.

Color Match Example Using NaturalMatch

The following illustrations show an example of the use of the Color Match control and the
NaturalMatch feature to correct color from shot to shot.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version available from the Online Library for your application.
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Uncorrected Image

This original image is very gray and shows poor skin tones. The
RGB values for a point in the center of the man’s forehead are
R:61, G:62, B:66 — an almost completely neutral gray.

Reference Image

This image shows much better color characteristics, including
good skin tones and a better color for the canvas of the tent. If
we want to present these two shots next to one another in a
sequence, we will almost certainly want to make their color
characteristics match better. One way to do this is with the
Color Match control. If we use the center of the forehead in the
first image as an input value and the center of the forehead in
this reference image (R:110, G:70, B:56) as an output value,
and then make a Color Match using NaturalMatch to
automatically generate Curves adjustments for all three color
channels, we can quickly match the skin tones in the weak
image to those in the better one.

Corrected Image

Though this image would benefit from further correction
(particularly to improve the contrast ratio), it is improved
dramatically as a result of the color match. The skin tones and
the color of the tent in the background now match the reference
image well.
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Saving Custom Colors to a Bin

You can save a color that you have selected in the Color Match control as an item in a bin.
For example, you might want to save a skin tone that you want to match throughout your
sequence. You can then load that color back into the Color Match control whenever you need
to make a match based on that color.

To save a color to a bin:

1. In the Color Match control, Alt+click the swatch that contains the color you want to
save, and drag the rectangular outline to a bin.

While you drag, the pointer changes to a hand, and a rectangular outline appears.

The color appears in the bin as a rectangular color icon. The system assigns the color a
name based on the current Saved Color Labels settings in the Correction Mode Settings
dialog box. For more information, see “Customizing Color Correction Settings” on
page 148.

c¥lcustom Colors Sl

Text

Mame Cregtion Dete |
| Tan (180,166, 147) 071202005 12:3812
O MediumPurple (145, 147, 229) 071202005 12:37:28
W Sienma (156,101, 28) 071202005 12:37:04

2. (Option) If you want to rename the custom color, click the existing name in the bin and
type a new name.
To load a custom color into the Color Match control:

»  Click the color icon in the bin, and drag it to the appropriate color swatch in the Color
Match control.

Getting RGB Information Using the Color Match Control

By default, the color swatches in the Color Match control display the RGB values for the
selected color. This makes the Color Match control useful as an information palette to check
the exact RGB value of a sample area in your image.

For example, if you have an area in your image that you know should appear white, you can
sample that area using the Color Match eyedropper and check how far its RGB values depart
from a true white. If the values are R:231, G:217, B:229, then you know that a little green
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needs to be added to achieve white. (In other words, the image has a magenta cast.) If you
want this area in the image to be exactly reference white (R,G,B:235), you know that you
also need to adjust the white point slightly to increase the RGB values.

The HSL (Hue, Saturation, Luminance) Group

The HSL (Hue, Saturation, Luminance) group provides controls that allow you to alter
attributes such as hue, saturation, gain, and gamma. These controls resemble the color
adjustment controls found in the Video Input tool and in the Color Effect.

The HSL group also allows you to specify an offset for the hue of an image, a control that is
especially useful for correcting a color cast. For example, when an object in an image that
should be a neutral gray appears tinged with a color, you can use the offset adjustment to
restore the correct gray color.

The HSL group provides additional control by allowing you to make adjustments in three
different luminance ranges — highlights, midtones, and shadows. You can define the exact
scope of each of these ranges and get visual confirmation of which parts of an image fall in
each range. Having control over different luminance ranges is useful in a number of
situations. For example, video images often contain chroma noise in the brightest and
darkest areas. Using the HSL controls for the highlight and shadow ranges, you can make
adjustments to reduce the noise without affecting the midtones in the image.

You can invert both the chrominance and luminance values in an image with a single click.
You can also set clipping values for both the High and Low ends of the luminance range.

The HSL controls are capable of correcting a wide range of problems. If you are comfortable
working with the HSL group and gain some experience using it, you might be able to make
most of your common corrections without needing to employ any other group. For some
kinds of adjustments, however, you might find the blending properties or the individual color
channel control of other groups more suitable.

Working with the Controls Tab
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The Controls tab of the HSL group includes sliders for making adjustments to hue,
saturation, and luminance values. It also includes the Color Match control for making hue,
saturation, and luminance adjustments automatically, based on selected input and output
color values. For information on the Color Match control, see “Using the Color Match
Control” on page 173.
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The following illustration shows the Controls tab.

Making Corrections Using the Controls Tab

To make a color correction using the Controls tab:
1. If you have not already done so:
a. Move the position indicator to the segment you want to correct.
b. Click the Correction Type button and select a correction type.
c. Click the HSL tab.

For more information on correction types, see “Working with Correction Types” in the Help.
2. Click the Controls subdividing tab in the first vertical group on the left side of the Color

Correction tool.

3. Click the appropriate subdividing tab in the second vertical group on the left side of the
Color Correction tool.

This tab selection determines the brightness range across which your adjustments will
apply. The following table describes the available options.

Brightness Subdividing Tabs for the HSL Group

Tab Description

Master Adjustments apply to the whole image.

Highlights Adjustments apply to the brightest parts of the image only.
Midtones Adjustments apply to the midrange of brightness values only.
Shadows Adjustments apply to the darkest parts of the image only.
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By default, highlight, midtone, and shadow ranges represent equal one-third subdivisions of
the full brightness range. You can customize these ranges using the controls in the Luma
Ranges tab. For more information, see “Working with the Luma Ranges Tab” on page 193.

4. Make your adjustments by doing one of the following:

» Adjust one or more of the individual sliders or buttons. For more information, see
“Using the HSL Sliders” on page 184 and “Controls Tab Controls” on page 185.

»  Use the Color Match control to make a correction by selecting input and output
colors. For more information, see “Using the Color Match Control” on page 173.

Using the HSL Sliders
The following illustration shows the Hue slider.

Direction buttons

Enable
button

Text box Slider

To adjust the HSL sliders, do one of the following:

» Type a value in the text box, and then press Enter.

» Drag the slider.

» Click one of the direction buttons to change the value in small increments.

» Click and hold one of the direction buttons to change the value quickly over a large

range.

You can “nudge” the numerical value of a control up or down by small increments. To do
this, click in the text box, and then press the Up Arrow key to increase the value or the Down
Arrow key to decrease the value.

You can also use the mouse scroll wheel to change values in the Color Correction tool. Click
a slider or click in a value text box, then press the Ctrl key and use the scroll wheel to change
the value in small increments, or press the Ctrl and Shift keys (or the Ctrl and Alt keys) and
use the scroll wheel to change the value in increments of -10 or +10.

Each slider has an Enable button that you can click to turn that slider on or off or Alt+click
to reset the slider to its default value. For more information, see “Working with the Enable
Buttons” on page 145.
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Controls Tab Controls

The following table describes the individual controls available in the Controls tab of the

HSL tab.

Controls Tab Controls

Control

Description

Invert Chroma
(Master subdividing
tab only)

Hue

Saturation

Brightness

Contrast

Invert Luma
(Master subdividing
tab only)

Replaces the color value of every pixel in the image with the opposite color value on
the color wheel. This is the equivalent of setting the Hue control to 180 or —180.

Shifts the hues in the image around the color wheel. Values range from —180 to 180,
where 0 is the default and causes no change in the image. When applied in the Master
subdividing tab, a value of 120 shifts red to blue, and a value of —120 shifts red to
green.

Specifies the amount or intensity of color. Values range from 0 to 200, where 100
represents no change to the image, 0 represents complete desaturation (monochrome
image), and 200 represents maximum saturation.

The Master subdividing tab Saturation slider is also available as the Master
Saturation slider in the Curves tab. Adjusting the Master Saturation slider in
the Curves tab enables the HSL > Controls > Master tab hierarchy.

Adjusts the luminance of the image by shifting the luminance value of every pixel by
the value set in the control. Values range from —100 to 100, where —100 subtracts 100
from the 8-bit luminance value of every pixel and 100 adds 100 to the 8-bit luminance
value of every pixel.

The effect of the Brightness control is very similar to that of the Setup control. One
important difference, however, is that the Brightness control interacts with the
Contrast control, while the Setup control interacts with the Gain and Gamma controls.
If you have made a Contrast adjustment, it is better to adjust luminance further using
the Brightness slider. If you have made an adjustment using the Gain or Gamma
controls, it is better to adjust luminance further using the Setup control.

Increases or decreases the amount of contrast in the image. Values range from —100 to
100, where —100 represents no contrast (all pixels mapped to neutral gray) and 100
represents maximum contrast.

Reverses the brightness level of every pixel in the image. Dark areas become light, and
light areas become dark.
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Controls Tab Controls (Continued)

Control

Description

Gain

Gamma

Setup

Clip Low

Clip High

Adjusts the gain or white point for the image. Values range from 0 to 200, where 100
represents the unchanged image.

The main difference between Brightness and Gain is that Brightness adjusts by adding
to the 8-bit luminance value of every pixel, while Gain makes an adjustment based on
a percentage of the original luminance.

Adjusts the midpoint of the luminance range. Values range from 0.1 to 10, where 1
represents the unchanged image. Lowering the value darkens the midtones and brings
the image closer to black. Raising the value lightens the midtones and brings the
image closer to white.

Adjusts the setup or black point for the image. Values range from —255 to 255, where
0 represents the unchanged image.

The effect of the Setup control is very similar to that of the Brightness control. One
important difference, however, is that the Setup control interacts with the Gain and
Gamma controls, while the Brightness control interacts with the Contrast control. If
you have made an adjustment using the Gain or Gamma controls, it is better to adjust
luminance further using the Setup control. If you have made a Contrast adjustment, it
is better to adjust luminance further using the Brightness slider.

The Master subdividing tab Gain, Gamma, and Setup sliders are also available
in the Curves tab as the Master Gain, Master Gamma, and Master Setup
sliders. Adjusting any of these sliders in the Curves tab enables the HSL tab,
the Controls subdividing tab, and the Master brightness subdividing tab.

Sets the Low clip for the image. All pixels with the Low clip value or less are clipped
to black. The default setting is 16 on an 8-bit scale, representing the normal broadcast
value for black.

Sets the High clip for the image. All pixels with the High clip value or more are
clipped to white. The default setting is 235 on an 8-bit scale, representing the normal
broadcast value for white.

Working with the Hue Offsets Tab
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The Hue Offsets tab of the HSL group includes controls for adjusting hue and saturation
values at the same time using ChromaWheel color wheels and linked text boxes. These
controls are especially well-suited for correcting color casts in images.

Since the ChromaWheels provide a control similar to the physical controllers on traditional
color correction equipment, experienced colorists might choose to use them as their
preferred controls for many color adjustments.
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You can also use the Color Match control to automatically make a hue offset adjustment
based on input and output colors. For information on the Color Match control, see “Using
the Color Match Control” on page 173.

The following illustration shows the Hue Offsets tab.

Shadows Midtones Highlights Master Color Match control
ChromaWheel ChromaWheel ChromaWheel ChromaWheel

Understanding ChromaWheel Color Wheels

The Hue Offsets tab includes four ChromaWheel color wheels that allow you to make
adjustments across the same luminance ranges as the Controls tab. The wheels are arranged
in the following order from left to right: Shadows, Midtones, Highlights, and Master.

ChromaWheel Displays

By default, each Chroma Wheel displays as a graphical outline that resembles the design of
the Vectorscope monitor in the Video Input tool. Colors are oriented in the same manner as
in the Vectorscope monitor, with red near the top. Axes indicate the offset in degrees from
the 0° point, which corresponds with red.

You can display color backgrounds in the ChromaWheels that help you to understand the
effect of an adjustment as you work. For more information, see “Customizing Color
Correction Settings” in the Help.

The Hue Offsets color wheels are designed to create a familiar environment for users by
duplicating the general appearance of the Vectorscope monitor. They are not calibrated in
the same way as in the Vectorscope monitor.

Each wheel contains a crosshair pointer that identifies the currently selected point on the
wheel. Each pointer has a distinctive appearance to help you distinguish them from one
another. The following table shows the four pointers.
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ChromaWheel Crosshair Pointers

Color Wheel Pointer
Shadows +
Midtones +
Highlights

Master +

How ChromaWheels Work

The ChromaWheel color wheel is a circular graph that represents hue and saturation values.
Hue values are mapped around the circumference of the wheel, with colors in the same
positions that they occupy on a vectorscope. Red is at the 0° point on the wheel, and cyan is
at the 180° point.

As you move around the wheel counterclockwise from red to cyan, you move through
positive degree values. For example, green is at +120°. As you move around the wheel
clockwise from red to cyan, you move through negative degree values. For example, blue is
at —120°.

Saturation values are mapped along the radius of the wheel. The center point of the wheel
represents zero saturation (neutral gray); the edge of the wheel represents maximum
saturation. As you move out from the center of the wheel, you shift from less to more
saturation. Saturation values are measured on a scale from 0 (zero saturation) to 100
(maximum saturation).

By picking a specific point on the wheel, you select an exact combination of hue and color
intensity to add to your image. You can select a gray with a slight yellow tinge near the
center of the wheel, for example, or an intensely saturated blue at the outer edge.
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Saturationincreases
from the center of
the wheel toward
the edge.

Hue changes as
you move around
the wheel.

The graphical outline shows the
degree values for measuring hue.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version available from the Online Library for your application.

When you use ChromaWheels to correct a color cast, you use a basic principle of color
theory: you can cancel out one color in an image by adding an equal amount of the opposite
color on the wheel. For example, to remove a red cast, add some cyan. To remove a yellow
cast, add some blue. You do not even need to remember which colors are opposite when you
have the color wheel as a control. Simply add some color from the opposite side of the wheel
from the color you want to remove, and then fine-tune your adjustment until you are
satisfied with the result.

Making Corrections Using the Hue Offsets Tab

To make a correction using the Hue Offsets tab:
1. If you have not already done so:
a. Move the position indicator to the segment you want to correct.
b. Click the Correction Type button and select a correction type.
c. Click the HSL tab.

For more information on correction types, see “Working with Correction Types” in the Help.

2. Click the Hue Offsets subdividing tab in the first vertical group on the left side of the
Color Correction tool.
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3. Make your adjustments by doing one or more of the following:

»

Click one of the automatic color correction buttons, or use one of the Remove Color
Cast buttons, to adjust one or more of the ChromaWheel color wheels
automatically. For more information, see “Correcting Color Automatically in the
Hue Offsets Tab” in the Help and “Using the Remove Color Cast Buttons” on
page 170.

Drag the crosshair pointer on the appropriate ChromaWheel color wheel.

As you move the pointer in the wheel, the Hue and Amt (Amount) text boxes update
to display numerical values for the adjustment.

For more precise control over the movement of the crosshair pointer in the central area of
the wheel, press and hold the Shift key while dragging the pointer.

»

Type values in the Hue and Amt text boxes for the appropriate ChromaWheel color
wheel to set the offset you want. You must press Enter after typing a value for it to
take effect.

Hue values range from —180 degrees to 180 degrees where 0 degrees is the position
of red on the wheel. Amount values range from 0 to 100. When you change the Hue
and Amount values, the pointer on the color wheel updates to represent the
adjustment.

You can “nudge” the numerical value of a control up or down by small increments. To do
this, click in the text box, and then press the Up Arrow key to increase the value or the Down
Arrow key to decrease the value.

You can also use the mouse scroll wheel to change values in the Color Correction tool. Click
a slider or click in a value text box, then press the Ctrl key and use the scroll wheel to change
the value in small increments, or press the Ctrl and Shift keys (or the Ctrl and Alt keys) and
use the scroll wheel to change the value in increments of -10 or +10.

»  Use the Color Match control to calculate an offset automatically, based on input and

output colors. For more information, see “Using the Color Match Control” on
page 173.

4. Fine-tune your adjustments until you are satisfied with the result.

Remember that you can make adjustments on more than one color wheel and turn them
on and off individually to assess their effect on the image.
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Examples of Hue Offsets Settings

The following illustrations help you to understand the Hue Offsets controls by showing the
effect on an image of several simple adjustments made in the Master Hue Offsets
ChromaWheel color wheel.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version available from the Online Library for your application.

The Master wheel is used in these examples because it operates across the entire luminance
range and alters the image in ways that are easy to see and understand. You have more
precise control of corrections if you use the Shadows, Midtones, and Highlights wheels to
make adjustments in specific luminance ranges.
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This original image has a yellow cast. The swatch to the left, which shows the sample RGB
values for an area of the ladder, indicates that there is relatively less blue than red or green in
the grays of the image. You might not need to change this coloring, but you might want to
restore the metal objects in the image to a more neutral gray or even to change the look and
mood of the image by creating a different cast. One way to do this easily is using the Hue
Offsets ChromaWheel color wheels.
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Adjustment 1
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Adjustment 1 alters the original image by introducing just enough blue to make the grays in
the image neutral. The RGB values in the ladder now show almost equal amounts of red,
green, and blue. The yellow cast is corrected by moving the crosshair pointer in the
ChromaWheel color wheel in the opposite direction from yellow.

Adjustment 2
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Adjustment 2 increases the intensity of the blue that is being added to the original image.
Metal objects in the image are now distinctly blue-gray, and the sample values from the
ladder show more blue than red or green.
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Adjustment 3

-Hue -122.71 I 4025 ﬂm‘tﬁ

Adjustment 3 adds a large amount of blue to the original image. The metal objects now look
very blue, and the grain elevators are so saturated in blue that they have lost a lot of detail.
Though you might be unlikely to make such an extreme adjustment except as part of a
deliberately unrealistic look, it demonstrates how much an image can be changed with a
single adjustment of a Hue Offsets ChromaWheel color wheel.

Working with the Luma Ranges Tab

The Luma Ranges tab allows you to view and customize the luminance ranges that you are
using to define the highlights, midtones, and shadows in other parts of the HSL group. You
make these adjustments on a Luma Ranges graph.

You can view your images in three different ways while you are working in the Luma
Ranges tab. You can view the uncorrected image, the image with all active corrections
applied, or a three-tone preview that uses white, gray, and black to indicate the three
luminance ranges.

You might use the Luma Ranges tab as a tool to adjust the three luminance ranges before
you make other HSL adjustments. Alternatively, you might make HSL adjustments that
affect the different ranges and then use the Luma Ranges tab to fine-tune the brightness
ranges to which those adjustments apply. For example, you can make an adjustment that you
like in the Highlights wheel of the Hue Offsets tab and then fine-tune the range of pixels to
which that adjustment applies using the Luma Ranges tab.
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The following illustration shows the Luma Ranges tab with the Highlights subdividing
tab displayed.

Preview buttons

Luma Ranges graph

Text boxes

Understanding the Luma Ranges Graph

The Luma Ranges graph shows curves for each of the three luminance ranges: highlights,
midtones, and shadows. You can always see all three curves, but you can make adjustments
only to the curve that is active as defined by your subdividing tab.

The graph plots brightness values from 0 to 255 on the horizontal axis and percentage values
on the vertical axis. The system defines a luminance range as the area in the graph where the
curve for that range is highest in the graph. The following illustration shows this
arrangement for the default curves.

Shadows Midtones Highlights
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When you adjust a curve, you move a control point on the curve up or down on the graph.
This results in more or less of the curve being highest in the graph, which enlarges or
reduces the luminance range for that curve.

For example, if you raise the highlights curve near the center of the graph and drop the
midtones curve in the same area, you expand the highlights range toward the middle of the
full luminance range and contract the midtones range into a smaller area. The following
illustration shows this adjustment.

Reduced midtones range Expanded highlights range

To fine-tune luma range adjustments, you should understand the role of all three curves in
defining exactly how the system treats each level of brightness. At any point on the
brightness scale (the horizontal axis of the graph), percentage values are plotted for all three
ranges — shadows, midtones, and highlights. Though a luminance range is broadly defined
by which curve is highest in the graph, each brightness level is affected more precisely by all
three ranges in the relative percentage amounts shown on the graph.

For example, in the default Luma Ranges settings, brightness level 175 is defined as 50%
highlight, 50% midtone, and 0% shadow. Brightness level 215 is defined as 95% highlight,
5% midtone, and 0% shadow. If you have made adjustments to the highlights luminance
range elsewhere in the HSL tab, those adjustments are dominant in controlling pixels of
brightness 215 but share control of pixels of brightness 175 equally with the midtones
adjustments.

With some practice, you will find that you can control the relative impact of your
adjustments in different luminance ranges very precisely.
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Adjusting Luminance Ranges
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To adjust luminance ranges:

1. If you have not already done so:

a.

Move the position indicator to the segment you want to correct.

b. Click the Correction Type button and select a correction type.

C.

Click the HSL tab.

For more information on correction types, see “Working with Correction Types” in the Help.

2. Click the Luma Ranges tab in the first vertical group of subdividing tabs on the left side
of the Color Correction tool.

3. Click one of the following tabs in the second vertical group of subdividing tabs on the
left side of the Color Correction tool:

Highlights — Displays the Luma Ranges graph with the highlights curve available
for editing

Midtones — Displays the Luma Ranges graph with the midtones curve available
for editing

Shadows — Displays the Luma Ranges graph with the shadows curve available for
editing

4. Select one of the following options to control how your image displays in the active
monitor:

Input — Displays the uncorrected image in normal color

Three-tone — Displays the uncorrected image using white, gray, and black to
represent the highlights, midtones, and shadows luminance ranges

Output — Displays the image in normal color with all active corrections applied

You can switch back and forth freely between these settings as you work to assess
your adjustments.

5. Adjust the active curve by adding and adjusting control points using the procedures in
“Manipulating Luminance Range Curves” on page 197.
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Manipulating Luminance Range Curves

To add a control point to a curve:
»  Click the curve at the point where you want to move it.

A new control point appears with a circle around it to indicate that it is the active point.

To move a control point:
1. Click the control point to activate it.
A circle appears around the control point.
2. Do one of the following:
p  Click the point on the graph, and drag it until the curve is in the position you want.
P  Type values in the In and Out text boxes to define the position of the point on the

graph. You must press Enter after typing a value for it to take effect.

You can “nudge” the numerical value of a control up or down by small increments. To do
this, click in the text box, and then press the Up Arrow key to increase the value or the Down
Arrow key to decrease the value.

You can also use the mouse scroll wheel to change values in the Color Correction tool. Click
a slider or click in a value text box, then press the Ctrl key and use the scroll wheel to change
the value in small increments, or press the Ctrl and Shift keys (or the Ctrl and Alt keys) and
use the scroll wheel to change the value in increments of -10 or +10.

To delete a control point:

P Click the point to activate it, and then press the Delete key.
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Examples of Three-Tone Previews

The following illustrations show sample three-tone previews for a typical video image and
for a test monochrome gradient.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version available from the Online Library for your application.

Monochrome gradient (Imported PICT graphic) Video image

Original images

Three-tone preview using
default luma range settings

Three-tone preview with expanded
midtones range. The midtones
range now includes more of areas
such as the sign in the window and
the drape beside it.

Luma Ranges graph used
to create the expanded
midtones range shown in
the images immediately
above
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The Channels Group

The Channels group provides controls that allow you to redefine each output color channel
(red, green, blue) by blending different input color components in various proportions.

You can work with components from both the RGB (red, green, blue) and the YCbCr
(luminance, red chroma, blue chroma) color spaces. Because you can blend up to four input
components to create each output color channel, the Channels group offers very precise
control over the final composition of each color channel.

The Channels group also enables you to preview the individual color channels in
monochrome. This is useful for checking the amount of contrast or noise in each channel.

The Channels group is particularly useful for identifying a color channel that is deficient in
some way — one that is lacking in contrast or is noisy, for example — and repairing it by
“borrowing” from another color channel. For some kinds of images, borrowing in this way is
the only way to improve the appearance of the image significantly.

For example, you might preview the input channels for a segment and notice that, although
the master input shows acceptable overall contrast, the green channel is clipped to white and
has therefore lost contrast in the highlight range. It is not possible to “unclip” these green
highlights by working in the existing green channel, since the brightness value of all the
pixels in the highlight range is the same (or very nearly so). The best solution to this problem
is to blend a percentage of one of the other channels into the green channel to reintroduce
some contrast and detail. You might redefine the green channel as 80% green and 20% red to
solve the problem.

As in other groups, you can use the Color Match control to set the blending controls
automatically, based on selected input and output colors. For information on the Color
Match control, see “Using the Color Match Control” on page 173.

The following illustration shows the Channels tab in its default configuration.
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Making Corrections Using the Channels Tab

To make corrections using the Channels tab:
1. If you have not already done so:
a. Move the position indicator to the segment you want to correct.
b. Click the Correction Type button and select a correction type.
c. Click the Channels tab.

For more information on correction types, see “Working with Correction Types” in the Help.

2. Preview the input image by selecting an input type in the Preview pane:
- Red Input — Displays the uncorrected red channel in monochrome
- Green Input — Displays the uncorrected green channel in monochrome
- Blue Input — Displays the uncorrected blue channel in monochrome
- Master Input — Displays the complete uncorrected image in color

For more information on previewing options, see “Considerations When Working with
Color Components” on page 202.

3. Adjust the blend for each channel in the Channel Blending pane.

For more information on using the Channel Blending pane, see “Using the Channel
Blending Pane” on page 201.

4. Preview the output image by selecting an output type in the Preview pane:

- Red Output — Displays the red channel in monochrome with the Channel
Blending pane adjustments applied

- Green Output — Displays the green channel in monochrome with the Channel
Blending pane adjustments applied

- Blue Output — Displays the blue channel in monochrome with the Channel
Blending pane adjustments applied

- Master Output — Displays the complete image in color with the Channel
Blending pane adjustments applied

5. Repeat steps 2 through 4 as necessary until you are satisfied with the result.

Remember that you can switch between Preview options freely at any time and that you
can use the Enable buttons to turn each channel blending formula on and off or to reset it
to its default values.
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Using the Channel Blending Pane

The Channel Blending pane includes text boxes and buttons for each of the three RGB color
channels. Use these controls in combination to blend components and to create a formula for
the corrected color channel.

In its default configuration, the pane shows only one component for each channel. Each
component is represented by a text box that defines the percentage of the component that is
in the channel and a button that allows you to select the component type. You can add up to
three more components for a total of four.

Channel text box

_ Red iz I_‘_gn % Red Component Type button

To select a component type:
»  Click the Component Type button, and select a type from the menu.

The following table describes the available options.

Component Type Options in the Channels Tab

Option Description

Red The input red channel.

Green The input green channel.

Blue The input blue channel.

Luma The luminance channel in the component video signal.

Cr The red chroma channel in the component video signal.

Cb The blue chroma channel in the component video signal.

Offset A constant value that adjusts all the other values in the formula.

Invert This option subtracts the component from the overall formula instead of adding it.

Select one of the other options, and then select Invert to invert it. A minus sign (-)
appears after the component name when it is inverted. This has the same effect as
entering a negative value for a component: 20% Green — is the same as

—20% Green.
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To adjust the amount of a component in the blend:
» Type a value in the text box for the component, and then press Enter. Values can range
from —200% to 200%.

You can “nudge” the numerical value of a control up or down by small increments. To do
this, click in the text box, and then press the Up Arrow key to increase the value or the Down
Arrow key to decrease the value.

You can also use the mouse scroll wheel to change values in the Color Correction tool. Click
a slider or click in a value text box, then press the Ctrl key and use the scroll wheel to change
the value in small increments, or press the Ctrl and Shift keys (or the Ctrl and Alt keys) and
use the scroll wheel to change the value in increments of -10 or +10.
To add a new component to the formula for a channel:
»  Click the “more” button to the right of the existing components.
The “more” button changes to a plus (+) button, and a new set of component controls
appears to the right of the button.
To remove components from the formula:

»  Click the plus (+) button to the left of the components you want to remove.

The system removes all components to the right of the plus (+) button you click.

Considerations When Working with Color Components
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When you find that one of your color channels has a problem that you want to correct by
blending, you need to look for another color component that can correct the problem while
minimizing any unwanted changes. In general, you should look for a component that
exhibits less of the specific problem you want to correct but that otherwise looks similar to
the problem channel.

You do not have to restrict your component choices to the same color space (RGB or
YCbCr). In fact, it is common practice when performing advanced color correction to
borrow from a different color space. For example, if you have a green channel that is noisy
in the highlight range, you might find that the Cb (blue chroma) component has less
highlight noise but is otherwise similar in its brightness distribution to the green channel.
Blending a percentage of Cb into the green channel reduces the noise without greatly
disturbing other aspects of the channel.
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You can preview the full range of color components available by temporarily redefining one
of the existing channels. For example, if you want to see what the Cb component looks like
in comparison to your problem green channel, you can redefine the red channel as 100% Cb.
Then you can switch back and forth between the Red Input and Green Input previews to
compare the two.

The total of the percentages you set for a channel does not need to be 100. The percentage
values simply indicate relative proportions of one component as opposed to others.

Examples of Channel Blending Settings

The following illustrations show two representative Channel Blending settings for the red
channel.

The following detailed example shows how an individual channel is altered by blending.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version available from the Online Library for your application.

The Blue Input monochrome preview shows that the blue channel lacks contrast. Blending
25% of the green channel information into the blue channel (as shown in the illustration of
the controls) introduces somewhat more contrast into the blue channel.

The effect on the Master image in this case is not dramatic; this might or might not be
desirable, depending on your project needs. A little extra detail has been obtained in the
lower half of the image, but the color characteristics have changed so that the image is less
intensely yellow. This probably improves the look of the sky; however, it reduces the
strength of the yellow color in the sunflowers.
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Blue Input preview Blue Output preview

Master Input preview Master Output preview

The Levels Group

The Levels group allows you to control the relative brightness or darkness of an image by
defining the white point, gray point, and black point of video material.

You can do this for the master channel (red, green, and blue combined) or for each of the
color channels. You can also control the white and black points only for the luminance range
and for the composite signal to ensure your sequence is within legal limits. If you make
adjustments in the master channel and in one or more of the other channels, the final output
is the cumulative result of all the adjustments.
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There are four ways to define the white, gray, and black points. You can type numerical
values, adjust sliders on a histogram control, move control points on a ChromaCurve graph,
or use the Color Match control to set points automatically, based on selected input and
output colors. For information on the Color Match control, see “Using the Color Match
Control” on page 173.

The main use of the Levels group is to rebalance the color or luma range. The group
provides a great deal of control over the amount of contrast and detail visible in the video
image, especially since you can make adjustments on the individual color channels. The
Levels group is, therefore, a more refined and specialized version of the Gain, Gamma, and
Setup controls in the HSL tab.

You might want to extend the range of contrast and detail in an image that lacks a full range
(either in one color channel or across all the color channels), or you might want to
deliberately reduce detail in part of the range (perhaps to expand another part of the range
that is more important in the image). You might also want to adjust the gray point with
respect to the black and white points in order to rebalance the midtones without significantly
affecting the highlights and shadows.

It is important to understand the difference between a circumstance in which detail can be
enhanced with the Levels group and one in which a blending adjustment in the Channels
group is more useful. If a channel (for example, green) is clipped to white, then it does not
contain enough information to contribute much detail; it must be repaired by borrowing
contrast from another color component in the manner described in “The Channels Group” on
page 199. If, however, the green channel contains an acceptable range of tones but they are
shifted toward the highlight end of the brightness range, resetting the black point in the
Levels group improves contrast and detail by spreading the available information over a
bigger range.

The following illustration shows the Levels tab in its default configuration.

Subdividing Input text boxes Curve graph Output text boxes Color Match control
tabs

Input histogram Output histogram
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Understanding Input and Output Levels Adjustments

When you make an adjustment in the Levels tab, you are changing the relationship between
input and output values for your image. You can make adjustments on both the input and the
output side, and understanding the differences between input and output adjustments is
important.

Examples of Black Point Input and Output Adjustments
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A typical default setup for the Levels tab shows the following values on both the input and
the output side:

Black Point Gray Point White Point

16 128 235

The black point and white point values represent normal, safe limits for video broadcast.

If you make an adjustment on the input side, you change the range of input values being
mapped to the same range of output values. For example, if you move the black point up to
60, you instruct the system to map all values of 60 or less to the output value of 16. As a
result, input values between 60 and 235 are now mapped to the full output range of 16 to 235
(176 input steps on the 8-bit scale are mapped to 220 output steps on the 8-bit scale). You
have clipped some black values, but you have also spread the remaining input values over a
greater range. Depending on the exact nature of the image, this will probably result in some
degree of improvement in contrast and detail.

The input and output values for this adjustment are as follows:

Black Point Gray Point White Point
Input 60 128 235
Output 16 128 235

The following illustrations show the effect of this adjustment for a monochrome gradient
and a video image.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version available from the Online Library for your application.
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Unadjusted images Adjusted images

If you make an adjustment on the output side, you change the total range of output steps
available. For example, if you leave the input points unchanged and change the output black
point to 60, you are deliberately reducing the range of values in the image (220 input steps
are mapped to only 176 output values). The input and output values for this adjustment are
as follows:

Black Point Gray Point White Point
Input 16 128 235
Output 60 128 235

The following illustrations show the effect of this adjustment for a monochrome gradient
and a video image.
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Unadjusted images Adjusted images

Examples of Gray Point Input and Output Adjustments
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Gray point adjustments work in a similar way to black and white point adjustments except
that output gray point changes will not change the total output range. If you change the input
gray point to 100 while keeping all other values at their default setting, you are instructing
the system to map input values from 16 to 100 to output values from 16 to 128, and input
values from 100 to 235 to output values from 128 to 235. This brightens the image
somewhat. The input and output values for this adjustment are as follows:

Black Point Gray Point White Point
Input 16 100 235
Output 16 128 235

The following illustrations show the effect of this adjustment for a monochrome gradient
and a video image. In the adjusted monochrome gradient, the mid-gray value has moved
toward the left.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version available from the Online Library for your application.
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Unadjusted images Adjusted images

If, however, you change the output gray point to 100, you are essentially performing the
opposite correction. Input values from 16 to 128 are mapped to output values from 16 to
100. Input values from 128 to 235 are mapped to output values from 100 to 235. This has the
effect of darkening the image somewhat. The input and output values for this adjustment are
as follows:

Black Point Gray Point White Point
Input 16 128 235
Output 16 100 235

The following illustrations show the effect of this adjustment for a monochrome gradient
and a video image.
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Unadjusted images Adjusted images

Making Corrections Using the Levels Tab

To make corrections using the Levels tab:
1. If you have not already done so:
a. Move the position indicator to the segment you want to correct.
b. Click the Correction Type button and select a correction type.
c. Click the Levels tab.

For more information on correction types, see “Working with Correction Types” in the Help.

2. Click the appropriate subdividing tab on the left side of the Color Correction tool.

The subdividing tab selects the type of levels adjustment you want to make. The
following options are available:

- Composite —Allows you to adjust high and low points for the composite signal to
ensure that your sequence remains within legal composite limits

- Luma —Allows you to adjust levels based on luminance values only

Controls in the Composite and Luma tabs work slightly differently from those in the other
Levels tabs. For more information on working with the Composite and Luma tabs, see
“Working with the Composite and Luma Tabs” on page 216.
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- Red — Allows you to adjust levels for the red channel only

- Green — Allows you to adjust levels for the green channel only

- Blue — Allows you to adjust levels for the blue channel only

- Master — Allows you to adjust levels for all three color channels
3. Make adjustments to the controls until you are satisfied with the result.

For more information on the individual controls and how to use them, see “Working
with the Levels Tab Controls” on page 211.

Working with the Levels Tab Controls

The following sections provide detailed explanations of the different controls in the Levels
tab and how to use them.

The Levels controls are dynamically linked. When you make an adjustment to one of the
controls, that adjustment is reflected in all other appropriate controls. For example, if you
change the input black point value in the text box, the histogram slider and the control point
for black on the ChromaCurve graph changes.

Understanding Histograms

A histogram is a graph of information about the color values of all the pixels in an image.
Color values are plotted on the horizontal axis of the graph; the number of pixels is plotted
on the vertical axis. For example, if an image contains 120 pixels of color value 30, then a
bar 120 units high appears at the 30 point along the horizontal axis. A background grid
indicates the quartile points on each axis to assist you when you are reading the graph and
making adjustments.

Histograms provide an easily understood summary of the color range of an image. If an
image is mostly dark, the bars of its histogram are concentrated at the low end. If an image
contains only a small number of discrete color values, its histogram shows discrete spikes
for each of those values. The following illustrations show several examples of histogram
patterns.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version available from the Online Library for your application.
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Example 1

This image has large areas that are very dark and a relatively
even distribution of values in the rest of the brightness range.
The histogram shows a sharp spike at the very low end, a
concentration of values in the lowest 25% of the range, and a
relatively even distribution in the rest of the range.

Example 2

This image, like the last, has more dark values than light. But
the distribution of values is less extreme, and this is reflected
in the histogram, which shows a more rounded peak at the
low end, fewer extremely low values, and relatively more
midtone values.

Example 3

This image has very large highlight areas in the background
and on the chicks. Most of the rest of the image is relatively,
but not extremely, dark. The histogram shows sharp spikes at
the high end, relative concentration in the low to middle
range, and few values in the middle to high range.
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Using the Histogram Controls

To make adjustments to the histogram controls:

»  Click the appropriate triangular slider below the histogram, and drag it to its new
position.

The following illustration shows the Black Point, Gray Point, and White Point sliders.

F

Black Point slider  Gray Point slider ~ White Point slider

For example, if you want to move the input black point toward gray, click the Black Point
slider and move it to the right.

When you make an adjustment to the input controls, the input histogram does not update.
The input histogram always shows the distribution of values for the uncorrected image. The
appropriate text box, the ChromaCurve graph, and the output histogram do update.

Using the Text Boxes

To set black, white, and gray points for both input and output:

P Type a numerical value in the appropriate text box, and then press Enter.

The following illustration shows the input text boxes.
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Black Point text box White Point text box

Gray Point text box

For example, if you are working with 8-bit values and you type 50 in the In Black Point text
box, you set the black point to 50 on a scale from 0 to 255.

You can “nudge” the numerical value of a control up or down by small increments. To do
this, click in the text box, and then press the Up Arrow key to increase the value or the Down
Arrow key to decrease the value.

You can also use the mouse scroll wheel to change values in the Color Correction tool. Click
a slider or click in a value text box, then press the Ctrl key and use the scroll wheel to change
the value in small increments, or press the Ctrl and Shift keys (or the Ctrl and Alt keys) and
use the scroll wheel to change the value in increments of -10 or +10.

Understanding ChromaCurve Graphs
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A ChromaCurve graph shows the relationship of input values (on the horizontal axis) to
output values (on the vertical axis). The graph in the Levels tab has three control points for
manipulating black, gray, and white points. A background grid indicates the quartile points
on each axis to assist you when you are reading the graph and making adjustments.

The following illustration shows the Levels tab Curve graph.

Control point for white point

Control point for gray point

Control point for black point
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The default curve that displays in the graph (before any adjustments have been made) is
therefore an ascending 45 degree straight line, since input and output values are the same
across the entire range. (In the previous illustration, the line of the graph is horizontal for the
extreme low and high values because of standard video limiting. All input values of 16 and
below are mapped to an output value of 16; all input values of 235 and above are mapped to
an output value of 235.)

If you make an adjustment that moves part of the line below the 45 degree angle, you make
the output values for that part of the image lower than the input values. If you make an
adjustment that moves part of the line above the 45 degree angle, you make the output values
for that part of the image higher than the input values.

If you make an extreme adjustment to a curve so that it becomes a horizontal line, you are
converting all input values to the same output value.

For example, in the following illustration, all input values are mapped to an output value of
128. When this adjustment is made across all three color channels, the result is a uniform,
mid-gray image.

When you make less extreme adjustments, the result is a true curve, since the graph updates
by calculating a curve based on the values of the control points and their positions with
respect to one another. For example, if you move the control point for gray, the white point
and black point remain in the same positions. Intermediate values along the curve are
calculated based on the relative position of the new gray point with respect to the white and
black points. The following illustration shows this behavior for a typical gray point
adjustment.
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ChromaCurve graph for a typical gray point
adjustment. Because of the exact position of the gray
point, the curve is steeper near the black point and
somewhat shallower near the white point. The
adjustment therefore boosts values in the lower half
somewhat more than in the upper half. One benefit of
this is that values near the white point receive some
adjustment but are not clipped to white.

Using the ChromaCurve Graph in the Levels Tab

You adjust the ChromaCurve graph in the Levels tab by clicking one or more of the three
control points and dragging it to a new position.

To adjust a control point:
» Click a control point, and drag it to a new position.

When you click a control point, a circle appears around it to indicate that it is selected.

Working with the Composite and Luma Tabs
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The Composite tab shows histograms that represent the levels in the composite image before
and after correction. The Luma tab shows histograms that represent the luminance levels in
the image before and after correction. They are useful for checking whether your
color-corrected images are within the composite and luminance limits you need to meet and
for adjusting levels to meet those limits, if necessary.

The Composite tab can display unit information in either IRE units or millivolts, depending
on which option you select in the Correction Mode Settings dialog box. The Luma tab can
display unit information in a broader range of unit types. For more information, see
“Customizing Color Correction Settings” on page 148.

You can make only black point and white point adjustments in the Composite and Luma
tabs. By adjusting these two points, if necessary, you can bring any values that exceed your
composite or luminance limits back into an acceptable range.

The following illustration shows the controls for the Composite histogram and Curve graph.



The Levels Group

Black and white points only on histogram Two control points in Curve graph

You can use the Composite and Luma tabs together with the Safe Color feature to ensure
that your images remain within limits. If you set the Safe Colors feature to warn you when
composite and luminance limits are exceeded, parts of the image that exceed the limit appear
orange in the histograms and you can use these warnings to guide your adjustments. For
more information on safe colors, see “Safe Color Basics” in the Help and the chapter “Safe
Colors.”

Examples of Levels Adjustments

The following illustrations show some common levels adjustments. In the first example,
white, black, and gray points are all adjusted to create a small but significant change in the
amount of contrast available in the image. In the second example, a gray point adjustment
alone greatly increases the amount of detail that can be seen.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version available from the Online Library for your application.
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Example 1

Unadjusted image

218

Performing Color Corrections

In this example, the intention is to enhance the contrast between the white building exterior
and the black building interior toward which the car is driving. By changing the input black
point to 19 and the input white point to 206, you increase the contrast range. These
adjustments leave the entire image a little dark and lacking in detail, so a gray point
adjustment is made to place more of the overall tonal range between gray and white. The
final image shows strong contrast between the lightest and darkest areas and sharp highlights
around the letters in the foreground.
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Example 2

Unadjusted image Adjusted image

In this example, the gray point adjustment substantially increases the proportion of the tonal
range that lies between gray and white. As a result, detail is greatly enhanced in the image,
revealing such details as the lettering on the wall at the extreme right.

The Curves Group

The Curves group allows you to control color by placing up to 16 control points on a
ChromaCurve graph and then adjusting the points.

As in the Levels tab, you can control the master channel or any individual color channel.

The ChromaCurve graphs in the Curves tab are similar to those in the Levels tab, except that
they allow you to add up to 16 control points. With 16 control points, you can control color
with great precision in the Curves tab since you can make detailed adjustments to many
different subdivisions of the brightness range.

219



Chapter 5 Performing Color Corrections

By default, ChromaCurves in the Curves tab display as a graph line plotted through a set of
control points. You can also choose to display color backgrounds in the Curves tab
ChromaCurves that help you to understand the effect of an adjustment as you work. For
more information, see “Customizing Color Correction Settings” in the Help.

For more information on how ChromaCurve graphs operate, see “Understanding
ChromaCurve Graphs” on page 214.

You can also type numerical input and output values in text boxes or use the Color Match
control to automatically add control points to the curves, based on selected input and output
colors. For more information on the Color Match control, see “Using the Color Match
Control” on page 173 and “Curves and the Color Match Control” on page 223.

The Curves tab also contains four slider controls — Master Saturation, Master Gain, Master
Gamma, and Master Setup. These sliders work in exactly the same way as the Saturation,
Gain, Gamma, and Setup sliders in the HSL > Controls > Master tab, allowing you to make
some HSL-type adjustments without having to leave the Curves tab. When you adjust any of
these sliders, you enable the HSL > Controls > Master hierarchy of tabs. For more
information on the function of these controls, see “Controls Tab Controls” on page 185.

Making Corrections Using the Curves Tab

The following illustration shows the Curves tab.

Curve graphs Sliders

Color Match control

To make corrections using the Curves tab:
1. If you have not already done so:
a. Move the position indicator to the segment you want to correct.
b. Click the Correction Type button and select a correction type.
c. Click the Levels tab.

For more information on correction types, see “Working with Correction Types” in the Help.
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2. Do one or more of the following:
P Adjust the curves until you are satisfied with the results.
For more information on adjusting curves, see “Adjusting Curves” on page 221.

P Adjust the Master Saturation, Master Gain, Master Gamma, or Master Setup slider
controls.

For more information, see “Using the HSL Sliders” on page 184 and “Controls Tab
Controls” on page 185.

Adjusting Curves

Adjusting ChromaCurve graphs in the Curves tab is similar to adjusting the three-point
ChromaCurve graph in the Levels tab. In the Curves tab, however, you can set up to 16 total
control points on a ChromaCurve graph.

To add a control point:

P Click the curve line in the graph at the point where you want the new point to appear.

A new control point appears with a circle around it to indicate that it is the active control
point.

New control point

To select a control point:
p  Click the control point you want to select.

A circle appears around the control point to indicate that it is the active control point.

@ Active control point

‘ Inactive control point
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To move a control point, do one of the following:

»  Click the control point, and drag it to the location on the graph where you want to place
the point.

The curve updates as you drag the control point.

» Type input and output values for the position of the control point in the Input and Output
text boxes below the ChromaCurve graph. You must press Enter after typing a value for
it to take effect.

You can “nudge” the numerical value of a control up or down by small increments. To do
this, click in the text box, and then press the Up Arrow key to increase the value or the Down
Arrow key to decrease the value.

You can also use the mouse scroll wheel to change values in the Color Correction tool. Click
a slider or click in a value text box, then press the Ctrl key and use the scroll wheel to change
the value in small increments, or press the Ctrl and Shift keys (or the Ctrl and Alt keys) and
use the scroll wheel to change the value in increments of -10 or +10.

Control point at 100 on the
input (horizontal) axis, 69 on
the output (vertical) axis

- I i1IZII:I| 169 2 Bit

Input text box Output text box

To delete a control point:
1. Click the control point to activate it.
A circle appears around the control point.

2. Make sure that the pointer is over the curve graph that contains the control point you
want to delete.

3. Press the Delete key.

A curve is defined by at least two control points. If you have only two control points set in a
curve graph, you cannot delete one.
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To anchor a portion of the curve so that it does not move when you are making other
adjustments:

1. Place two control points at either end of the portion of the curve you want to anchor.

2. Place a third control point very close to the point that separates the portion of the curve
you want to anchor from the portion of the curve you want to adjust.

3. Place a fourth control point on the portion of the curve that you want to adjust.

Third control point. The
curve will adjust around
this point but will not
move between the first
two points.

Fourth control point. Click this
point, and drag it to adjust the
upper portion of the curve.
First two control points
define the portion of the
curve you want to anchor.

When you drag the new control point to adjust the curve, the portion of the curve
between the first two control points will not move.

Adjusted portion of
the curve

Anchored portion of
the curve

Curves and the Color Match Control

When you use the Color Match control in the Curves tab, a gray crosshair marker appears in
each appropriate ChromaCurve graph to mark the intersection of the input value as defined
by the input color swatch in the Color Match control and the output value as defined by the
output color swatch in the Color Match control.
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When you click the Match Color button, the system adds new control points and updates the
ChromaCurve graphs to reflect the color match. If you are not using NaturalMatch or if the
ChromaCurve graphs have not received any previous adjustment, the new control points will
appear at the location of the crosshair marker. If you are using NaturalMatch or if the
ChromaCurve graphs have already received some adjustment, the system makes a more
complex calculation to reflect the input saturation and luminance values or to take earlier
ChromaCurve graph adjustments into account. In these cases, the new control points will not
appear at the location of the crosshair marker.

The following illustrations show this behavior both before and after you click the Match
Color button.

The crosshair marker on the Green ChromaCurve graph
represents the values for Green in the color swatches — Input
131, Output 105. Since R+G+B is selected as the Match Type,
similar crosshair markers appear on the Red and Blue
ChromaCurve graphs.

When you click the Match Color button, the system creates a
new control point and updates the curve to reflect the color
match. In this illustration, NaturalMatch is selected and the
calculation is not complicated by other control points, so the new
control point is created at the exact location of the crosshair
marker. The Green input and output values as shown in the color
swatches now appear in the Input and Output text boxes below
the graph.

Input text box Output text box
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Examples of Curve Adjustments

The following illustrations show a series of simple adjustments made to an image using the
Red ChromaCurve graph in the Curves tab. By comparing the results of these adjustments,
you can learn how curves can be used to control color across different parts of the brightness
range.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version available from the Online Library for your application.

In each adjustment example, the new corrected image and the curve used to produce it are
shown together with one other image from the series for the purpose of comparison.

In each example, the color of the background behind the control point represents the color
change to the image. In the first example, creating a curve through the darker cyan area
causes reds to be reduced in the darker parts of the image. In the second example, creating a
curve through the lighter cyan area causes reds to be reduced in the lighter areas of

the image.
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Uncorrected Image

Adjustment 1

Adjustment 1. Red is reduced primarily in the shadows range (the lower part of the curve).
Notice how much of the red tone is lost from the background grass, the shirt, and the lower
red signpost, which loses much of its detail. The higher red signpost is relatively less
desaturated, however, and some of the reddish tinge is retained in the cloud highlights in the
top right.
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Adjustment 1

Adjustment 2

Adjustment 2. Red is reduced primarily in the highlights range (the upper part of the curve).
The differences between this adjustment and adjustment 1 are most apparent in the lower
signpost, which retains more redness and detail, and in the background, where the crop in
the lower right retains more red tones, but the cloud highlights in the top right have lost their
red tinge.
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Adjustment 2

Adjustment 3

Adjustment 3. Red is reduced more evenly across the entire luminance range but with the
largest change in the midtones. Though the differences between this adjustment and
adjustment 2 are subtle, the strong midtone reduction in red is most noticeable in the skin
tones, which appear more gray than in either adjustment 1 or adjustment 2. However,
adjustment 3 retains both some detail in the lower signpost and some of the reddish
highlights in the clouds.
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Adjustment 3

Adjustment 4

Adjustment 4. Red is boosted relatively evenly across the entire luminance range but with
the largest change in the midtones. Here the difference from adjustment 3 is obvious
throughout the image. The most extreme differences appear in the midtone range, for
example, in the hands.
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Adjustment 4

Adjustment 5

Adjustment 5. Red is boosted primarily in the highlights range. Here the most noticeable
difference can be seen in the crop in the background. In adjustment 4, where red has been
boosted more in the lower ranges, the crop looks more orange. In adjustment 5, where red
has been boosted very little in the shadows range, the crop looks more yellow-green.
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Adjustment 5

Adjustment 6

Adjustment 6. In the final adjustment, red is boosted primarily in the shadows range. In
comparison with adjustment 5, there is much more of a red or orange tinge in the darker
parts of the image (for example the crop in the lower right and the lower part of the shirt).
Highlights in the clouds, however, have much less of a red tinge.
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The Secondary Group
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Secondary color correction allows you to make real-time adjustments to parts of an image
defined by hue and saturation values. You can apply secondary adjustments, like other
adjustments made in Color Correction mode, to a single segment or to multiple segments
that you define by setting Source or Program relationships.

Secondary color correction works best when the range of colors that you want to change in
an image is isolated in the area or object that you want to change and does not appear
elsewhere in the image. For example, you can use secondary color correction to change the
look of a sky as long as the blue tones of the sky are not present elsewhere in the image.

If you want to change the colors in part of an image without affecting any other part of the
image in any way, you can use the Spot Color effect or certain modes in the Paint Effect to
isolate part of the image using drawing tools, and then color correct that part only. For
example, if you had a clip showing three red cars and you wanted just one of the cars to be a
different color, you could use the Spot Color effect. For more information, see “Spot Color
Correction” on page 297.

The following illustrations show a typical example of a secondary color correction. The
original color of the turban is changed with virtually no alteration to the color characteristics
of other parts of the image.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version available from the Online Library for your application.
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Understanding Secondary Color Correction

The Secondary group provides controls for making hue and saturation adjustments to as
many as 12 distinct parts of the full color range in an image.

Secondary color correction is most useful for images in which the following two
circumstances apply:

*  You want to change the color characteristics of some parts of the image without altering
the rest of the image in any way.

»  The parts of the image that you want to change are characterized by hue and saturation
values that are absent or nearly absent from the rest of the image.

For example, you might be correcting a shot of a person wearing a bright yellow scarf. After
earlier stages of color correction, you are pleased with the image in general, but the scarf
remains too bright. You can use secondary color correction to select the bright yellow of the
scarf and then make an adjustment to alter the yellow color. The system applies that
adjustment to only the bright yellow pixels in the image. As long as no other parts of the
image are bright yellow, your correction changes the color of the scarf alone, preserving the
rest of the image untouched.

The following illustration shows the Sec (Secondary) tab in its default configuration.

Output Vector controls  Color Match control

Input Vector controls Input Vector Output Vector Selected Vectors panel  Color Correction
color wheel color wheel buckets

Color Selection buttons
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Secondary Color Correction Workflow
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The workflow for secondary color correction differs slightly from that used in other color
correction groups since you must make corrections in two distinct stages. In the first stage,
you define the range of color in the image that you want to alter using the Input Vector
controls, the Color Selection buttons, or the Color Match control. In the second stage, you
change the hue and saturation values of the defined range of color using the Output Vector
controls or the Color Match control.

The following procedure lists the main steps involved in making a secondary color
correction and provides cross-references to detailed information on each step.

To make a secondary color correction:

1.

In Color Correction mode, verify that you have selected the track in which you want to
make the correction.

. Click the Sec (Secondary) tab.

. Select a correction type to control the scope of the correction.

For more information, see “Working with Correction Types” on page 136.

. Move the position indicator to the segment you want to correct.

5. Select a predefined color vector as a starting point for defining the color range you want

to correct.

For more information, see “Understanding Secondary Color Correction Vectors” on
page 235 and “Selecting Vectors” on page 241.

. Adjust the input values of the vector until it corresponds to the color range you want to

correct.

For more information, see “Adjusting Input Vector Values” on page 242.

. (Option) As an alternative to steps 5 and 6, use the Color Selection buttons to select,

enable, and adjust an input color vector based on colors that you sample from the image.
For more information, see “Using the Color Selection Buttons” on page 247.

. Correct the color range you have defined by adjusting the output values of the vector.

For more information, see “Adjusting Output Vector Values” on page 251.

You can also use the Color Match control to quickly make a correction based on input and
output color values that you select, and then fine-tune the correction using Input and Output

Vector controls. For more information, see

ccec

Using the Color Match Control for Secondary

Corrections” on page 252.
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Understanding Secondary Color Correction Vectors

Secondary color correction is based on the concept of color vectors. A vector is a subset of
the full color range in an image. When you work in the Secondary group, you select a
predefined vector as a starting point, adjust the vector so that it represents the exact color
range you want to correct, and then change the color characteristics of that vector.

Standard and Custom Vectors

The system provides twelve predefined color vectors. The first six, known as standard
vectors, represent the following major colors: Green, Yellow, Red, Magenta, Blue, Cyan.
The remaining six, known as custom vectors, represent other, more narrowly defined colors
that are useful starting points for common corrections (for example, blues that can be easily
customized to define the sky color in an image).

Vector Display in Color Wheels

Center point

Boundary line

The Secondary tab displays vectors graphically in color wheels similar to those used in the
Hue Offsets tab of the HSL group. In these displays, the full wheel represents the complete
range of possible hue and saturation values, and each vector appears as a distinct area within
the wheel. For more information on the color wheels and how they represent hue and
saturation values, see “Understanding ChromaWheel Color Wheels” on page 187.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version available from the Online Library for your application.

The following illustration shows a color wheel that displays all the available color vectors.
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Each vector displays with a boundary line and a center point. The center point marks the
base hue and saturation values for the vector, while the boundary lines indicate the range of
hue and saturation values that the vector contains. Center points for standard vectors are
filled circles; center points for custom vectors are crosshairs.

The hue range of a vector is represented by the arc of the wheel that it covers, and the
saturation range of a vector is represented by the part of the wheel’s radius that it covers.

The exact range of values included in a vector is also related to the shape of that vector.
Standard vectors always appear as wedge shapes — they have no upper saturation limit, and
their hue ranges are constant regardless of the saturation level. Custom vectors always
appear as ellipses — their saturation ranges are fully adjustable, and their hue ranges scale
with the saturation level.

The following illustrations show how to interpret the hue and saturation ranges of a vector
from its color wheel display.

Hue Range Example Using Red Standard Vector

The vector extends for 30° of arc —
15° either side of pure red. A narrower
arc limits the vector to a smaller range
of reds. A wider arc expands the vector
to include more yellow and magenta
hues (see next illustration).

Zero degree line (location of pure red
on the color wheel)
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Examples of Varying Hue Ranges

These three examples show three versions of a Red vector with different hue ranges (or
widths). The top row shows the color wheel display for each version of the vector. The
bottom row shows the color range defined by that vector with the rest of the color wheel
shown as grayscale.

Hue width 30° (default) Hue width 10° Hue width 60°

cele

Saturation Range Example Using Custom Vector

This custom vector (#3 in the Selected
Vectors panel) has a default saturation
value of 35 and a default saturation
width of 40. Its saturation range
therefore excludes very low saturation
levels and a wide band of high
saturation levels. Reducing the
saturation width reduces the range of
color intensity included in the vector
even further. Increasing the saturation
width expands the range of color
intensity (see next illustration).
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Examples of Varying Saturation Ranges

These three examples show three versions of a custom vector with different saturation
ranges (or widths). The top row shows the color wheel display for each version of the

vector. The bottom row shows the color range defined by that vector with the rest of the
color wheel shown as grayscale.

Saturation width 40 (default) Saturation width 15 Saturation width 80

Customizing a Vector Display

E
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You can customize which vectors appear in the color wheels by setting options in the
Features tab of the Correction Mode Settings dialog box.

To customize a vector display:

1. Open the Correction Mode Settings dialog box by doing one of the following:

» In the Project window, click the Settings tab, and then double-click Correction in
the Settings scroll list.

» In the Color Correction tool, click the Correction Mode Settings button.

The Correction Mode Settings dialog box opens.



2. Click the Features tab.
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Features tab

Secondary Vectors menu

3. Click the Secondary Vectors menu, and then select an option. The following table

4,

describes the options available.

Click OK.

Secondary Color Correction Vector Display Options

Option

Description

Display in Color Wheels

Show All

Show Standard

Shows all twelve vectors in the color wheels of the

Secondary tab.

Shows the six standard vectors (Green, Yellow, Red,
Magenta, Blue, Cyan) in the color wheels of the
Secondary tab. This setting also shows custom vectors
that are enabled. This is the default setting.

239



Chapter 5 Performing Color Corrections

Secondary Color Correction Vector Display Options (Continued)

Option

Description Display in Color Wheels

Show Custom

Show Enabled

Shows the six custom (elliptical) vectors in the color
wheels of the Secondary tab. This setting also shows
standard vectors that are enabled.

Shows only those vectors that are currently enabled in
the Selected Vectors panel. The illustration shows the
Red standard vector and one custom vector.

Understanding the Selected Vectors Panel
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The Selected Vectors panel provides a central location in the Secondary group tab for
controls that allow you to select or enable individual vectors.

In addition, the Selected Vectors panel includes the following check boxes:

Invert Last Vector. Checking this box inverts the effect of the enabled vector furthest to
the right in the Selected Vectors panel. When you invert a vector, you apply the
adjustment to all parts of the image except those parts defined by the vector. For more
information, see “Inverting a Vector” on page 254.

Isolate. Checking this box isolates the selected vector in the image by displaying all
other parts of the image as grayscale.

You can use Isolate both as a preview feature and as an effect in its own right. While you
are making a secondary color correction, you can select Isolate to see the extent of a
vector more clearly. If you leave Isolate selected as part of a finished secondary color
correction, you create a special secondary color correction that isolates one color range
while displaying the rest of the image as grayscale. For more information, see “Isolating
the Selected Vector” on page 250.
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The following illustration shows the Selected Vectors panel with the Green vector selected.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version available from the Online Library for your application.

Standard vectors Custom vectors

Vector names

| N B Color swatches

7 T T P P T £ P e e e

Enable buttons

Isolate check box

Invert Last Vector check box

The color swatches for each vector in the Selected Vectors panel update in real time to
provide a visual indication of the defined color range for the vector. The following
illustrations show this behavior for the Red vector color swatch.

i Default Red vector color swatch i Red vector color swatch after hue is adjusted to +20°

Selecting Vectors

You must select a vector to make an adjustment. Any adjustments that you make using
controls in the Secondary tab are made to the currently selected vector.

To select a vector, do one of the following:
P Click the center point of the vector in the color wheel.
P Click the vector’s color swatch in the Selected Vectors panel.
For more information, see “Understanding the Selected Vectors Panel” on page 240.
P Use the syringe to define an input vector.

The system automatically selects, enables, and adjusts the appropriate vector based on
the colors you sample. For more information, see “Using the Color Selection Buttons”
on page 247.

A white box appears around the color swatch for the selected vector in the Selected Vectors
panel, and the selected vector appears highlighted in the color wheels.
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Enabling and Disabling Vectors

You can enable and disable vectors in any combination using Enable buttons. Enable buttons
for vectors function in the same way as Enable buttons elsewhere in the Color Correction
tool. For more information on Enable buttons, see “Working with the Enable Buttons” on
page 145.

To enable or disable a vector, do one of the following:
» Click the vector’s Enable button in the Selected Vectors panel.
»  Use the syringe to define an input vector.

The system automatically selects, enables, and adjusts the appropriate vector based on
the colors you sample. For more information, see “Using the Color Selection Buttons”
on page 247.

Enable buttons are pink when the associated vector is enabled and gray when the associated
vector is disabled.

Resetting Vectors

You can use a vector’s Enable button to quickly reset the vector to its default values. For
more information on Enable buttons, see “Working with the Enable Buttons” on page 145.

To reset a vector:
»  Alt+click the vector’s Enable button in the Selected Vectors panel.

The system resets the vector to its predefined values.

Adjusting Input Vector Values

242

Once you have selected a predefined vector as a starting point for a secondary correction,
you adjust that vector so that it represents as accurately as possible the specific color range
that you want to correct.

Secondary color correction allows you to make adjustments using several different kinds of
controls. You can also use the Isolate check box to select a preview display that makes it
easy to see what parts of an image are included in a vector.
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To adjust an input vector:
1. Select the vector you want to adjust.
For more information, see “Selecting Vectors” on page 241.
2. Adjust the vector by doing one or more of the following:

P  Manipulate the vector directly in the Input color wheel. “Repositioning Vectors in
the Color Wheel” on page 243.

P Adjust the input sliders. For more information, see “Using the Input Vector Sliders”
on page 243.

P Select colors from the image using the syringe and eyedroppers. For more
information, see “Using the Color Selection Buttons” on page 247.

You might want to click Lock Vectors at some stage in the adjustment process to prevent
the output image from exhibiting premature color changes while you fine-tune your
input vector. For more information, see “Locking Vectors While Adjusting an Input
Vector” on page 245.

3. As you make your adjustments, use the Isolate feature to verify what parts of the image
are currently defined by the vector. For more information, see “Isolating the Selected
Vector” on page 250.

Repositioning Vectors in the Color Wheel

You can reposition a vector in the color wheel by dragging its center point. This changes the
hue and saturation values of the vector.
To reposition a vector in a color wheel:
1. Move the pointer over the center point of the vector.
The pointer changes to a hand.

2. Click the mouse button, and drag the center point of the vector to a new location in the
color wheel.

As you drag the center point around in the color wheel, the Hue and Saturation sliders
update to show the current hue and saturation values, and the vector’s color swatch
updates in the Selected Vectors panel to show the currently selected color.

3. Release the mouse button when you are satisfied with the hue and saturation values.

Using the Input Vector Sliders

You can change the values of a vector by adjusting the Input Vector sliders. These sliders
work in exactly the same way as other sliders in the Color Correction tool, for example,
those in the HSL group. For more information, see “Using the HSL Sliders” on page 184.
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The following table describes the individual sliders available for input vectors.

Input Vector Sliders

Control

Description

Hue

Saturation

Hue Width

Saturation Minimum
(standard vectors)

Saturation Width
(custom vectors)

Softness

Shifts the hue value for the center point of the vector around the color wheel. On the
default Degree unit scale, 0 (the center point of the slider) represents red and —180 or
180 (the end points of the slider) represents cyan.

Shifts the saturation value for the center point of the vector between the center and the
outer edge of the color wheel. On the default Percent unit scale, 0 represents no
saturation (the center of the wheel) and 100 represents full saturation (the outer edge of
the wheel).

Sets the hue range of the vector. On the default Degree unit scale, values represent the
number of degrees of arc that the vector covers on the color wheel, with the Hue value
being the midpoint of the arc. For standard vectors, values range from 0 to 180; for
custom vectors, values range from 0 to 100.

For standard vectors, sets the minimum saturation value for the vector. Pixels in the
image below the saturation minimum are not included in the vector even if their hue
value is within the vector’s hue width.

For custom vectors, sets the saturation range of the vector. On the default Percent scale,
values represent the saturation range as a percentage of the maximum saturation width.
For example, a vector with Saturation Width 40 extends across 40% of the full saturation
range. Pixels in the image outside this saturation range are not included in the vector
even if their hue value is within the vector’s hue width.

Sets a softness value for the vector. Values range from —255 to 255.

Positive values blend the corrected color into areas of the image beyond the limits of the
defined input vector. The higher the value, the further into adjacent color values the
blend extends.

Negative values blend the uncorrected color into parts of the area defined by the input
vector. The higher the value, the more of the uncorrected color is retained in the input
vector area.

When Softness is set to 0, the correction has a hard edge at the limit of the defined input
vector. The default Softness setting of 30 creates a softened edge without extending the
corrected color significantly outside the defined input vector.

For illustrations of the effect of various Softness settings, see “Examples of Softness
Adjustments” on page 246.
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Locking Vectors While Adjusting an Input Vector

You can lock the Hue and Saturation controls for Input and Output vectors together. When
the vectors are locked, any changes you make to the Input Hue and Saturation values (either
by adjusting the sliders or by dragging the vector in the vector wheel display) are matched
by equivalent changes to the Output Hue and Saturation values.

To lock Input and Output Hue and Saturation controls together:
p  Click Lock Vectors.

Lock Vectors button

If you lock the Input and Output vectors together while you are fine-tuning your Input vector
(before you make an Output vector adjustment), you can avoid the impression that you are
correcting your image prematurely (and inaccurately). The image that you see in the monitor
does not show any false color changes while you are manipulating the Input vector. This is
especially useful if you are demonstrating corrections for a client, who might be confused by
seeing inaccurate color changes while you are setting up an input vector.

A typical workflow for making a secondary color correction using Lock Vectors might
include the following steps:
1. Define an initial color range for the Input vector, for example by using the Syringe.

2. Turn on Lock Vectors, and fine-tune the hue and saturation values for the Input vector,
for example by dragging the Input Hue and Saturation sliders.

Because the input and output vectors are locked together, these adjustments do not
change the output colors in the monitor.

3. Turn off Lock Vectors, and adjust the Output vector until the color range you have
defined changes to the finished color you want.

4. (Option) If you need to fine-tune the whole correction further but do not want to change
the color shift that you have established from Input to Output values, turn on Lock
Vectors and shift the vectors slightly by dragging in the vector wheel display.
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Examples of Softness Adjustments

Softness is an important control for fine-tuning the effect of a secondary correction on an
image. You can control the appearance of the transitional areas between a corrected part of
the image and the rest of the image. You can also quickly compensate for inaccuracies in the
input vector definition by expanding or contracting the color range over which the correction
has an effect.

The following illustrations show the effect of a range of Softness adjustments on a test
image.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version of this document, available from the Online Library for
your application.

The original image is a radial gradient from green to red. The basic adjustment uses the default Green
input vector and an output vector that shifts the Hue by 180 degrees on the color wheel. The effect of
this adjustment is to change the strongly green area near the center of the image to magenta.

Original image Adjusted image: Softness 0
The following illustrations show the effect of a variety of Softness adjustments on the correction. The

illustrations show the image as it appears with Preview Selected in the Secondary tab so that the
extent of the adjustment is easy to see.

Softness 0 The correction is defined by a hard Softness +30 This is the default Softness setting. The
edge, and no blended color appears outside correction color blends slightly into areas of the image
the area defined by the input vector. with color values adjacent to the defined color range.

The outside edge appears green because the
uncorrected color is dominant in the blend at the edge
of the area affected by the correction.
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Softness +128 The correction now expands Softness +255 With Softness at its maximum

into more of the surrounding color, and the positive value, the correction now affects an area
gradual blend from magenta back to green is substantially larger than the area defined when
more easily visible. Softness is set to 0. However, the area that is 100%

corrected color (magenta) remains the same.

Softness —128 When Softness values are Softness —255 With Softness at its maximum
negative, the blended area is within the limits negative value, almost all of the original input

of the original input vector. Only a small area in vector area is affected by a blend of uncorrected
the center is now 100% magenta. and corrected color.

Using the Color Selection Buttons

You can use the Color Selection buttons to select, enable, and adjust a vector by sampling
colors from an image. The system provides three distinct sampling tools that allow you to
define an initial color vector and then fine-tune the vector by adding to or subtracting from
the defined color range.

You can use the Color Selection buttons together with the Color Match control to quickly
perform a complete secondary color correction. For more information, see “Using the Color
Match Control for Secondary Corrections” on page 252.

You can also use the Color Selection buttons to refine the definition of an existing vector by
sampling colors within or adjacent to that vector.

The following illustration shows the Color Selection buttons.
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Add to Selection button
Syringe button Subtract from Selection button

Defining a Vector with the Syringe

To define a vector using the syringe:
1. Click the Syringe button to highlight it.
2. Move the pointer over the image in the active monitor.
The pointer changes to a syringe.
3. Move the tip of the syringe over the area of color you want to sample in the image.

4. Press and hold the mouse button, and drag the tip of the syringe over the area of color
you want to sample.

The system samples every color value that the tip of the syringe passes over. The input
color swatch in the Color Match control updates as you drag the syringe to show the
most recently sampled color.

Try to cover the area that you want to sample as fully as possible, but take care not to stray
outside that area. Remember that you can make further refinements to the vector after
completing the initial selection.

5. When you have finished sampling, release the mouse button.
The system does the following:
- Selects and enables the closest vector to the range of colors you have sampled.

- Adjusts the Input Vector values for the vector so that it includes the full range of
colors that you sampled with the syringe.

- Sets the Output Vector values to match the Input Vector values.

- Automatically selects the Isolate check box so that the vector you have defined is
visible in the monitor. For more information, see “Isolating the Selected Vector” on
page 250.

6. (Option) Refine the vector definition.
For more information, see “Refining a Vector Definition with the Add to Selection and

Subtract from Selection Buttons™ on page 249.

The Syringe button remains selected until you explicitly turn it off by clicking it or by
clicking one of the other Color Selection buttons. This means that you can perform repeated
operations with the syringe without having to reactivate it for each operation.
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Refining a Vector Definition with the Add to Selection and
Subtract from Selection Buttons

EE

You can refine the definition of a vector by adding or subtracting colors that you sample
using the Add to Selection and Subtract from Selection buttons. You can use these buttons to
refine any vector, regardless of how you originally defined the vector.

To refine a vector using the Add to Selection and Subtract from Selection buttons:
1. Select the vector that you want to refine.
2. Click the Add to Selection or Subtract from Selection button to highlight it.
3. Move the pointer over the image in the monitor.
The pointer changes to an eyedropper.

4. Move the tip of the eyedropper over the color you want to add to or subtract from the
vector, and then click the mouse button.

The system updates the vector to include or exclude the color you have selected.

The Add to Selection or Subtract from Selection button remains selected until you explicitly
deselect it by clicking it or by clicking one of the other Color Selection buttons. This means
that you can perform repeated operations with the eyedropper without having to reselect it
for each operation.

The Undo command works with eyedropper color selections. If you select too much color
with the Add to Selection eyedropper or subtract too much with the Subtract from Selection
eyedropper, select Edit > Undo or press Ctrl+Z to have the system delete the effect of that
selection on the vector.

When the system calculates revised vector areas based on selections made with the Add to
Selection and Subtract from Selection eyedroppers, it is constrained by the geometric limits
of the vector (wedge-shape for standard vectors and ellipse for custom vectors). As a result,
you might include or exclude more colors than you expect. In general, the Color Selection
buttons are excellent tools for quickly adjusting a vector to approximately the area you
require. However, you might still need to fine-tune the vector using the sliders to achieve a
precise match with the color range you want to correct.
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Isolating the Selected Vector

250

You can isolate the selected vector in an image. The system displays those parts of the image
that fall within the selected vector in color, with the rest of the image in grayscale. This
makes it easy to see which parts of an image are included in a selected vector while you are
making corrections.

You can choose to use Isolate only as a preview feature that allows you to see the extent of
vectors clearly. In this case, you must deselect Isolate when you have finished making the
correction. Alternatively, you can use Isolate as a special Color Correction effect that
isolates parts of an image in color while displaying the rest of the image in grayscale. In this
case, you leave Isolate selected when you have finished making the correction.
To isolate the selected vector:

1. Make sure that the position indicator is in the segment that you want to isolate.

2. Click Isolate in the Selected Vectors panel of the Secondary tab.

The active monitor changes to isolate the selected vector.

3. Make input and output adjustments to the vector until you are satisfied with the look of
the correction.

4. Do one of the following:
» To leave the areas of the image outside the vector grayscale, leave Isolate selected.
» To return the image to a full-color display, click the Isolate check box to deselect it.
Isolate shows the effect of any output adjustment you have made to the vector. If you have

made output adjustments and want to see a preview that shows only the input color range,
disable the Output Vector Hue and Saturation sliders by clicking their Enable buttons.

The following illustration shows a typical image and its appearance when Isolate is selected.
For more illustrated examples of the effect of isolating a vector, see “Examples of Inverted
and Isolated Images” on page 121.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version of this document available from the Online Library for your
application.
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Original image in full color.

Corrected image with Isolate selected. The
preview shows the effect of an adjustment that
changes the pale blue robe to match the green
color of the shoes in the top left corner of the
original image. Areas of the image not affected
by the correction display as grayscale. The
preview allows you to see which additional
areas of the image are affected by the
adjustment and confirm which areas are not —
for example, the blue jacket in the bottom right.

Corrected image in full color. The correction has
completely changed the color of the robe. A few
other small areas of the image have also been
changed by the correction, but most of the
image retains its original color.

Adjusting Output Vector Values

Once you have an input vector defined correctly, the final step in the secondary color
correction process is to adjust the output values for the vector to change the color
characteristics.

Because you have already defined the extent of the vector using input adjustments, only hue,
saturation and luminance values are adjustable for output. To change the color
characteristics for that vector, you only need to define a new combination of hue, saturation,
and luminance values.
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You might make an output vector adjustment that causes the saturation levels in an image to
exceed the RGB Gamut limits that you have set in the Safe Color Settings dialog box.
Depending on the current settings in the Safe Color Settings dialog box, the system might
ignore the excess value or display a warning. For more information, see “Safe Colors” on
page 301.

To adjust output vector values:
1. Select the vector you want to adjust.

2. Adjust the output vector values by doing one of the following:

» Manipulate the vector directly in the Output color wheel. For more information, see
“Repositioning Vectors in the Color Wheel” on page 243.

» Adjust the output sliders.

The Output Vector Hue and Saturation sliders are identical to their Input Vector
equivalents. For more information, see “Using the Input Vector Sliders” on
page 243.

The Output Vector Luminance slider changes the luminance value for the final
color. Values for the Luminance slider range from —10 to +10, where —10 reduces
the luminance by 10% of the full black-to-white luminance range, and +10
increases the luminance by 10% of the full black-to-white luminance range.

As you adjust the output values, the active monitor updates to show the effect of the
correction on your image. If Isolate is selected, the monitor shows the corrected areas of
the image in color and the unaffected areas of the image as grayscale.

3. Do one of the following:

» To have the areas of the image outside the vector continue to display as grayscale,
make sure that Isolate is selected.

» To have the image appear as a full-color display, make sure that Isolate is
deselected.

Using the Color Match Control for Secondary Corrections
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You can use the Color Match control to make secondary color corrections based on color
values that you sample from images or select from the Windows Color dialog box or the

Macintosh Color Picker. If necessary, you can make further refinements to the input and

output vectors after the color match to achieve the precise correction that you want.

You can use the Color Match control together with the syringe to perform a secondary color
correction based on a range of sampled color values. In most circumstances, this is the
preferred method for achieving a good correction when the hue and saturation values of the
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area you want to correct are somewhat varied. This method also shows the selected vector
before you complete the match, making it easier to verify that you have a well-defined input
vector.

You can also use the Color Match control to make a secondary color correction with the
same basic methods that you use to make Color Match corrections in the other Color
Correction tabs. In this case, the system applies the match to a predefined range of colors
centered on the single color value that you sample, and you cannot see the input vector until
the color match is completed. Though generally less precise and less controllable than the
first method, this technique might produce acceptable results quickly if you need to correct
an area of uniform color.

Making a Secondary Correction with the Color Match Control and the Syringe

To make a secondary color correction using the Color Match control and the syringe:

1.

Select, enable, and define the input vector using the syringe.

For more information, see “Defining a Vector with the Syringe” on page 248.

As part of the vector definition process, the system automatically selects Isolate.

2.

Select the output color using the standard Color Match eyedropper. For more
information, see “Making a Correction with the Color Match Control” on page 174.

. Click the Match Type button, and select a Match Type to determine the exact nature of

the match the system makes.

For more information on the options available in the Secondary group, see “Selecting
Match Type Options” on page 175.

Click the Match Color button to make the correction.

The system adjusts the output values for that vector, deselects Isolate, and displays the
corrected image in the monitor that contains the current segment.

. (Option) Make further adjustments to the vectors using the Input Vector and Output

Vector sliders until you are satisfied with the correction.

Making a Secondary Color Correction with the Color Match Control Only

To make a secondary color correction with the Color Match control only:

1.

2.

Select the input color using the standard Color Match eyedropper. For more
information, see “Making a Correction with the Color Match Control” on page 174.

Select the output color using the standard Color Match eyedropper.
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3. Click the Match Type button, and select a Match Type to determine the exact nature of
the match the system makes.

For more information on the match types available in the Secondary group, see
“Selecting Match Type Options” on page 175.

4. Click the Match Color button to make the correction.

The system selects and enables a vector, adjusts the input and output values for that
vector based on the sampled colors, and displays the corrected image in the monitor that
contains the current segment.

5. (Option) Make further adjustments to the vectors using the Input Vector and Output
Vector sliders until you are satisfied with the correction.

Inverting a Vector

254

You can invert a vector to apply a correction to every part of the image except for the area
defined by the vector. The most common use of this technique is to isolate an object in its
original color while altering the color of every other part of the image. For example, you
might want to partially desaturate most of the image while retaining full color in the areas
defined by the vector.

To invert a vector:
1. Select the vector, and make input adjustments to it using standard methods.
2. Click Invert Last Vector in the Selected Vectors panel.

The system inverts the vector, selecting all parts of the image not defined within the
vector. If you are working with Isolate selected, the display updates to show the area
defined by the vector as grayscale and the rest of the image in color.

3. Adjust the output hue and saturation values for the vector.

4. Make sure that the Isolate check box is selected or deselected as necessary to produce
the final effect that you want. For more information, see “Isolating the Selected Vector”
on page 250.

Invert Last Vector can invert only one vector in each correction, and the vector that is
inverted is always the enabled vector farthest to the right in the Selected Vectors panel. In
the common case of using Invert Last Vector to isolate one object in color, the vector that
you invert is likely to be the only vector you need to adjust. If you do use Invert Last Vector in
a segment where you make adjustments to multiple vectors, make sure that the inversion
applies to the vector you want by making that vector the enabled vector farthest to the right
in the Selected Vectors panel.
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Examples of Inverted and Isolated Images

The following illustrations show the effects of Isolate and Invert Last Vector on a typical
image. Using these two features alone or in combination, you can achieve a wide range of
special Color Correction effects in which one area of the image stands out from the rest.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version available from the Online Library for your application.

Examples of Isolate and Invert Last Vector

Original Image

Image with Isolate selected. The Image with Isolate selected and a
selected vector displays in color. correction made to the selected
vector.

Image with Invert Last Vector Image with both Isolate and Invert
selected and a correction made to Last Vector selected. The selected
all parts of the image other than vector displays as grayscale while
the selected vector. the rest of the image displays

in color.
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Understanding How Multiple Vectors Interact

If you make corrections to more than one vector in the Secondary group, those corrections
are applied cumulatively to the image when it plays back. The order of application moves
from left to right across the Selected Vectors panel.

If the color ranges of vectors overlap, the final result in the image is the cumulative result of
all the corrections for the overlapping vectors. For example, if you use the Green vector to
change a green object in the image to yellow, and then adjust the Yellow vector so yellow
objects become red, your original green object is red in the final image.

Working with the Waveform Monitors and the
Vectorscope Monitor

256

The waveform and vectorscope commands in the Source menu configure the monitor to
graphically display color information about your sequence. The system displays the
information for the currently active monitor.

A waveform indicates the brightness of the image. The higher the green trace goes on the
scale, the brighter that part of the image is.

Waveform monitors display all the information for the current field or frame overlaid in the
waveform. That is, each left-to-right trace in the waveform represents one scan line. If you
see a bright object on the left side of the image, you will see its peak on the left side of the
waveform. A bright object in the top left of the image produces the same waveform if it is in
the bottom left of the image.
To display a Waveform monitor or a Vectorscope monitor:

1. Click in the monitor for which you want to display color information.

The monitor becomes the active monitor.

2. In one of the other monitors, click the Source menu and select a waveform or
vectorscope command.

The monitor displays the selected waveform or vectorscope information.
For more information, see “Using the Waveform and Vectorscope Information” on page 264.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version of this document available from the Online Library for your
application.

The following table describes each command.
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Waveform and Vectorscope Commands

Command Description

Quad Display Displays the following waveform and vectorscope information in a single monitor (clockwise
from the top left corner):

*  YC Waveform

*  Vectorscope
* RGB Histogram
* RGB Parade

For information on each display, see its individual entry in this table.
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Waveform and Vectorscope Commands (Continued)

Command

Description

RGB Histogram

258

Displays a graph showing which RGB values in the image appear most frequently. The
darkest values of red, green, and blue in the image appear as peaks on the left of the graph,
and the brightest values appear as peaks on the right. The height of a peak indicates the
number of pixels of that value. The width of a peak indicates how many pixels in the image
have similar values.

For example, if the blue histogram has many tall peaks at the left side, it shows that the image
has many pixels with low blue values. However, those same pixels might appear in the image
as many different colors, since they might have any red and green values.

For information on using the RGB Histogram display, see “Using the Waveform and
Vectorscope Information” on page 264.
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Waveform and Vectorscope Commands (Continued)

Command

Description

RGB Parade

Displays waveforms of the RGB (red, green, and blue) components side by side. Since video
cameras capture in RGB, this display helps to show camera problems. It is also used for
general reference to the three primary colors.

RGB signals are used together to create all other colors. A white area in the image appears as
peaks in all three waveforms at the same relative location. A high red level does not mean a
red image, unless the green and blue levels are low.

RGB Parade incorporates any safe color limits you have set. The system displays RGB
values in white when the values fall outside the RGB Gamut limits. For more information on
color limits, see “Safe Color Limits with Waveform and Vectorscope Information” on

page 308.

For information on using the RGB Parade display, see “Using the Waveform and Vectorscope
Information” on page 264.
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Waveform and Vectorscope Commands (Continued)

Command

Description

Vectorscope

260

Displays chroma information without luma information as a circular graph where the center
represents no chroma and chroma increases as the trace moves away from the center.

All white, black, and gray parts of the image appear at the center. Areas with more saturation
appear further out from the center. Images with an overall color cast produce a vectorscope
trace that is generally off-center. Colors created by various positive and negative
combinations of Cb and Cr appear around the circle.

Small squares mark the location of standard color bar vectors. Inner squares represent the
proper values for 75% color bars, and outer squares represent 100% color bars.

100% color bar vector

75% color bar vector

For information on using the Vectorscope monitor, see “Using the Waveform and
Vectorscope Information” on page 264.
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Waveform and Vectorscope Commands (Continued)

Command

Description

Y Waveform

Displays a Waveform monitor with luma information. Luma is the brightness of an image
without regard to color.

The scale on the left is a digital level scale using a 256-step (8-bit) range; 16 is the level for
black, and 235 is the level for white.

The scale on the right shows the amount of white in the image as a percentage; 0% represents
black, and 100% represents white.

Parts of an image can have values outside the 0% to 100% range. The digital video standard
allows for headroom and footroom so that you can correct a mistake in level in the
postproduction process. The minimum is digital 0 or —8%, and the maximum is digital 255 or
108%.

Some external software or hardware processing can clip a signal that is outside the
0% to 100% range.

Y Waveform incorporates any safe color limits you have set. The system displays Luma
values in white when the values fall outside the Luminance limits. For more information on
color limits, see “Safe Color Limits with Waveform and Vectorscope Information” on

page 308.

For information on using the Y Waveform display, see “Using the Waveform and
Vectorscope Information” on page 264.
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Waveform and Vectorscope Commands (Continued)

Command

Description

YC Waveform

262

Displays composite video information. Composite video has the C (chroma) waveform,
which is derived from Cb and Cr components, riding on the Y (luma) waveform. The Y trace
is green, and the C waveform is a cyan (blue-green) envelope around the green trace. Because
the C signal of composite video has equal positive and negative energy, the cyan bands are at
an equal distance above (Y+C) and below (Y-C) the green waveform.

The left side of the YC Waveform display shows a scale marked either for NTSC or PAL,
depending on your project.

NTSC black is 7.5 IRE (except in Japan), and NTSC white is 100 IRE.
PAL black is 0 millivolts (mV), and PAL white is 700 mV.

This tool does not display actual composite video output. It is an accurate software
model of a perfect encoder. If you convert your material to composite form, you see
similar results.

The scale on the right shows the amount of white in the image as a percentage; 0% represents
black, and 100% represents white.

Composite video values above or below these limits are indicated by a red edge on the
display. In addition, YC Waveform incorporates any safe color limits you have set. The
system displays Composite values in yellow and Luma values in white when the values fall
outside the safe color limits. For more information on color limits, see “Safe Color Limits
with Waveform and Vectorscope Information” on page 308.

For information on using the YC Waveform display, see “Using the Waveform and
Vectorscope Information” on page 264.
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Waveform and Vectorscope Commands (Continued)

Command

Description

YCbCr Histogram

Displays a graph showing which YCbCr values in the image appear most frequently. The
height of a peak indicates the number of pixels of that value. The width of a peak indicates
how many pixels in the image have similar values.

The upper bar of the histogram represents Y values. The darkest values are on the left and the
brightest values on the right. An image with good contrast shows a good spread of values
from darkest to lightest.

An image with a great variety of colors appears as a wide spread in the Cb and Cr histograms.
If they extend too far from the center, there is too much saturation.

For information on using the YCbCr Histogram display, see “Using the Waveform and
Vectorscope Information” on page 264.
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Waveform and Vectorscope Commands (Continued)

Command

Description

YCbCr Parade

Displays waveforms of Y, Cb, and Cr side by side. The Y in YCbCr is the same luma shown
in the Y Waveform display. In this display, the Y waveform is shown in white on the left side.

Cb and Cr are color difference signals that represent just the color information of a signal
with the luma removed. Cb and Cr values can be negative or positive. For images that are
black and white, Cb and Cr are zero. You would see a flat white line halfway up the two right
bands. As they increase, Cb and Cr are shown in the colors representing those vectors. The
more the values increase, the more saturated the colors used to display them. Positive Cb is

represented by blue hues, and negative Cb is represented by yellow hues. Positive Cr is
represented by red hues, and negative Cr is represented by cyan hues.

If the Cb or Cr waveforms are not centered, the cause might be a color cast to the image.

For information on using the YCbCr Parade display, see “Using the Waveform and
Vectorscope Information” on page 264.

Using the Waveform and Vectorscope Information

264

Some of the ways you can use the waveform and vectorscope information include to:

Align levels of sources using test patterns. If you capture some color bars from your

source footage, you can measure them and set the color correction needed to restore the

video levels to the way the program was created. Import the Test Patterns from the
SupportingFiles folder of your Avid system to become familiar with the proper
Waveform, Parade, and Vectorscope readings. Histograms are not as useful on test

patterns. For example, with 75% color bars, the Y+C envelope for the yellow and cyan

bars should match the 100% white level.
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Identify problems with source video. Typical problems include:

Color levels too high or too low. For more information, see “Safe Color Limits with
Waveform and Vectorscope Information” on page 308.

Missing channels in YCbCr or RGB, indicating an equipment problem or a
damaged cable.

Clipping in YCbCr, RGB, or YC channels. The trace appears chopped at a certain
level. If this appears at a level below the maximum, it occurred before the footage
was captured.

Images imported at the wrong level settings. If you import images at RGB levels of
0-255 that you should have imported at 601 levels of 16235, the images lack
contrast. If the images have too much contrast, with levels exceeding the 0% and
100% markings, the opposite is likely.

With experience, you can learn how to read not only test patterns but actual content on the
instruments. This facility allows you to:

Match scene brightness across a cut in the Y Waveform histogram.

Put your flesh tones along a certain hue axis in the Vectorscope monitor.

Watch the spread of the Y Waveform histogram to identify a good contrast range
without clipping.

Watch the top of the YC Waveform histogram to make sure you do not have too much
bright chroma.

Fix white balance and black balance problems by identifying and centering those
vectorscope traces.

You can also use the information in the Waveform and Vectorscope monitors to monitor safe
color limits. For more information, see “Safe Color Limits with Waveform and Vectorscope
Information” on page 308.

Waveform and vectorscope monitors show you the values of only one frame or field at a time.
Move around in the clip to find the most extreme levels or those most representative of the

scene.
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Using the Color Correction Effect

In addition to color corrections made using relationships, you can also apply color
corrections using the Color Correction effect.

Some types of corrections can only be made using the Color Correction effect, and it is
important to understand the situations that call for a Color Correction effect rather than a
relationship color correction. For more information, see “When to Use the Color Correction
Effect” on page 266.

You can apply the Color Correction effect in two different ways:

*  You can apply it from the Color Correction tool by selecting CC Effect as the correction
type, as described in “Applying a Color Correction Effect from the Color Correction
Tool” on page 268.

*  You can apply it from the Effect Palette, in the same way as any other effect. When you
apply the Color Correction effect from the Effect Palette, your application makes the
automatic color corrections set in the AutoCorrect tab of the Correction Mode Settings
dialog box. (You can then make further color adjustments in the Color Correction tool if
you need to do so.) For more information, see “Correcting Color Automatically Using
the Color Correction Effect” in the Help.

Once you have applied a Color Correction effect, you can work with it in much the same
way as any other effect. For example, you can save it as an effect template, or delete it using
standard methods for deleting effects.

When to Use the Color Correction Effect

You need to use a Color Correction effect rather than a relationship color correction in the
following situations:

*  When you want to apply multiple automatic corrections in a single operation.

In this case, you must apply the Color Correction effect from the Effect Palette, as
described in “Correcting Color Automatically Using the Color Correction Effect” in
the Help.
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*  When you want to apply a color correction in combination with certain other effects.

For example, if you have two layers of video with a Picture-in-Picture applied to the top
layer, you cannot color correct the entire video composite (foreground and background
together) using a relationship correction. However, if you nest a Color Correction effect
on top of the Picture-in-Picture, you can correct foreground and background at the same
time. (This behavior is a result of the fact that relationship color corrections are
processed before most other effects.) For more information, see “Understanding
Relationship Color Corrections” on page 137.

Original setup before color corrections

Relationship correction on bottom
track — only bottom track has
chroma inverted

Relationship correction on top track
— only top track has chroma inverted

Color Correction effect nested on top
of Picture-in-Picture — entire
composite has chroma inverted
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*  When you want to apply a color correction to filler.

You cannot apply relationship color corrections to filler. A common example of the
use of a color correction on filler is when you add a new video track above all other
tracks and then add a Color Correction effect to that track. This provides a way to
apply an overall color correction that affects every layer beneath it (for example,
adding a little brightness to an entire sequence as a final color correction step). The
Program Track relationship color correction, in contrast, affects the whole of any
one track in a sequence.

Color Correction effect applied to filler
on top track, above multiple other tracks.

Applying a Color Correction Effect from the Color Correction Tool
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You can apply a Color Correction effect in the Color Correction tool, and then make any
combination of color correction adjustments that are available in the Color Correction tool.

When you apply a Color Correction effect from the Color Correction tool, your application
does not apply the automatic corrections set in the AutoCorrect tab of the Correction Mode
Settings dialog box.

To apply a Color Correction effect from the Color Correction tool:

1. If you have not already done so, move the position indicator to the segment you want to
correct.

2. Click the Correction Type button and select CCEffect.
3. Make the color adjustments you want in one or more of the Color Correction tool’s tabs.

Once you make an adjustment, the Color Correction effect appears on the segment.
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Managing Color-Corrected Sequences

The Color Correction tool includes menu commands that allow you to manage sequences
once they have color correction applied to them. You can update a sequence to apply existing
color corrections to newly added segments, merge different versions of a color-corrected
sequence, convert color corrections in a sequence to segment-only relationships, and remove
groups of corrections from a sequence.

You can control the extent of the changes for all these operations. You can also choose to
make the changes on a new copy of the sequence so that the unchanged sequence is still
available to you.

This chapter describes how to manage sequences with color corrections and contains the
following main sections:

»  Updating Color-Corrected Sequences
*  Merging Color-Corrected Sequences
» Flattening Color-Corrected Sequences

* Removing Color Corrections

For information on how color-corrected sequences conform between Symphony Nitris and
certain other Avid editing applications, see “Conforming Sequences with Color Correction”
on page 40.

Updating Color-Corrected Sequences

The Update Correction command allows you to make color corrections to a sequence and
then to edit additional material into the sequence without having to repeat much of your
color correction work. When you return to Color Correction mode, you can instruct the
Symphony system to apply existing color corrections to the new segments, based on their
relationship to the existing material. The system updates any color corrections based on
Source Tape, Clip Name, Master Clip, or Sub Clip relationships, or based on

Program Track relationships.
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For example, you are working with a sequence that contains several segments from the same
source tape. When you first perform a Source color correction pass, you correct these
segments simultaneously using the Source Tape relationship. Later, you edit new segments
from the same source tape into the sequence. You can now go back into Color Correction
mode and use the Update Correction command to apply the color correction from the
original segments to the new segments automatically.

The following illustrations show the stages of this process for a simple sequence.

Before Segment A corrected using Segment B corrected using
Source Tape relationship Source Segment relationship

e P Y -

After new edit Segment C material is from the
same source tape as segment A.

B P S e e

After update Color correction is applied to
segment C, based on its Source
Tape relationship with segment A.

e (s A fweweean B o Jumewaw ©

To update a color-corrected sequence:
1. In Source/Record mode, edit new material into a previously color-corrected sequence.

- 2. Click the Color Correction Mode button at the bottom of the Timeline to enter Color
Correction mode.

3. Right-click in the Color Correction tool, and select Update Correction.
The Update Color Correction dialog box opens.
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_Corre:tion =l
Saurce Program
ﬁ Tape n Track
o2 Clip Mame: = Segment
o, Master Clip
£, Sub Clip
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_ Create New Sequence 1 Ol iU Cancel

4. Select the Source and Program relationships you want the system to use when deciding
which segments to update.

By default, all available relationships are selected.

5. Select Create New Sequence if you want the system to create a new copy of the
sequence and update that copy.

If you deselect Create New Sequence, the system updates the existing version of the
sequence. Avid recommends that you create a new sequence when updating. You then retain
the previous version as a backup. If you update an existing version of a sequence and want to
return to the previous version, select Edit > Undo.

6. Click OK.

The system updates the sequence and adds color correction to the appropriate new
segments. If you have selected Create New Sequence, a new sequence appears in the bin
with the title /OldTitle].Copy 1. You can rename the sequence to indicate more clearly
that it is an updated version.

Merging Color-Corrected Sequences

Your workflow might make it useful to work with two versions of a sequence at the same
time. For example, you might want an editor to work on one copy of a sequence while a
colorist continues to make color adjustments on another copy. The Merge Correction
command allows you to merge the two sequences to reflect the changes made on both
copies.

Merge Correction merges any color corrections based on Source Tape, Clip Name, Master
Clip, or Sub Clip relationships, or based on Program Track relationships, into the latest
version of the edited sequence. For example, if the editor adds new segments from source
tape 1, and a color correction exists for that source tape, the correction is applied to the new

271



Chapter 6 Managing Color-Corrected Sequences

segments when the merge takes place. This is true whether the color correction was made
before the editor began work or whether the color correction is made to the sequence while
the editor is working with a copy of it.

You can also control which of the two copies the system prefers if there is a conflict between
the two copies when merging.

Using the Merge Correction Command

mm
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The Merge Correction process begins with the creation of a new sequence, which is then
copied. The two copies are worked on independently before being merged using the Merge
Correction command. You can separate the two copies before you make any color
corrections, or you can make initial corrections and then separate the two copies.

To work with two copies of a sequence and then merge the corrections:

1. Create a first version of your sequence.

2. (Option) Click the Color Correction Mode button at the bottom of the Timeline to enter
Color Correction mode, and make initial color adjustments to the sequence.

3. Save the sequence, and then create one or two copies of the sequence.

The way you handle copies of the sequence depends on the requirements of your
workflow. You need only two versions of the sequence — the original and one copy. For
example, the colorist might keep the original while the editor works on the copy.
However, it might be safer to keep the original as a backup and to move forward in your
workflow with two new copies.

Take care to name your copies clearly. For example, if you are creating two copies as well as
keeping the original, you might use the extensions .Editor, .Colorist, and .Original to
distinguish the three versions.

For more information on saving and copying a sequence, see “Basic Bin Procedures” in the
Help.

4. Continue to work on the two copies independently.

5. When you are ready to merge the two copies, enter Source/Record mode.

6. Load one copy of the sequence into the Source monitor and the other into the Record
monitor.

You can load a copy into either monitor. The only difference is that the system merges
into the sequence in the Record monitor unless you instruct it to create a new sequence
for the merge in step 11.

7. Click the Color Correction Mode button at the bottom of the Timeline to enter Color
Correction mode.
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8. Right-click in the Color Correction tool, and select Merge Correction.

The Merge Color Correction dialog box opens.

_nrre:tinn x|
Source Program

& Tape o Track

22 Clip Mame = Segment

& Master Clip

24 Sub Clip

= Segment

In caze of conflict
Prefer Source Sequence Conflict Resolution menu

—

. Creste New Seguence ! Ok F Cancel

The Merge Correction command appears dimmed in the Color Correction tool shortcut
menu and cannot be selected until you load versions of a sequence in both the Source
monitor and the Record monitor and enter Color Correction mode.

9.

10.

11.

12.

Select the Source and Program relationships you want the system to use when deciding
which segments to update in the merging process.

By default, all available relationships are selected.

Click the Conflict Resolution menu, and select an option to control how the system
resolves conflicts between the two copies of the sequence:

Prefer Source Sequence — Resolves conflicts by preferring the information in the
sequence you loaded into the Source monitor.

Prefer Record Sequence — Resolves conflicts by preferring the information in the
sequence you loaded into the Record monitor.

Prefer Latest — Resolves conflicts by preferring the most recent information. This is
the default setting.

Select Create New Sequence if you want the system to create a new copy of the
sequence and merge into that copy.

If you deselect this option, the system merges the two copies into the sequence that is
currently in the Timeline. This is the sequence that you loaded into the Record monitor
before entering Color Correction mode.

Click OK.
The system merges the two existing sequences, based on the options you have selected.

The merged sequence appears in the Timeline.
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Color Correction Merging Example

The following example illustrates the capabilities of the Merge Color Correction command.

The original sequence for this example consists of seven segments that are derived from four
different source tapes. For simplicity, the segments are edited together in exactly equal
one-second lengths. The following illustration shows the original sequence before any color
correction is performed.

1. Original sequence

The numbers on the segments indicate the
source tape from which each segment comes.

L8 e ot eunding it Tomery | werchat it 4 wanth |t partotusan |

The sequence now receives some initial color correction. Source Tape correction is applied
to the material from source tapes 2 and 4. The following illustration shows the sequence
after this initial color correction work.

2. Sequence after initial color correction

Segments from source tapes 2 and 4 have
Source Tape corrections.
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At this point in the workflow, a copy is made of the sequence and an editor continues to
work on the copy. At the same time, further color corrections are made to the original
version of the sequence.

The editor makes the following adjustments:

*  The fifth segment is replaced by another clip from source tape 2.

* A new segment from source tape 4 is added near the end of the sequence.

e The second segment is trimmed to double its length.

3. Editor’s copy of sequence after further editing

Lengthened segment Replacement segment  New segment from
after trimming from source tape 2 source tape 4

1) R P, O .0 200 O 5 P W O S
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The colorist modifies his or her version of the sequence by adding Source Tape correction

for source tape 1.

4. Colorist’s copy of sequence after further correction
Source Tape correction added for source tape 1

The editor’s copy of the sequence is now out-of-date with respect to the colorist’s
corrections. It contains segments from source tapes 1, 2, and 4 that need to be updated to use
the Source Tape corrections for those tapes. When the two sequences are merged, the
editor’s sequence is correctly updated.

5. Merge process

05 et b ] uiing with tom] Tomero | worhant wit] watelpan | sty | stestevr e |

Editor’s copy Source Tape correction

Editor’s trim appears in is applied to new shots.

merged sequence. |

v v

Merged sequence 4 A

-
-

|
Colorist’s new correction to source tape 1 is
applied in the merged sequence.
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Colorist’s copy

Flattening Color-Corrected Sequences

In some circumstances, you might want to convert a color-corrected sequence so that all the
color corrections become segment-only relationships. This allows you to readjust the color
correction in a single segment, even if it had previously been corrected as part of a broader
relationship, without affecting any other segments. As with the other color correction
sequence commands, you can define by relationship which groups of segments are converted
to segment-only relationships.

The following illustrations show this process for a simple sequence.
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Before flattening Segments A and C are currently corrected using a Source Tape relationship. You cannot

adjust the Source color correction for one segment without affecting the other.

After flattenin
9 All three segments are now governed by a segment-only relationship. You can adjust

each of them independently without changing any other segment.

To flatten a color-corrected sequence:

- 1. Click the Color Correction Mode button at the bottom of the Timeline to enter Color
Correction mode.

2. Right-click in the Color Correction tool, and select Flatten Correction.

The Flatten Color Correction dialog box opens. The dialog box indicates the number of
segments that are available for flattening in each relationship category.

3. Select the Source and Program relationships you want the system to use when deciding
which segments to flatten.

By default, all available relationships are selected.

4. Select Create New Sequence if you want the system to create a new copy of the
sequence and flatten segments on that copy.
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If you deselect Create New Sequence, the system flattens the existing version of the
sequence. Avid recommends that you create a new sequence when flattening. You then retain
the version that has not been flattened as a backup. If you flatten an existing version of a
sequence and want to return to the previous version, select Edit > Undo.

5. Click OK.

The system converts the segments you have selected to segment-only relationships. If
you have selected Create New Sequence, a new sequence appears in the bin with the title
[OldTitle].Copy 1. You can rename the sequence to indicate more clearly that it is a
flattened version.

Removing Color Corrections

You can remove the color correction on a specific segment at any time by clicking the
Remove Effect button in the Composer window while in Color Correction mode. You can
also remove groups of corrections with the same associated relationship using the Remove
Correction command. This is useful for removing all corrections, or large numbers of
corrections, at the same time.

To remove corrections using the Remove Correction command:

1. Click the Color Correction Mode button at the bottom of the Timeline to enter Color
Correction mode.

=l

2. Right-click in the Color Correction tool, and select Remove Correction.

The Remove Color Correction dialog box opens. The dialog box indicates the number of
segments in the sequence for each relationship category.

| Remove Color Correction x|
Source 0 Progratm 0
ﬁ Tape 0 n Track 1]
&2 Clip Name 0 . zegment 0
& Master Clip 0
) Sub Clip ]
. Segment 3

2, Creste New Seguence ! Ok J Cancel
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3. Select the Source and Program relationships you want the system to use as the criteria
for removing segments.

By default, all relationships are selected.

4. Select Create New Sequence if you want the system to create a new copy of the
sequence and remove segments only from that copy.

If you deselect Create New Sequence, the system updates the existing version of the
sequence. Avid recommends that you create a new sequence when removing groups of
corrections. You then retain the previous version as a backup. If you remove corrections from
the existing version of a sequence and want to return to the previous version, select

Edit > Undo.

5. Click OK.

The system removes color correction for all segments governed by the relationships you
have selected. If you have selected Create New Sequence, a new sequence appears in the
bin with the title /OldTitle].Copy 1. You can rename the sequence to indicate more
clearly that it is a version from which some corrections have been removed.



Chapter 7
Color Correction Techniques

This chapter provides a basic introduction to color correction techniques. It suggests some
general principles to keep in mind when you are assessing footage and making color
corrections. The chapter then presents several examples of shots with typical color problems
and detailed explanations of adjustments that improve those shots.

This information is intended primarily for users who are unfamiliar with the methods of
color correction and who want some initial guidance on how to handle material that needs
correction. However, since the chapter is built around specific examples of color corrections
made with the Color Correction tool, it might also be useful for anyone learning to work
with the tool and its controls, even an experienced colorist.

This chapter contains the following main sections:

*  QGuiding Principles for Color Correction

»  Examples of Color Correction Problems

Guiding Principles for Color Correction

One useful high-level way to think about the color correction process is to define what the
overall goals of the process are. Another, slightly more practical and detailed, is to break
down the typical color correction workflow into clearly defined stages of adjustment. This
section uses these two approaches to provide you with a set of guiding principles for color
correction.

Goals of Color Correction: Restoration and Adaptation

You can think of color correction as having two main goals. The first is restoring the original
look of the scene. The second is adapting the look of the scene to meet the demands of the
project.

In some cases, the task of color correction is complete when the first goal has been met.
Often, however, there is at least some departure from the restored look to achieve
shot-to-shot consistency or to convey creative concepts. The color corrections applied to any
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particular shot must therefore respect (to varying degrees) two different contexts: the
original scene at the time the camera captured it and the final situation of the shot within a
program that has particular creative or communicative aims.

Restoring the Original Look
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The first task in color correction is to restore the original look of the scene that has been
filmed — in other words, to make the image match as closely as possible what an observer
standing beside the camera would have perceived when the scene was shot.

This is important primarily because viewers have little tolerance for images that look
unrealistic when they are supposed to represent reality. Viewers make some allowances for
the fact that they are watching film or television rather than viewing the world directly, but
they do not make many. For example, when a skin tone departs from our normal
expectations of what skin should look like, we notice. Even when the final image is
intentionally a distortion of reality, it is useful to restore the original look as a well-balanced
foundation for subsequent alterations.

The color characteristics of a given shot can depart from the look of the original scene for a
variety of reasons. At the time of shooting, the camera might not be correctly balanced or the
scene might be imperfectly lit. During transfers (from film to tape, from one tape to another,
or from tape to captured media), inconsistencies in materials, processing methods, or
calibration might alter the colors.

When you are working on an uncorrected shot, you should make intelligent decisions about
what the scene originally looked like and then bring the shot into line with those decisions as
much as possible. Since it is unlikely that you were present when the scene was shot, this
might seem to require a great deal of guesswork, but, in fact, it can be accomplished with
sufficient accuracy using the following two basic guidelines.

*  The human visual system generally maximizes the tonal range available in a scene. For
example, in low light we adjust to perceive a greater range of dark tones.

*  The human visual system generally perceives color accurately and compensates for
color casts. For example, we perceive a white shirt as white even if it is being
illuminated by slightly pink light.

Generally, you can restore the original look of a shot (or at least create a believable
approximation of the original look) by opening up the tonal range as much as reasonably
possible and by ensuring that colors look accurate. For more detailed information on how to
achieve this with adjustments, see “Correcting Tonal Range” on page 282 and “Neutralizing
Color” on page 283, and the examples later in this chapter.
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Adapting the Original Look

An adaptive adjustment deliberately departs from the original look of the scene in some way.
Such an adjustment might be relatively subtle, for example, lightening one shot to make it
match another. In this case, you are departing from your commitment to the original look in
order to achieve shot-to-shot consistency in your sequence. Other kinds of adaptive
adjustment might be much more dramatic, for example, applying a gold tint to an entire
sequence for an advertising spot or applying extreme adjustments such as posterization or
chroma inversion for a music video.

Before you begin adaptive adjustments, you should try to achieve an effective restorative
adjustment. You will then be building on an image that has good color characteristics. Most
viewers can probably perceive the difference between a restored, well-balanced image with a
strong blue tint applied and an unrestored, poorly lit image with a strong blue tint applied
(and prefer the former).

Remember that Symphony Nitris is capable of two levels of color correction and that some
kinds of adaptive adjustments, especially if they are to apply equally to every shot in a
sequence, are best applied as Program relationships. However, if your correcting work
involves only restoration and simple matching for consistency from shot to shot, it is
probably better to do all your work as Source relationship corrections. This keeps your color
corrections as a whole simpler and preserves the Program relationship option for any final
adjustments that you might want to make.

Stages of Color Correction

A typical color correction for a shot will probably include the following main stages of
adjustment:

*  Correcting the tonal range (or contrast ratio)

*  Neutralizing color casts

* Achieving consistency between the shots in a sequence

* Achieving a final look

Different kinds of projects lead to different emphases among these stages and might even
make some unnecessary. Different working habits also affect how these stages are handled.
A more experienced colorist might work in a manner that blurs the distinctions between

them. For a beginner, it might be better to keep them distinct and achieve an acceptable
result for each one before moving on to the next.

The following sections provide some guidelines for each main stage.
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Correcting Tonal Range
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Correcting the tonal range usually requires two steps. In the first step, you reset the white
and black points to make the range of values between the lightest part of the image and the
darkest part of the image as large as possible. In the second step, you adjust the gray point to
control how much of the total tonal range falls above and how much below the middle value.

Setting White and Black Points

Setting the white point and the black point is often relatively straightforward, since the shot
includes an area that should obviously be very light and another area that should be very
dark. You simply look for what should be the lightest area of the image and adjust controls
until it becomes as light as possible, and then do the same for the area that needs to be black.
You can dramatically improve the quality of shots taken using insufficient or excessive light
just by making white and black point adjustments.

In some cases, however, the shot should have less range of brightness (for example, when the
whole scene was originally in shadow or was shot at sunset). In such cases, you need to be
careful to expand the range as much as possible without making parts of the image
unrealistically light or dark.

Avoid clipping any significant part of the image. You want the range between your lightest
value and your darkest value to be as large as possible, but in most circumstances you don’t
want to lose detail by reducing all your very light values to white or all your very dark values
to black.

Do not use intense reflected spots of light (known as speculars) to judge where your white
point should be. If you do so, you define white by an artificial standard that probably occurs
in only a tiny fraction of the image. A true white object such as an item of clothing might
appear dull and gray by this standard.

You have a number of choices for controls to use to make white point and black point
adjustments, including the Gain and Setup sliders in the HSL tab and the various controls in
the Levels tab.

Adjusting the Gray Point

Once you have established the range from the brightest part of the image to the darkest part,
you can adjust the gray point if necessary. When you make a gray point adjustment, you
define how much of the overall tonal range is between black and mid-gray, and how much is
between mid-gray and white.



Guiding Principles for Color Correction

The most obvious effect of a gray point adjustment is that it either lightens or darkens the
overall look of the image. Large adjustments of the gray point toward either the black point
or the white point are almost always undesirable because they leave the whole image much
too dark or too light.

Smaller, well-chosen gray point adjustments, however, can be useful for fine-tuning the
overall brightness of the image. Also, since a gray point adjustment expands the tonal range
on one side of the midpoint and contracts it on the other, it can be useful for improving
contrast and detail overall. For example, some images look better if more contrast is
available in the range between gray and white, even though the price paid for that extra
contrast is a reduction in contrast between gray and black.

The main controls for making gray point adjustments are the Gamma slider in the HSL
group and the gray point controls in the Levels group.

Neutralizing Color

Neutralizing color involves returning the colors in an image to the colors that a viewer would
have perceived when standing beside the camera. Most film or video images depart from that
ideal to some degree, and some depart from it dramatically.

One way to think about neutralizing color is to imagine working on a project where every
shot includes a large card that we know is, when viewed in ideal lighting conditions, a
perfectly neutral mid-gray color. If you can correct each image so that the card appears mid-
gray when your audience views the final program, all other colors in the images should be
correct also.

Though you cannot normally have such a perfect measuring device in your images, it is
useful to select an area of each image as a target for your color neutralizing adjustments. If
you focus on getting the color in that area right, color in the rest of the image should fall into
place. In some images, there might be an object or area that should be neutral gray, or nearly
so0, and you can use that area as your principal target as you make adjustments. In other
images, you might not have any gray color at all, but you will almost certainly have some
other area where even a small departure from neutral color is noticeable. Human skin is
probably the most common example. Or you might choose to focus on an area where you
know the true color, such as a person’s hair.

In addition to identifying parts of your image on which to concentrate your attention, it is
useful to establish how the uncorrected image departs from neutral color before you attempt
to correct it.

Sometimes this is obvious. You cannot mistake an image with an extreme pink or yellow
cast. When the problem is more subtle, you can sample a few areas with the Color Match
eyedropper to get information about the color characteristics of the image. Areas that should
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be white or black are particularly helpful, since these are easily identifiable colors that
should have nearly identical values for red, green, and blue. If the red value is higher than
the other two, the image has a red cast. If red and green are higher than blue, the image has a
yellow cast.

You can neutralize color using many different controls in the Color Correction tool. For
example, you can use the Curves tab to adjust the proportions of each color. You can use the
Hue and Saturation sliders in the Highlights, Midtones, and Shadows tabs of the HSL group.
Or you can use the Hue Offsets color wheels, which allow you to quickly locate the sector of
the wheel that represents the color cast in the image, and then adjust in the opposite direction
to that color. Except when a color problem is extreme, you are usually more successful when
neutralizing color if you make adjustments in individual colors or in specific brightness
ranges rather than in the Master controls.

The more experienced you become as a colorist, the better you will get at judging even
subtle color problems by eye and knowing intuitively what kinds of adjustments to make.

Achieving Shot-to-Shot Consistency
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The most common reason for departing from the look of the original shot is to achieve
simple shot-to-shot consistency in the finished program. If a scene in a drama that is
supposed to take place at one time is shot over two days, and lighting conditions have
changed from one day to the next, you clearly want to adjust all the shots so that they appear
to be taking place at the same time.

Adjustments for shot-to-shot consistency are relatively straightforward in most cases. You
simply need to compare shots in the Composer window and then adjust them to match. If
you have already adjusted tonal range and neutralized color well, a small change to relative
brightness might be all that is needed.

Depending on the requirements of your project, you might choose to make adjustments for
shot-to-shot consistency as Source or as Program relationship corrections. If you have made
a lot of earlier Source relationship adjustments and you know you do not need to make
overall adjustments for a finished look, you might choose to move to Program relationships
to make shot-to-shot corrections. If you expect to need Program relationships for significant
finishing adjustments that apply across all the segments in your sequence, you should stay
with Source relationships when making shot-to-shot adjustments.
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Achieving a Final Look

Some projects might require final adjustments to create a finished look. For example, you
might slightly increase saturation across the whole sequence to create richer-looking colors
or slightly darken all the shots to enhance a mood of tension or suspense. In certain
circumstances, you might make substantial changes to the color values of the whole
sequence or remove color entirely from some parts of it.

You usually make final corrections of this kind as Program relationship corrections by
correcting entire program tracks or extended parts of sequences defined by IN and OUT
points. It is not possible to generalize about which controls to use to make such adjustments.
You might be called upon to use any combination of color correction controls. The only
effective preparation for such work is practice using Color Correction mode and a good
understanding of the more specific corrections discussed in the previous sections.

Examples of Color Correction Problems

The remainder of this chapter presents three typical color correction problems. The original
images are chosen as good illustrations of the kind of color correction work that needs to be
done to restore a good approximation of what an observer at the scene would have perceived
when the camera was shooting. They require corrections to improve tonal range and to
neutralize color casts.

Each example provides the following information:

* An analysis of the original image

»  Step-by-step descriptions of the corrections with illustrations (including split-screen
displays in some instances)

*  Sample RGB values that illustrate the results of the corrections

*  Suggestions for alternative ways to achieve similar results with the Color Correction
tool

Remember that these examples are presented as aids to learning, not as inflexible
instructions for making corrections or models of what a perfect corrected image looks like.
Each example shows only one possible way of making a correction and one possibility for a
final corrected image. As you develop your own color correcting skill and judgment, you
might prefer to use different combinations of controls and to aim for a slightly different final
look.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version available from the Online Library for your application.
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Example 1

Uncorrected Image

T

Analysis of original image: This image has two obvious problems. First, it lacks contrast
and detail because it does not have a full tonal range. A correction is required to improve
sharpness and detail in areas such as the shirt and the man’s hair. Second, the image has a
strong yellow-green cast. This leads in particular to a very unnatural skin tone.

Step 1: Contrast Correction

Discovery
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Split Screen: Uncorrected
Image and Step 1 Correction

Step 1 of this correction is an adjustment to the Contrast slider in the Master Controls tab of
the HSL group. This adjustment (which sets the Contrast slider value to 11) illustrates one of
the simplest ways to affect the tonal range of an image. Despite its simplicity, the correction
improves the image noticeably. Compare the look of the man’s hair on either side of the
split-screen dividing line.

Step 2: Correction
to Neutralize Color
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Split Screen: Uncorrected Image
and Image After All Corrections

Step 2 of this correction eliminates the color cast by making a single adjustment on the
Master Hue Offsets color wheel in the HSL group. Since the image is obviously too green,
the correction is made by moving the crosshair pointer away from green. The adjustment
shown is Hue:—94, Amount:11. (This places the crosshair between the magenta and blue
parts of the wheel, opposite a point between green and yellow. The sample RGB values
below confirm that we are reducing both yellow and green in the image.) This successfully
restores a good skin tone and reveals the man’s shirt to be blue.

Sample RGB values: A sampling of an area of the man’s shirt before and after the
corrections shows the following values:

Before: R:37, G:56, B:61
After: R:14, G:26, B:55

These numbers reinforce the nature of the corrections that have been made. The hue offset
adjustment has reduced the red and green levels significantly while preserving the amount of
blue in the image.

Alternative techniques: This example uses simple corrections that apply across the full
luminance range. Another method for correcting this image would involve making
individual adjustments in different ranges such as highlights and shadows. For an illustration
of this approach, see “Example 2 on page 289. The contrast adjustments could be made
using the Gain, Gamma, and Setup sliders as an alternative to the one adjustment on the
Contrast slider. Another alternative for making the contrast adjustment would be to use the
controls in the Levels tab.
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Example 2

Uncorrected Image

Analysis of original image: This example has less glaring problems than Example 1, but it
is still an image that can be improved with color correction. The highlight areas of the image
(primarily the shirts) are not particularly bright, and the shadow areas (such as the underside
of the cap brim) could be darker. Rebalancing white and black will improve contrast and
sharpen the image throughout. Also, the image has a red cast, apparent in the slightly pink
tone of the shirts. A good color-neutralizing correction will eliminate that cast without
taking too much red out of the skin tones. Since the skin tones are relatively good in the
image already, successful corrections will not disturb the midtones very much. The
corrections in this example are therefore made primarily in the highlights and shadows
luminance ranges.
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Step 1: Corrections in Master
Controls Tab

Step 1 of this correction adjusts the Gain and Saturation sliders in the Master Controls tab.
Gain is increased to 103.70, Saturation to 106.17. This brightens the whole image slightly
and intensifies color throughout to correct the slightly dull look of the original.

Step 2: Correction in Highlights .l
Controls Tab

o s e

Step 2 makes a large adjustment to the Gain slider in the Highlights Controls tab. Gain is
increased to 148.15. This brightens the highlight areas considerably and brings much more
sharpness and contrast into the lighter areas of the cap and into the shirt in the lower

right corner.
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Step 3: Corrections in Shadows
Controls Tab

Step 3 makes adjustments in the Shadows Controls tab. Saturation is reduced to 66.67 and
Setup is reduced to —9. This makes the darkest areas of the image more nearly black and
further contributes to the building of contrast in the image.

Step 4: Correction to Neutralize el
Color

Step 4 neutralizes the color cast in the highlights range by making a large adjustment in the
Highlights color wheel. The adjustment values are Hue:—167.76, Amount:41.32. This
removes the pink look in the shirts (most apparent by comparing the shirt in the background
between Step 3 and Step 4). Since the adjustment is made in the highlights range only, it
doesn’t result in an extreme loss of the red component of the skin tones.

291



Chapter 7 Color Correction Techniques

292

Split Screen: Uncorrected Image
and Image After All Corrections

Sample RGB values: A sampling of the darkest shadow area of the cap before and after the
corrections shows the following values:

Before: R:24, G:24, B:22
After: R:14, G:15, B:17

These values confirm that corrections in the shadows area have resulted in shadows that are
a more intense black.

Alternative techniques: The Curves tab is the only other part of the Color Correction tool
that allows adjustments that affect luminance ranges differently in the manner of this
example. A similar final result could probably be achieved in the Levels tab, but the
adjustments there are made on individual color channels rather than on different overall
luminance ranges.
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Example 3

Uncorrected Image

Reference Image

Analysis of original image: In this example, two different cameras have been used to shoot
the rock climbers. The second camera is correctly balanced and shows good color
characteristics. In comparison, the images from the first camera show a pronounced blue
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cast. Also, the image from the first camera is too dark. Because the images from the two
cameras look so different from one another, and because the first image is intrinsically weak,
corrections are needed to neutralize color and raise the brightness level in the first image.
The image from the good camera can be used as a reference as these corrections are made. In
this example, the corrections are made in the Curves tab. One advantage of Curves tab
adjustments, if you are practiced and comfortable with them, is that you can make quite
complex changes without having to alter many controls. The corrections in this example are
made by adding and moving a single control point in each of two Curves tab graphs.

Step 1: Correction to Neutralize
Color

Split Screen: Uncorrected Image
and Step 1 Correction

Step 1 of this correction removes the excess blue in the image by adjusting the Blue curve in
the Curves tab. A control point is placed near the center of the curve since the adjustment
needs to apply relatively evenly across the whole luminance range. The control point is then
dragged down to reduce blue. The input and output values for this adjustment are 142 and
104 respectively.
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Step 2: Correction to Match
Brightness of Reference Image

Split Screen: Uncorrected Image
and Step 2 Correction

Step 2 of this correction increases the brightness of the image by making an adjustment on
the Master curve in the Curves tab. The control point is placed three-quarters of the way up
the curve and moved up and to the left. The input and output values for this adjustment are
178 and 213 respectively. The resulting curve increases brightness throughout the image but
increases it most in the highlights range. This creates more contrast in the lower three-
quarters of the luminance range (in a Curve graph, contrast is greater where the curve is
steeper).

The following illustration compares the corrected image to the reference image from the
good camera. Some fine-tuning is still possible to match the shots more precisely, but the
images from the two cameras are now much closer to one another and look more acceptable
when viewed in the sequence.
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Reference Image and Corrected Image

Sample RGB values: A sample of the white helmet before and after the correction and in
the reference image shows the following values:

Before: R:113, G:139, B:211
After: R:142, G:152, B:174
Reference: R:146, G:174, B:185

Though these samples might not be from precisely the same part of the helmet in all three
cases, they clearly confirm the nature of the correction. They indicate a relative gain in red
and green levels, a reduction in blue levels, and a much closer match with the levels in the
reference frame.

Alternative techniques: The Blue curve correction could be made in the Hue Offsets tab, in
the Blue Levels tab, or even with a series of adjustments to the HSL sliders in the Controls
tab. The brightness and contrast adjustment could be made in the HSL tab (using similar
techniques to those in examples 1 and 2), or it could be made by adjusting white and gray
points in the Levels tab.
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Spot Color Correction

Avid Symphony Nitris allows you to apply color adjustments to parts of images that you
define by drawing. You can make these adjustments using the Spot Color Correction effect
or using color adjustment modes in the Paint Effect. Both effects include the Color Match
control for making automatic adjustments based on selected input and output colors.

»  Using the Spot Color Correction Effect
»  Using Paint Effect Modes for Color Adjustment

Using the Spot Color Correction Effect

The Spot Color Correction effect allows you to make precise color adjustments to a part of
an image that you define using the Intraframe drawing tools.

For example, you can outline a figure in a shot or isolate a single object and then adjust the
color of that figure or object without affecting the color of the rest of the image. As with
other Intraframe effects, you can use keyframes to adjust the effect over time.

Spot color correction is commonly used as a storytelling device that emphasizes part of an
image by giving it distinct color characteristics. You can also make color corrections using
spot color correction whenever you want a color adjustment to be restricted to part of the
image only.

In many circumstances, you can correct the color in selected areas of an image more quickly
and easily using the secondary color correction capabilities of the Color Correction tool.
However, color corrections that define part of an image using drawing tools are sometimes
the only way to isolate the exact area of an image that you need to correct. For more
information on secondary color correction, see “The Secondary Group” on page 232.
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The following illustrations show two basic examples of spot color correction. In the first
example, the background of the shot is outlined with a drawing tool and then desaturated and
lightened, leaving the car as the only part of the image in color. Additional shapes within the
main outline of the car have been used to remove any color visible through the car’s
windows. In the second example, the straw bale on the left is outlined with a drawing tool
and then enhanced with color adjustments to give it a stronger golden-yellow appearance.

If you are reading a printed version of this document, you will find it useful to view the color
images in the online version of this document available from the Online Library for your
application.

B T T e

You can also make color adjustments to Intraframe objects using various modes in the Paint
Effect. However, you can apply only one kind of adjustment to a selected area using the Paint
Effect. Using the Spot Color Correction effect, you can enable several kinds of color
adjustments at the same time.



Using Paint Effect Modes for Color Adjustment

Making Corrections Using the Spot Color Correction Effect

To make corrections using the Spot Color Correction effect:

1.
2.
>
— 4.

10.

Select Tools > Effect Palette.
The Effect Palette opens.
Click the Image category.

Click the Spot Color Correction Effect icon in the Effect Palette, and drag it to the
segment you want to correct in the Timeline.

Click the Effect Mode button to enter Effect mode.

. From the Effect Editor, select a drawing tool, such as the Polygon tool.

Use the drawing tool to define the area on the image that you want to correct.

For more information on working with the Intraframe drawing tools, see “Intraframe
Editing” in the Help.

Adjust parameters in the Effect Editor until you are satisfied with the look of your
correction.

For information on the parameters available, see “Image: Spot Color Correction” in the
Help.

. (Option) If necessary, repeat steps 3 through 6 to define and adjust additional areas for

correction.

(Option) If necessary, use keyframes to adjust the corrected areas over time so that they
follow movements in the footage.

For more information on keyframing Intraframe objects, see “Animating the AniMatte
Effect” in the Help.

Render the effect to play it back in real time.

Using Paint Effect Modes for Color Adjustment

Using some of the modes in the Paint Effect, you can adjust the color of a selected area that
you have defined.

The main difference between color correction using the Paint Effect and color correction
using the Spot Color Correction effect is that the Paint Effect can be used to apply only one
kind of color adjustment. For example, you can adjust the luma range of a selected area by
selecting the Luma Range mode of the Paint Effect, but you cannot then make an adjustment
to the red color channel using the Color Gain mode. The Paint Effect can apply only one
mode to an object.
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To make a correction to an area in an image using a Paint Effect mode:

1.

Select Tools > Effect Palette.
The Effect Palette opens.

. Click the Image category.
. Click the Paint Effect icon in the Effect Palette, and drag it to the segment you want to

correct in the Timeline.

. Click the Effect Mode button to enter Effect mode.

5. From the Effect Editor, select a drawing tool, such as the Polygon tool.

10.

11.

. Use the drawing tool to define the area on the image that you want to correct.

For more information on working with the Intraframe drawing tools, see “Intraframe
Editing” in the Help.

. In the Mode parameter category, click the Fast Menu button, and select one of the

following color adjustment modes:
- Luma Adjust

- Luma Range

- Luma Clip

- Chroma Adjust

- Color Style

- Color Gain

- Color Match

. Adjust the parameters in the Mode parameter category until you are satisfied with the

look of your correction.

For information on Paint Effect modes, see “Image: Paint Effect” in the Help.

. (Option) If necessary, repeat steps 3 through 6 to define and adjust additional areas for

correction.

(Option) If necessary, use keyframes to adjust the corrected areas over time so that they
follow movements in the footage.

For more information on keyframing Intraframe objects, see “Animating the AniMatte
Effect” in the Help.

Render the effect to play it back in real time.



Chapter 9
Safe Colors

The Safe Colors feature allows you to set safe limits for the colors that display in your
images — that is, limits beyond which the application issues a safe color warning. This
chapter provides all information about the safe color features of Avid Symphony Nitris that
are not covered in the Avid Symphony Nitris Basics Guide.

This chapter includes the following main sections:

*  Overview of Safe Color Limits

*  Understanding Safe Color Settings Options

*  Understanding the Graphical View of Safe Color Settings

*  Understanding Safe Color Warnings

»  Safe Color Limits with Waveform and Vectorscope Information

Overview of Safe Color Limits

Symphony Nitris allows you to set three different types of safe color limits — limits beyond
which a safe color warning appears. You can set warning limits for the composite signal
range, the luminance range, and the RGB gamut.

Most broadcasting companies set specific limits for the composite signal and the luminance
range. Programs that do not meet these limits are not normally accepted for broadcast. For
example, a typical set of limits for broadcast in the United States might restrict the
composite signal to a range from —20 IRE to 110 IRE and limit the maximum luminance to
approximately 100 IRE. Some broadcast standards might be even stricter than these values,
while others might be somewhat more permissive.

The composite signal for a program intended for broadcast should never exceed 120 IRE,
which is the highest level that can be broadcast.
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Safe Colors

If you are working on a program intended for broadcast, you should determine what the safe
limits for composite and luminance are and type them in the appropriate areas of the Safe
Color Settings dialog box. You can then instruct the system to warn you when those limits
are exceeded. For more information, see “Understanding Safe Color Settings Options” on
page 302.

RGB gamut refers to the intensity of each individual color channel — red, green, and blue.
This measure of a safe color is less likely to be subject to specific broadcast standards, but it
is still an important limit type. Colors that have extremely low or high gamut values might
not display well on television screens.

Understanding Safe Color Settings Options

You set safe color limits and control how those limits are applied by selecting options in the
Safe Color Settings dialog box. For more information on how to open the Safe Color
Settings dialog box, see “Managing Safe Color Warnings” in the Help.

The following table describes the available warning types, units of measurement, and types
of action in the Safe Color Settings dialog box.

The Safe Color Settings button in the Color Correction tool provides a visual indication of
the status of the Safe Colors feature. If Warn is selected in one or more of the Actions menus,
the icon on the Safe Color Settings button appears orange to indicate that at least some of
the Safe Colors options are active. Otherwise, the icon on the Safe Color Settings button
appears black.

Safe Color Settings Options

Option Description

Composite Sets safe color values for the composite video signal.
Luminance Sets safe color values based on brightness.

RGB Gamut Sets safe color values based on color range.
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Safe Color Settings Options (Continued)

Option Description

Units buttons Define the units of measurement for the three types of safe color values.
Click the Composite Units button and select either IRE or mVolts (millivolts).
Click the Luminance and RGB Gamut buttons and select from the following options:
* 8 Bit — Measures the adjustment on a scale from 0 to 255.

The RGB value for a color in the Color Correction tool will not be identical to
the RGB value for the same color in a graphics application such as Adobe
Photoshop. For example, the 8-bit RGB values for reference black and
reference white are 16 and 235, respectively.

*  Percent — Measures the adjustment on a percentage scale from 0 to 100.
* IRE — Measures the adjustment in IRE units.

* mVolts — Measures the adjustment in millivolts.

Actions buttons Define how Symphony Nitris implements the safe color settings. The top button
controls both the Composite and the Luminance limit types; the bottom button
controls the RGB Gamut limit type.

Click an Actions button and select from the following options:

» Ignore — Symphony Nitris does not limit based on these settings. This is the
default setting.

*  Warn — Symphony Nitris provides warnings when these limits are exceeded.
For more information on safe color warnings, see “Understanding Safe Color
Warnings” on page 305.

Understanding the Graphical View of Safe Color
Settings

The Safe Color Settings dialog box includes a graphical indication of the current limit values
in relation to the default values. This allows you to quickly check that your limits are
consistent with one another and within an acceptable range without having to read all the
numerical limit values and remember the default values.

The following illustration shows the location of this graph within the Safe Color Settings
dialog box. All settings in this illustration are at their default values.
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-Ior Settings - Current x|

Loy High

Composite -20.00 110.00 IRE -
Luminance 7.50 10000 IRE b
RGB Gamut 0.00 23300 g Bit Tai lgnore

_—— oK Cancel

Ignore. -

Safe Color Settings graph

The graph shows colored bars that represent the current low and high levels for each limit
type. The colors are the same as those used to display safe color warnings in the monitors. It
also displays gray vertical lines that represent the default high and low levels for each limit

type.

The following illustrations present two graphs in detail — the first showing default levels
and the second showing adjusted levels — and explain how to interpret the graphs.

Default Safe Color Settings

Loy High

On the default Safe Color Settings Composte -2000 | 11000 | Default settings
graph, all the color bars are aligned Luminance | 750 | 100.00 values
with the gray vertical lines that
represent the default numerical values. RGE Gamut ey | 2
Composite Default settings
Luminance ——&=— T e
Red —— I I
Green —————— I

Low-limit Gray lines mark High-limit

indicator bars default values indicator bars
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Adjusted Safe Color Settings

Loy High
On the adjusted Safe Color Settings graph, Composte poo | 12000 Adjusted settings
colored bars that extend beyond the gray lines , ,—l— values
toward the middle of the graph indicate more Luminance 10.00 ] 110.00

restrictive settings than the defaults. Bars that RiGE Gamut 16.00 | 235.00
retreat from the gray lines toward the outside of

the graph indicate more permissive settings

than the defaults.

Adjusted settings
| | ) 9
graph
| |
] |
|
1 |
All low limit settings (and RGB high High composite and luminance settings
settings) are now more restrictive than the are now more permissive than the
defaults represented by the gray lines. defaults represented by the gray lines.

Understanding Safe Color Warnings

If you select the Warn option for one or more of the types of safe limit, Symphony Nitris
displays warnings when material exceeds the limits you have set. You select the Warn option
using the Actions button as described in “Managing Safe Color Warnings” in the Help.

Warnings appear in the Composer Window monitors for all limit types — Composite,
Luminance, and RGB Gamut. (Warning indicators do not appear unless color levels exceed
at least one of the limits currently set to Warn.) For more information, see “Safe Color
Warnings in the Composer Window” in the Help.

Warnings appear in the Color Match control for RGB Gamut limits only.

Safe color warnings appear when you exceed limits in either field of the frame if you are
working with two-field media. To move through video material one field at a time and see
histograms for every field, use the Step Forward One Field button or the Step Backward One
Field button. In Color Correction mode, these buttons are available on the Move tab of the
Command palette. You can also map these buttons to your keyboard to use them quickly
while using Color Correction mode.
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Safe Color Warnings in the Color Match Control

If you select the Warn option for the RGB Gamut limit type, Symphony Nitris displays
warnings in the color swatches of the Color Match control when values exceed the limits
you have set. If you use the eyedropper to select an input or output color that exceeds limits,
a warning triangle appears beside the color information in the appropriate color swatch. The
following illustration shows a swatch with typical Safe Color warnings.

In this example of a swatch for an intense white, both the
F: . 1 EIEI Red and Green levels exceed the High RGB Gamut
G 255 ‘. setting of 235 and warning triangles appear. The Blue

E 255 l value remains just within the limit.

Making Adjustments to Achieve Safe Color Values

306

If some of your color levels exceed limits, you can return them to safe color values by
adjusting the color correction controls in any combination. The following procedures show
how to make various adjustments using the Controls subdividing tab of the HSL group and
the Curves group.
To bring luminance within safe limits:

1. Click the Controls subdividing tab in the HSL group.

The Controls tab opens.
. Click the Enable button for the HSL group and the Controls subdividing tab.
. Click the Enable button for Clip Low and Clip High controls to activate them.

. Type 16 in the Clip Low text box, and press Enter.

wn kA W N

. Type 235 in the Clip High text box, and press Enter.

Luminance values are clipped to safe levels.
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To bring RGB values within safe limits:

1. In the Master ChromaCurve graph of the Curves tab, click the lower left control point to
select it.

A circle appears around the point.

2. Under the Master ChromaCurve graph, type 16 in both the input text box and the output
text box.

The control point moves to 16, 16. Symphony Nitris adjusts RGB values under 16 up to
16.

3. In the Master ChromaCurve graph of the Curves tab, click the upper right control point
to select it.

A circle appears around the point.

4. Under the Master ChromaCurve graph, type 235 in both the input text box and the
output text box.

The control point moves to 235, 235. Symphony Nitris adjusts RGB values above 235
down to 235.
To bring composite levels within safe limits:
1. First adjust luminance and RGB levels using the previous procedures.
If composite levels do not fall within safe limits, continue with step 2.
2. Click the Curves tab.
3. If the composite high warning is on, do the following:

» Inthe Master ChromaCurve graph, Shift+click the upper right control point, and
drag it down the curve until the composite high warning turns off.

4. If the composite low warning is on, do the following:

» Inthe Master ChromaCurve graph, Shift+click the lower left control point, and drag
it up the curve until the composite low warning turns off.
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Safe Color Limits with Waveform and Vectorscope
Information

308

To stay well within the limits of television transmitters, cable systems, satellite links, DVD
encoders, and so on, broadcasters or distributors often issue safe color limits for video levels.
Video levels outside safe color limits are generally known as “illegal.”” A program with
illegal levels might be rejected on technical grounds or the image quality might suffer with
further processing. If you know that your delivery master is a VHS tape that does not handle
high chroma well, set some reasonable limits by yourself.

In'Y (luma only) waveforms, reference white of 100% corresponds to a digital level of 235,
an NTSC level of 100 IRE, and a PAL level of 700 mV. White excursions up to 108% are
technically possible.

In Y (luma only) waveforms, reference black of 0% corresponds to a digital level of 16, an
NTSC level of 7.5 IRE, and a PAL level of 0 mV. Black excursions down to —8% are
technically possible.

With both white and black levels, further signal processing (down the line from Symphony
Nitris) might clip the peaks in your material. In addition, you might be required by delivery
specifications to limit the white peaks to a lower level and the black peaks to a higher level.

Use Y Waveform to see the black and white levels of your image. Sometimes, particularly
with white levels, keeping the white peaks within the 100% limit does not produce a
pleasing level for the rest of the image. This is particularly common with backlit subjects,
where the sky or a window is in the background and the lighting on the foreground is
insufficient. In these cases, you might want to adjust for the foreground and leave the
background too bright.

Chroma peaks are easiest to see on the vectorscope. The theoretical maximum is the circle
around the outer edge, but to be safe you might like to keep vectors closer to the center than
the 75% color bar squares.

Saturated bright or dark colors might have very low or high luma values, together with a lot
of chroma. Even if neither luma nor chroma alone is excessive, the combination can be
illegal. For example, vivid yellow and cyan in an image can produce composite levels that
are too high, and those from vivid blue might be unacceptably low. The YC Waveform is a
good way to see how far these levels extend. In general, avoid levels above approximately
120 IRE or 850 mV, and those below —20 IRE or —200 mV.
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If you are producing a master for broadcast delivery, ask for delivery specifications. To
ensure you meet particular standards, use a legalizer such as a third-party AVX plug-in.

m

These instruments do not measure analog outputs. If Symphony Nitris or another device uses
analog connections, use an external Waveform monitor to verify levels.

The Y Waveform, YC Waveform, and RGB Parade displays incorporate any safe color limits
you have set. The following table describes the colors used to represent various conditions.
“Legal” means the value is within the safe color limits. “Illegal” means the value is outside
(either above or below) the safe color limits.

Safe Color Limits in Waveform Displays

Display Component Value Display Color
Y Waveform Luma Legal Green
Illegal White
YC Waveform Composite Legal Cyan
Illegal Yellow
Luma Legal Green
Illegal White
Composite or Luma Outside display boundaries Red
RGB Parade Red Legal Red
Illegal White
Green Legal Green
Illegal White
Blue Legal Blue
Illegal White
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Shadows tab (HSL group) 183, 196
tabs in 140
turning controls on or off in 145
Color Match control
3 x 3 averaging of pixels, described 151
3 x 3 averaging of pixels, using 174
and Curves tab 223
and secondary color correction 252
correcting with 174
described 173
example of use 179
in Paint Effect for spot color correction 299
Match Type options for 175
safe color warnings in 306

using with syringe for secondary color correction

253
Color Selection buttons 247
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Color space

for HD 70
Color swatches

in Selected Vectors panel 240
Color vectors

adjusting input values 242

adjusting output values 251

custom 235

customizing display in color wheels 238

described 235

display in color wheels 235

enabling 242

inverting 254

isolating in an image 250

repositioning in color wheels 243

resetting 242

selecting 241

standard 235

using input sliders 243
Color wheels

correcting color cast with 188

customizing display of color vectors in 238

display of color vectors in 235

display options for 152

in Secondary group 235

repositioning color vectors in 243
Color-corrected sequences

converting to segment-only relationships 275

flattening 275

removing 277

updating 269
Comments

adding to color corrections 152

displaying in the Timeline 154
Comments button 153
Comments command (Timeline Fast menu) 154
Composer window

configuring monitors in 129

controlling frame display in 135
Composite limits for broadcast 301
Composite tab (Levels group) 210, 216
Confidence values

in Tracker timelines 99
Configuring monitors in Color Correction mode 129
Contrast

automatic color correction of 168

Control points
manipulating in Curves tab 221
on Luma Ranges graphs 197
Controls tab (HSL group)
controls described 185
described 182
Copying
tracking data 119
Correcting color
general procedure 163
to achieve safe limits 306
using the Channels tab 200
using the Curves tab 220
using the Hue Offsets tab 189
using the Levels tab 210
Correcting colors with color wheels 188
Correction Mode Settings button 148
Creating
trackers 87, 88
Crosshair pointers in ChromaWheel color wheels
described 187
Curves
using to make Levels tab corrections 216
Curves group
See Curves tab
Curves tab
and Color Match control 223
examples of adjustments in 225
making corrections in 220
Custom color vectors 235
Custom colors
options for naming 151
saving to bins 181
Customizing the Color Correction tool 148

D

Decomposed and recaptured sequences
color correction workflow with 139
Defining
segment relationships with IN and OUT points
151
units of measurement 149, 302
Deleting
trackers 90
tracking data points 106
Disabling trackers 89
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Displaying
color correction information in Timeline 161
comments in the Timeline 154
tracking information 129

Dual Split button (Composer window) 132

E

Edit Review button (Command palette)
function in Color Correction mode 135
Editing
segments with tracking data 117
Effect Editor
enabling and disabling trackers in 89
enabling motion tracking in 85
motion tracking controls 78
Effect Palette
automatic color correction effect templates in 156
Effect parameters
adjusting, when motion tracking 84
compatibility guidelines for, with motion tracking
77
using with motion tracking 77
Effect Preview monitor
displaying tracking boxes in 90
motion tracking controls 79
setting up tracking in 90
tracking data in 99
Effect templates for color correction
automatic template update behavior 155
described 154
understanding save behavior 155
using automatic templates 156
Effects
applying for motion tracking 84
Paint 299
playing effects with tracking data 110
Spot Color Correction 297
using motion tracking 77
using motion tracking, examples 120
Effects (2D)
Region Stabilize 114
Stabilization 83
troubleshooting Region Stabilize effect 116
Enable buttons
described 145
interactions between 146
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Enable Tracker button (Tracking window) 82
Enabling
color vectors 242
Examples
black point adjustments 206
Channel Blending settings 203
Color Correction merging 274
correction with Color Match control 179
correction with NaturalMatch 179
Curves tab corrections 225
gray point adjustments 208
histograms 212
Hue Offsets settings 191
inverted images 255
isolated images 250, 255
Levels tab corrections 217
Luma Ranges three-tone previews 198
softness adjustments (secondary color correction)
246
typical color correction problems 285
Eyedropper
3 x 3 averaging of pixels, described 151
3 x 3 averaging of pixels, using 174
and Color Selection buttons 249
in Color Match control 174
options for 151

F

File transfers
between Macintosh and Windows 49
Windows to Windows 48
Files
guidelines for moving 26
Finding
tracking data points 105
Flatten Correction command (Color Correction
shortcut menu) 276
Flattening color-corrected sequences 275
Fonts
replacing title fonts 37
Format bin heading 69
Format display in the Project window
described 62
Frame display
and locators 135
controlling 135
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G

Generating tracking data
described 94
Gray point adjustments
guidelines for 282
Levels tab examples 208
Green tab (Levels group) 210
Groups
Channels 199
Curves 219
displaying 141
HSL (Hue, Saturation, Luminance) 182
interaction between 144
Levels 204
Secondary 233
Guidelines
for moving files 26
Guidelines for color correction
achieving a final look 285
achieving shot-to-shot consistency 284
neutralizing color 283
restoring an original look 280

H

HD media
offline formats 62
transcoding 70
HDTV
aspect ratio 54
broadcast graphics workflow 61
film-based workflow 55
supported formats 54
video-based workflow 59
HDV media
transcoding for conform 40
Hide Video command (Color Correction shortcut
menu) 134
High-definition television
See HDTV
Highlights tab (HSL group) 183, 196
Histograms
described 211
display options for 150
examples of 212
using controls 213

HSL (Hue, Saturation, Luminance) group 182
HSL sliders
described 185
making adjustments with 184
Hue Offsets tab (HSL group)
ChromaWheel color wheels in 187
color wheel display options 152
described 186
examples of settings for 191
examples of use 191
making corrections with 189

IN and OUT points

using to define segment relationships 151
Input color vectors

adjusting 242

sliders 243
Interaction between groups 144
Interface

for motion tracking 78
Intraframe effects

enabling motion tracking with 85

order of operations with motion tracking 84

using with motion tracking 83
Invert Last Vector feature

described 240

examples of images using 255
Inverting a color vector 254
Isolate feature

described 240

examples of images using 250, 255
Isolated images

examples of 250
Isolating color vectors in an image 250
ITU-R 709

described 70

L

Levels group
described 204
function compared to Channels group 204
Levels tab
ChromaCurve graphs described 214
examples of adjustments in 217

Index
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examples of black point adjustments 206
examples of gray point adjustments 208
histogram display options 150
histograms described 211
making corrections in 210
making curve adjustments 216
understanding input and output adjustments in 206
using histogram controls 213
working with controls in 211
Limitations
motion tracking 75
Locators
using to control frame display 135
Luma Ranges graphs
control points on 197
understanding 194
Luma Ranges tab (HSL group)
adjusting luminance ranges in 196
described 193
three-tone previews in 198
understanding graphs in 194
Luma tab (Levels group) 210, 216
Luminance limits for broadcast 301
Luminance ranges
adjusting 196

Macintosh Color Picker 173
Macintosh to Windows file transfers 49
Mapping
trackers 87, 88
Master tab (HSL group) 183
Master tab (Levels group) 210
MediaManager 44
Menu commands
16:9 Video (Color Correction shortcut menu) 134
Color Correction (Timeline Fast menu) 161
Comments (Timeline Fast menu) 154
Flatten Correction 276
Hide Video (Color Correction shortcut menu) 134
Merge Correction 272
Reference Current (Color Correction shortcut
menu) 132
Remove Correction 277
Update Correction 270
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Merge Correction command (Color Correction
shortcut menu) 272
Midtones tab (HSL group) 183, 196
Millivolts (mVolts) 149, 302
Mixing
SD and HD material 68
Modes
options in Paint Effect for spot color correction
299
using in Paint Effect for spot color correction 299
Modify command
changing sequence format 64
Monitors
activating 128
configuring in Color Correction mode 129
displaying 16:9 video in 134
displaying reference frame in 132
hiding video in 133
isolating a color vector in 250
source menu in 130
split-screen display in 132
Motion tracking
accuracy of 75
adjusting tracking boxes 90, 91
applying an effect for 84
changing display color 101
controls, in Effect Editor 78
controls, in Effect Preview monitor 79
controls, in Tracking window 81
copying and pasting tracking data 119
creating and mapping trackers 87
creating and mapping trackers manually 88
deleting trackers 90
display of tracking data points 99
displaying tracking boxes 90
editing segments with tracking data 117
effect parameter adjustments with 84
enabling and disabling trackers 89
enabling in the Effect Editor 85
enabling Intraframe effects with 85
establishing an effect offset 84
examples 74, 120
general workflow 75
interface, described 78
limitations of 75
limiting Position data to one axis 109
list of available effects and parameters 77
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manipulating tracking data points 104
multiple trackers in Tracking parameter 87
order of adjustments 84
order of operations with Intraframe effects 84
playback of effects 110
preparations for generating tracking data 85
process, described 74
reusing tracking data 118
selecting image areas for 92
setting up, in Effect Preview monitor 90
setting up, in Tracking window 93
starting to generate data 95
stopping tracking data generation 96
tracking box positioning guidelines 91
tracking box resizing guidelines 92
tracking perspective motion 88
tracking skew motion 88
Tracking window, described 80
understanding tracker creation and mapping 87
using Intraframe effects with 83
video layer requirements for 83
workflow for 75

Moving
settings between systems 45
tracking boxes 91
tracking data points 107

Moving files
guidelines for 26

mVolt (millivolt) units 149, 302

N

NaturalMatch
described 179
example of use 179
Neutralizing color
guidelines for 283
New Tracker button (Tracking window) 81

(o)

OMEFI MediaFiles folder
transferring media 45

Output color vectors
adjusting 251

P

Paint Effect
Color Match control in 299
making spot color corrections with 299
mode options for spot color correction 299
Perspective
using motion tracking for 88
Play Loop button (Command palette) 134
Playback of effects
that use tracking data 110
Point Range menu
brief description 81
Position effect parameter
limiting tracking data to one axis 109
using with motion tracking 77
Program side color correction
selecting 137
Project window
Format display, using 62
Projects
changing formats 62

Q

Quad Display
in Source menu 131

R

Red tab (Levels group) 210
Reference Current command (Color Correction
shortcut menu) 132
Reference frame
and split-screen display 132
displaying in monitor 132
Region of interest
adjusting 90
Region Stabilize effect (2D)
described 114
troubleshooting 116
types of stabilization 115
Relationships for color correction
defining with IN and OUT points 151
listed 138
using Source Clip Name 139
Remove Color Cast buttons 170

317



Index ABCDEFGHIJKLMNOPQRSTUVWXYZ

Remove Correction command (Color Correction
shortcut menu) 277
Removing
color corrections 277
Replacing
title fonts 37
Resetting controls 145
Resizing
tracking boxes 91
Restoring
an original look 280
Reusing
tracking data 118
Reviewing a color-corrected clip in context 135
RGB color space 152, 202
RGB gamut limit type
described 301
RGB Histogram
and safe color limits 308
display 256, 264
in Source menu 131
RGB Parade
and safe color limits 308, 309
display 256, 264
in Source menu 131
RGB values
displaying with the Color Match control 181
reference black and white 149, 302
Rotation effect parameter
using with motion tracking 77

S

Safe Colors

adjusting color to achieve safe limits 306

defining units of measurement for 302

graphical view of settings 303

overview of 301

understanding warnings 305

warnings in the Color Match control 306

warnings with two-field media 305
Scaling effect parameter

using with motion tracking 77
Secondary color correction

Add to Selection button 249

Color Selection buttons 247

enabling color vectors 242
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examples of softness adjustments 246
Invert Last Vector feature 240
Isolate feature 240
overview 233
resetting color vectors 242
Selected Vectors panel 240
selecting color vectors 241
Softness 243
Subtract from Selection button 249
Syringe button 248
using Color Match control for 252
vectors, described 235
workflow for 234
Segment mode
editing segments using tracking data 117
Selected Vectors panel
color swatch update behavior 240
described 240
Selecting
tracking data points 105
Sequences
flattening color-corrected 275
removing color corrections from 277
updating color-corrected 269
Settings
moving between systems 45
Shadows tab (HSL group) 183, 196
Site settings
moving between systems 45
Skew
using motion tracking for 88
Smooth Selected Points button (Tracking window) 82
Softness
examples of adjustments in secondary color
correction 246
Sound Designer IT audio
transferring 44
Source Clip Name relationship 139
Source menu in monitors 130
Source side color correction
selecting 137
Split-screen display 132
Spot Color Correction effect
described 297
making corrections with 299
Stabilization
brief description 75
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described 111

using multiple trackers with 113
Stabilizing an image

See also Region Stabilize effect

procedure 112

using Region Stabilize 114
Stages of typical color correction 281
Standard color vectors 235
Standard definition television (SDTV) 54
Starting

tracking data generation 95
Stopping

tracking data generation 96
Stretch Points Mode button (Tracking window) 81
Stretching

tracking data points 108
Substituting title fonts

See Replacing title fonts
Subtract from Selection button 249
Syringe button

defining a vector with 248

using with Color Match control for secondary

color correction 253

T

Tab buttons (Command palette) 143
Tabs in Color Correction tool
activating 141
associating with Tab buttons 143
Channels 200
Composite (Levels group) 210, 216
Controls (HSL group) 182
described 140
displaying using Tab buttons 143
hiding 149
Highlights (HSL group) 183, 196
Hue Offsets (HSL group) 186
Luma (Levels group) 210, 216
Luma Ranges (HSL group) 193
Master (HSL group) 183
Master (Levels group) 210
Midtones (HSL group) 183
Midtones tab (HSL group) 196
Red, Green, and Blue (Levels group) 210
Shadows (HSL group) 183, 196
Three-tone previews

examples of 198
in Luma Ranges tab 198
Timeline
displaying color correction information in 161
for tracker information 83
tracking data in 99
Tonal range
automatic color correction of 168
guidelines for correcting 282
Tracker Close button (Tracking window) 83
Tracker Color box
described 82
Tracker Name text box
described 83
using 89
Tracker timelines
described 83
understanding display 99
Trackers
defined 74
deleting 90
enabling and disabling 89
number required for stabilization 113
number required for tracking 74, 87
Tracking boxes
adjusting 90
displaying 90
guidelines, for positioning 91
guidelines, for resizing 92
moving or resizing 91
Tracking button (Tracking window) 81
Tracking data
changing display color 101
copying and pasting 119
enabling, in Effect Editor 85
in Effect Preview monitor 99
in Tracker timeline 99
preparing to generate 85
reusing 119
starting to generate 95
stopping generation 96
Tracking data points
deleting 106
display in Effect Preview monitor 99
display of flashing points for current frame 99,
101
finding 105
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locators in tracking boxes 90
moving 107

options for manipulating described 104

selecting 105

setting display range 101

stretching 108
Tracking effect parameter

described 77

multiple trackers in 87
Tracking information

displaying 129
Tracking window

controls, described 81

described 80

enabling and disabling trackers in 89

setting up tracking in 93
TransferManager 44
Transferring

projects between systems 45

settings between systems 45
Transferring files

Macintosh to Windows 49

Windows to Windows 48
Trimming

segments with tracking data 117
Troubleshooting

Region Stabilize effect 114
Two-field media

safe color warnings with 305

U

Understanding safe color warnings 305
Units of measurement

defining for Color Correction tool 149

defining for Safe Colors feature 302
Unity 44

Update Correction command (Color Correction

shortcut menu) 270
Updating color-corrected sequences 269
Use Tracking button (Effect Editor) 85

\"

Vectors
in Secondary color correction 235
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Vectorscope
commands in Source menu 131
display 256, 264
safe color limits 308
Video layers
locating and using with motion tracking 83

W

Warnings
and two-field media 305
in Safe Colors feature 305
in the Color Match control 306
Waveform
commands in Source menu 131
display 256, 264
White point adjustments
guidelines for 282
Windows Color dialog box 173
Windows to Macintosh file transfers 49
Windows to Windows file transfers 48
Workflow
for motion tracking 75
Workflows
film-based HDTV 55
for color correction 163
for secondary color correction 234
graphics for HDTV 61
video-based HDTV 59

X

X Only button (Effect Editor Position parameter) 110

Y

Y Only button (Effect Editor Position parameter) 110
Y Waveform
and safe color limits 308, 309
display 256, 264
in Source menu 131
YC Waveform
and safe color limits 308, 309
displayg 256, 264
in Source menu 131
YCbCr color space 152, 202
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YCbCr Histogram
and safe color limits 308
display 256, 264
in Source menu 131
YCbCr Parade
and safe color limits 308
described 264
display 256, 264
in Source menu 131
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